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Informacje zawarte w niniejszej instrukcji opisują ogólne zasady projektowania 
i programowania urządzeń Machine Struxure.
Należy przestrzegać zasad bezpieczeństwa opisanych w instrukcji w momencie 
instalacji urządzeń.

© 2014 Schneider Electric. Wszelkie prawa zastrzeżone.
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§
Safety Information

Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.

Informacje dotyczące 
bezpieczeństwa

Ważne informacje

OSTRZEŻENIE
Przeczytaj ze zrozumieniem poniższe instrukcje przed wykonaniem jakiejkolwiek 
procedury z tym modelem przemiennika. Następujące poniższe wskaźniki 
określające poziom niebezpieczeństwa mogą pojawiać się w tej dokumentacji 
wskazując na elementy zagrożenia, co może być powodem poważnego 
uszkodzenia urządzenia lub być przyczyną śmierci lub poważnych obrażeń.

Symbol mówiący o wystąpieniu niebezpieczeństwa lub ostrzeżenia 
związanym z pojawieniem się zagrożenia w postaci niebezpieczeństwa 
elektrycznego, co w następstwie prowadzi do poważnych obrażeń jeśli 
poniższa instrukcja nie została przestrzegana.

Symbol bezpieczeństwa. Jest używany aby przestrzegać użytkownika 
przed potencjalnym wystąpieniem poważnych obrażeń ciała. 
Należy spełniać zalecenia z tym symbolem w instrukcji, aby uniknąć 
możliwości obrażeń lub śmierci.
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§
Safety Information

Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.

 NIEBEZPIECZEŃSTWO
Znak NIEBEZPIECZEŃSTWO wskazuje sytuacje zagrożenia, które 
bez eliminacji podczas użytkowania i instalacji prowadzą do śmierci lub 
poważnych obrażeń ciała.
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§
Safety Information

Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.

 UWAGA
Znak UWAGA wskazuje sytuacje zagrożenia, które bez eliminacji 
mogą w rezultacie prowadzić do śmierci lub poważnych obrażeń ciała.
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NOTA INFORMACYJNA
Przeczytać ze zrozumieniem instrukcję przed przed przystąpieniem do 
pracy. Instalacja, programowanie i obsługa powinna być wykonywana przez 
wykwalifikowany personel.

Użytkownik jest odpowiedzialny za przestrzeganie wszystkich międzynarodowych 
i krajowych norm elektrycznych w celach ochronnych wszystkich urządzeń.
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§
Safety Information

Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.

 OSTRZEŻENIE
Znak OSTRZEŻENIE wskazuje na powstanie potencjalnej sytuacji 
zagrożenia, co może być, w małym stopniu powodem obrażeń ciała.
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Zawartość 
podręcznika

Zawartość instrukcji 

Dokument
Instrukcja SoMachine opisuje pierwsze kroki programowania oraz funkcje 
aplikacyjne i narzędziowe. 

Wersja dokumentacji
Niniejsza dokumentacja dotyczy oprogramowania SoMachine 3.x

Dokumentacja powiązana z instrukcją

Tytuł dokumentacji Numer dokumentu
Podręcznik programowania karty ATV IMC EIO0000000390 (ENG); 

EIO0000000391 (FRE); 
EIO0000000392 (GER); 
EIO0000000393 (SPA); 
EIO0000000394 (ITA); 
EIO0000000395 (CHS)

Podręcznik programowania paneli HMI Magelis XBTGC EIO0000000632 (ENG); 
EIO0000000633 (FRE); 
EIO0000000634 (GER); 
EIO0000000635 (SPA); 
EIO0000000636 (ITA); 
EIO0000000637 (CHS)

Podręcznik programowania paneli HMI Magelis XBTGT, 
XBTGK.

EIO0000000638 (ENG); 
EIO0000000639 (FRE); 
EIO0000000640 (GER); 
EIO0000000641 (SPA); 
EIO0000000642 (ITA); 
EIO0000000643 (CHS)
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Dokumenty zamieszczone w powyższej tabeli można pobrać ze strony internetowej 
www.schneider-electric.com

Podręcznik programowania sterowników Modicon M238 EIO0000000384 (ENG); 
EIO0000000385 (FRE); 
EIO0000000386 (GER); 
EIO0000000388 (SPA); 
EIO0000000387 (ITA); 
EIO0000000389 (CHS)

Podręcznik programowania narzędzi komunikacyjnych 
do sterowników Modicon M238

EIO0000000374 (ENG); 
EIO0000000737 (FRE); 
EIO0000000738 (GER); 
EIO0000000739 (SPA); 
EIO0000000740 (ITA); 
EIO0000000741 (CHS)

Podręcznik programowania sterowników Modicon M258 EIO0000000402 (ENG); 
EIO0000000403 (FRE); 
EIO0000000404 (GER); 
EIO0000000405 (SPA); 
EIO0000000406 (ITA); 
EIO0000000407 (CHS)

Podręcznik programowania sterowników Modicon LMC058 EIO0000000408 (ENG); 
EIO0000000409 (FRE); 
EIO0000000410 (GER); 
EIO0000000411 (SPA); 
EIO0000000412 (ITA); 
EIO0000000413 (CHS)

Podręcznik programowania SoMachine DTM EIO0000000673 (ENG); 
EIO0000000674 (FRE); 
EIO0000000675 (GER); 
EIO0000000676 (SPA); 
EIO0000000677 (ITA); 
EIO0000000678 (CHS)
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Informacje dotyczące bezpieczeństwa

1 Dla uzyskania szerszych informacji, odnieść się do NEMA ICS 1.1 (ostatnia 
edycja), „Przewodnika Bezpieczeństwa, Instalacji i Utrzymania wydanego 
przez Nadzór Państwowy” i NEMA ICS 7.1 (ostatnia edycja), „Standardów 
Bezpieczeństwa i Instalacji” oraz „Instalacji i Utrzymania”.

OSTRZEŻENIE
UTRATA KONTROLI
p Użytkownik projektujący obwody sterowania musi rozważyć potencjalne 

tryby wystąpienia błędów sterowania poprzez nieodpowiednie napięcie na 
linii zasilającej i w następstwie powstanie krytycznych funkcji dla sterowania 
urządzenia. Rolą projektanta jest doprowadzenie do osiągnięcia stanów 
bezpieczeństwa w trakcie i po wystąpieniu błędu.

p Separowane i redundantne kanały sterowania muszą zabezpieczać funkcje 
krytyczne dla pracy urządzenia.

p System kontroli urządzenia musi być zapewniony również poprzez połączenie 
komunikacyjne. Należy rozważyć błędy i opóźnienia pochodzące od transmisji 
sieciowej.

p Należy przestrzegać zasad bezpieczeństwa opisanych w instrukcjach NEMA.1

Nieprzestrzeganie tej instrukcji może być przyczyną śmierci albo 
poważnych obrażeń lub uszkodzenie urządzenia.

OSTRZEŻENIE
NIEZAMIERZONE DZIAŁANIE URZĄDZENIA
p �Należy używać certyfikowanego oprogramowania do urządzeń Schneider 

Electric.
p �Aktualizacja oprogramowania i urządzeń musi być zawsze wykonywana po 

publikacji przez Schneider Electric.

Nieprzestrzeganie tej instrukcji może być przyczyną śmierci albo 
poważnych obrażeń lub uszkodzenie urządzenia.
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Wstęp

Co jest zawartością?
Ta część zawiera następujące rozdziały:

Rozdział Nazwa rozdziału Strona
1 Wstęp do programowania 15

2 Zarządzanie projektem za pomocą SoMachine 17

EIO0000000067 04/2012 13

I

SoMachine

Introduction

EIO0000000067 04/2012

Introduction

What’s in this Part?

This part contains the following chapters:

Chapter Chapter Name Page

1 Introduction to Programming 15

2 Managing Projects with SoMachine 17
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Wstęp do programowania

Programowanie

Przegląd

Oprogramowanie SoMachine umożliwia konfigurację, programowanie 
i uruchomienie całej maszyny za pomocą jednego narzędzia.
Zawiera dwie części dedykowane do programowania: 
- Sterownika PLC (SoMachine) 
- Panelu operatorskiego HMI (Vijeo Designer)

Dokumentacja użytkownika

Instrukcja programowania opisuje interfejs i funkcję oprogramowania SoMachine. 
Jest integralną częścią online helpu programu SoMachine.
Uruchomienie online help programu SoMachine odbywa się przez kliknięcie 
symbolu ? na ekranie SoMachine lub wybranie komendy help z menu głównego. 
Istnieje także klawisz szybkiego dostępu do pomocy technicznej przez naciśnięcie 
klawisza F1.

EIO0000000067 04/2012 15

1

SoMachine

Introduction to Programming

EIO0000000067 04/2012

Introduction to Programming

Programming

Overview

SoMachine allows you to configure, program and commission entire machines in a 
single software environment.

It consists of 2 parts dedicated to specific programming tasks:
SoMachine part for controller programming
Vijeo-Designer part for HMI programming

User Documentation

This programming manual describes the SoMachine user interface and functions. It 
is part of the SoMachine online help. 

To start the SoMachine online help, click the ? button in the SoMachine screen or 
select the Help command from the General Functions Menu (see page 26).

To start the online help from the Program screen of SoMachine, use the Help menu 
or press the F1 key.

To start the Vijeo-Designer online help, select a suitable command from the Help 
menu or press the F1 key when you are in the Vijeo-Designer application.

For general information on SoMachine, like for example system requirements, 
installation and supported devices, refer to section Introduction of the SoMachine 
online help.

For detailed information on the controllers and integrated HMIs supported by 
SoMachine, refer to section Hardware User Guides of the SoMachine online help.

For detailed information on SoMachine libraries, refer to section Functions & 
Libraries User Manuals of the SoMachine online help.
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Zarządzanie projektem 
za pomocą SoMachine

Główne zadania

Przegląd

SoMachine składa się z trzech graficznych interfejsów bazujących na głównych 
funkcjach do których został stworzony: 
- konfiguracja projektu 
- programowanie 
- uruchomienie maszyny

Konfiguracja projektu

SoMachine dostarcza narzędzi, które mają ułatwić tworzenie projektu: 
- wybór gotowych, przetestowanych i udokumentowanych rozwiązań (selektor 
rozwiązań ułatwiających wyszukanie najbardziej zbliżonej architektury) 
- różnorodność aplikacji do transportu poziomego, pakowania, wind i obróbki 
materiału z gotowymi konfiguracjami i programem do podstawowych funkcji. 
- programy przykładowe do rozpoczęcia pracy z SoMachine.
SoMachine posiada intuicyjny i łatwy w obsłudze edytor graficzny służący do 
tworzenia własnych architektur.

Programowanie

Programowanie odbywa się za pomocą standardowego interfejsu CoDeSys 
zintegrowanego w SoMachine oraz programu VijeoDesigner do paneli 
operatorskich.

EIO0000000067 04/2012 17

2

SoMachine

Managing Projects with SoMachine 

EIO0000000067 04/2012

Managing Projects with 
SoMachine 

Main Tasks

Overview

SoMachine provides a graphical user interface based on the 3 main tasks that it has 
been designed for:

configuring projects
programming projects
commissioning machines

Configuring Projects

SoMachine provides tools that are intended to assist you in creating new projects 
quickly and easily.

It provides for project start-up
a variety of tested validated documented architectures (a dedicated TVDA 
Finder tool assists you in selecting the architecture that most appropriately suits 
your individual project),
a variety of application projects for conveying, hoisting, and packaging that 
provide basic configurations for these applications,
some examples that provide basic projects for making yourself familiar with 
SoMachine.

Once the project is created, SoMachine provides extensive possibilities to add 
textual and graphical information to each project file. This additional information 
enables you to distinguish projects avoiding the need to open them when you have 
to select the suitable project out of those that are available on your computer. 

For easy configuration of your project, SoMachine provides a graphical 
configuration editor that allows to add and configure devices in an intuitive way.

Programming Projects

For programming projects, the conventional CoDeSys graphical user interface is 
integrated into SoMachine. It provides the general programming and controller 
configuration functions. For configuring HMI controllers, Vijeo-Designer is used. 
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Uruchomienie maszyny

SoMachine posiada komponenty, które są odpowiedzialne za uruchomienie 
maszyny. Te elementy dostarczają tylko funkcje wymagane do wykonania tego 
zadania: 
- podłączenie do urządzenia 
- konfiguracja parametrów 
- zgranie/wgranie aplikacji
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Zarządzanie projektem

Co jest zawartością?
Ta część zawiera następujące rozdziały:

Rozdział Nazwa rozdziału Strona
3 Wstęp 21

4 Właściwości 55

5 Konfiguracja 63

6 Program 89

7 Uruchomienie 235

8 Raport 251

EIO0000000067 04/2012 19

II

SoMachine

Managing Your Project

EIO0000000067 04/2012

Managing Your Project

What’s in this Part?

This part contains the following chapters:

Chapter Chapter Name Page

3 Home 21

4 Properties 55

5 Configuration 63

6 Program 89

7 Commissioning 235

8 Report 251
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Wstęp

Wstęp

Co jest zawartością?
Ta część zawiera następujące rozdziały:

Sekcja Temat Strona
3.1 Informacje ogólne 22

3.2 Podgląd istniejących maszyn 28

3.3 Tworzenie nowej maszyny 32

3.4 Praca z maszyną 43

3.5 Centrum pomocy 52

EIO0000000067 04/2012 21

3

SoMachine

Home

EIO0000000067 04/2012

Home

What’s in this Chapter?

This chapter contains the following sections:

Section Topic Page

3.1 General Information 22

3.2 Show Existing Machine 28

3.3 Create New Machine 32

3.4 Machine Workflow 43

3.5 Learning Center 52
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Wstęp

Co to za sekcja?
Ta część zawiera następujące rozdziały:

Temat Strona
Ogólny opis podstawowych ekranów 23

Dostęp do głównych funkcji 26

3.1	 Informacje ogólne
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Wstęp

Ogólny opis podstawowych ekranów

Start SoMachine

Uruchom SoMachine wchodząc do menu Start - Programs - Schneider Electric 
i podwójnie klikając na ikonę SoMachine lub wybierając już stworzony projekt.
Uwaga: Jeśli SoMachine zostanie uruchomiony z poziomu menu Start wtedy 
pojawi się ekran pokazany na następnej stronie. Wybranie juz istniejącego projektu 
pokazuje ekran główny programu.
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Wstęp

Elementy ekranu podstawowego

Po uruchomieniu SoMachine pojawia się ekran podstawowy z funkcjami 
zarządzania projektu tak jak poniżej:

1.	 Ikona SoMachine daje dostęp do ogólnych funkcji 
2.	 Funkcje ekranu podstawowego (możliwe jest ukrycie tego panelu za pomocą zakładki 

nr 7.
3.	 Obszar wyświetlający wszystkie dostępne projekty używane w ostatnim czasie.
4.	 Lista File of type umożliwia filtrowanie wyświetlanych plików (pliki projektów lub pliki 

bibliotek lub pliki projektów CoDeSys w wersji starszej niż V3.0 lub pliki bibliotek 
CoDeSys w wersji starszej niż V3.0)

5.	 Ustawienie sposobu wyświetlania listy projektów (ikony czy lista).6. Pole zawiera 
informacje o projekcie, który został wybrany z listy. Zawiera przycisk Open służący do 
otwarcia danego projektu. Można ukryć ten panel za pomocą przycisku nr 7 po prawej 
stronie

Home

24 EIO0000000067 04/2012

Elements of the Main Selection Screen

After successful startup SoMachine displays the main selection screen (the Home 
tab), which provides access to the available functions.

The following window will be displayed after SoMachine startup:

1 This SoMachine icon provides access to the general functions menu.
2 The task selection pane on the left-hand side shows the tasks that are provided by the 

Home screen, you can hide this pane by clicking the handle (position 7 in the figure).
3 The work area in the middle is intended to always be visible. It provides access to the most 

recently opened projects.
4 The Files of type list allows you to display All files or to display only Project files or 

Library files or CoDeSys project files (before V3.0) or CoDeSys library files (before 
V3.0) in this work area.

5 The View list allows you to change from the thumbnails view of the projects to a more 
detailed List view.
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Wstęp

6.	 Pole zawiera informacje o projekcie, który został wybrany z listy. Zawiera przycisk Open 
służący do otwarcia danego projektu. Można ukryć ten panel za pomocą przycisku nr 7 
po prawej stronie

7.	 Przycisk służący do ukrycia panela po lewej lub prawej stronie ekranu.
8.	 Wybór języka w którym będą wyświetlane wszystkie ekrany programu, po zmianie należy 

uruchomić ponownie program.
9.	 Ikona ? daje szybki dostęp do pomocy technicznej.

Funkcje ekranu podstawowego

Lista wszystkich funkcji, jest podzielona na foldery i grupy.

Grupy funkcji ekranu 
podstawowego

Funkcje

Show existing machine 
(Istniejące projekty)

Ten folder daje dostęp do funkcji umożliwiających istniejące 
projekty i archiwa projektów.

Create new machine 
(Stwórz nowy projekt)

Ten folder daje dostęp do funkcji umożliwiających stworzenie 
nowego projektu od zera lub na podstawie gotowej 
podkładki. 

Machine workflow 
(Konfiguracja maszyny)

Ten folder daje dostęp do funkcji umożliwiających 
konfigurację i uruchomienie maszyny

Learning Center  
(Centrum pomocy)

Ten folder daje dostęp do dodatkowych informacji na temat 
SoMachine.

Zamykanie projektu SoMachine

Ekran podstawowy umożliwia także zamykanie projektu SoMachine w dowolnym 
momencie pracy. Wystarczy kliknąć przycisk Home i program wróci do menu 
początkowego.
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Wstęp

Dostęp do głównych funkcji

Menu funkcji głównych

Kliknięcie ikony SoMachine widocznej w górnym lewym rogu ekranu, daje dostęp 
do menu głównego programu.

Menu główne daje dostęp do następujących funkcji:

Komenda Opis
Home Wybierając tą komendę wracamy do ekranu podstawowego 

(zamykając aktualny projekt).

Save Zapisanie zmian w aktualnie otwartym projekcie.

Save As Zapisanie zmian w aktualnie otwartym projekcie 
z możliwością zmiany lokacji lub nazwy pliku.

Home
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Accessing General Functions

The General Functions Menu

Click the SoMachine icon that is visible in the upper left corner of the SoMachine 
window to access the general functions menu. 

The general functions menu provides the following commands:

Command Description

Home Execute this command to return to the Home tab (closing your 
currently open project), that is the main selection screen 
(see page 24) of SoMachine.

Save Execute this command to save the changes to your currently open 
project.

Save As Execute this command to save your currently open project / library 
to a different location or under a different name. A standard 
Windows Save Project dialog box is displayed that allows you to 
browse to the new folder and / or enter the new file name.
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Komenda Opis
Save/Send archive Komenda umożliwia zapisanie projektu wraz ze wszystkimi 

bibliotekami i plikami jako plik archiwum oraz stworzenie 
pliku tymczasowego i wysłanie jako mail używając przycisku 
Send. Mail jest tworzony automatycznie jeśli zainstalowana 
jest aplikacja MAPI.

Preferences Komenda umożliwia:
pp ustawienie (Preferred Path) ścieżki docelowej otwieranych 
i zapisywanych projektów.

pp ustawienie (Online Polling Interval ms) zakresu czasu 
odpytywania urządzeń w trakcie połączenia

pp ustawienie (Routing Step Width) szerokośc siatki edytora 
graficznego. Zakres wartości pomiędzy 15 (szeroka siatka) 
i 50 (gęsta siatka), im gęstsza siatka tym dłuższy czas 
odświeżania.

pp ustawienie (Timeout for routing) maksymalnego czasu 
odświeżania edytora graficznego. Jeśli ten czas zostanie 
przekroczony, to odświeżanie zostaje przerwane i edytor 
może być wyświetlony bez zachowania odpowiednich 
kątów.

pp ustawienie (Stop Gateway on Exit) zachowania bramki 
komunikacyjnej po zamknięciu programu SoMachine:

pp fabrycznie zaznaczone
Bramka zostanie automatycznie zatrzymana w momencie 
zamknięcia programu

pp nie zaznaczone  
Bramka nie będzie automatycznie zatrzymana po 
zamknięciu programu i należy ją zatrzymać manualnie.

pp ogólne ustawienia Options

Help Dostęp do pomocy technicznej SoMachine.

About Wyświetlenie nformacji na temat aktualnej wersji SoMachine, 
stanu licencji i informacji technicznych.

Exit Zamknięcie programu SoMachine.
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Pokaż Istniejące Projekty
Funkcje

Za pomocą menu „Pokaż Istniejące Projekty” można otworzyć dowolny już 
istniejący projekt.
Zawiera następujące funkcje:

pp „Browse for existing project” Przeglądanie istniejących projektów SoMachine
pp „Extract archive” Otwieranie zapisanych plików archiwalnych projektu.

Otwieranie ostatnio używanego projektu

Ta funkcja pozwala wyświetlić określona liczbę ostatnio edytowanych projektów. 
Definiowanie ilości wyświetlanych projektów można ustawić w zakładce: 
Preferences → Options → Load and Save → Display[1-16] items in most 
recently used list. 

3.2	 Pokaż Istniejące Projekty Show Existing Machine
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1.	 Wyświetlanie ostatnio edytowanych projektów na ekranie roboczym.
2.	 Filtracja rozszerzenia wyświetlanych plików. Umożliwia wyświetlanie wszystkich 

dostępnych plików „All files” tylko projekty „Project files”, biblioteki „Library files” lub 
projekty starszych wersji niż V3.0 „CoDeSys library files (before V3.0)”.

3.	 Zmiana sposobu wyświetlania listy projektów (ikony, lista za szczegółami).
4.	 Panel informacyjny projektu aby otworzyć wybrany projekt kliknij na przycisk Open.

Podwójne kliknięcie lub przycisk Open otwiera wybrany projekt SoMachine. 
Program przejdzie do zakładki właściwości projektu i pokaże szczegółowe 
informacje o danym projekcie.

Home
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1 The most recently opened projects will be displayed in the SoMachine work area.
2 The Files of type list allows you to display All files or to display only Project files or 

Library files or CoDeSys project files (before V3.0) or CoDeSys library files (before 
V3.0) in this work area.

3 The View list allows you to change from the thumbnails view of the projects to a more 
detailed List view.

4 The information pane displays Project Information related to the project that is selected 
in the work area. To open the selected project, click the Open button.

Double-click its icon in the work area or select the project in the work area and click 
the Open button in the information pane to open the project in SoMachine. 
SoMachine will select the Properties tab (see page 56) for assigning further 
information.
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Przeglądanie aktualnych projektów Browse for Existing Project

Funkcja Browse for existing project umozliwia przegląd aktualnych projektów na 
dysku lokalnym lub sieciowym. 

1.	 Lista dostępnych dysków podobnie jak w „Windows Explorer”.
2.	 Lista projektów dostępnych w wybranym folderze. 
3.	 Filtracja rozszerzenia wyświetlanych plików. Umożliwia wyświetlanie wszystkich 

dostępnych plików „All files” tylko projekty „Project files”, biblioteki „Library files” lub 
projekty starszych wersji niż V3.0 „CoDeSys library files (before V3.0)”.

4.	 Zmiana sposobu wyświetlania listy projektów (ikony, lista za szczegółami).
5.	 Panel informacyjny projektu aby otworzyć wybrany projekt kliknij na przycisk Open. 

Home
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Browsing for Existing Project

The sub-task Browse for existing project allows you to browse for existing projects 
on the local drives or on connected network drives.

1 The task selection pane shows the connected drives similar to a Windows Explorer.
2 The work area displays the SoMachine projects that are available in the folder you have 

selected in the selection pane.
3 The Files of type list allows you to display All files or to display only Project files or 

Library files or CoDeSys project files (before V3.0) or CoDeSys library files (before 
V3.0) in this work area.

4 The View list allows you to change from the thumbnail view of the projects to a more 
detailed List view.

5 The information pane displays Project Information related to the project that is selected 
in the work area. To open the selected project, click the Open button.
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Podwójne kliknięcie lub przycisk Open otwiera wybrany projekt SoMachine. 
Program przejdzie do zakładki właściwości projektu i pokaże szczegółowe 
informacje o danym projekcie.
Dyski sieciowe, które nie są dostępne w PC:

Krok Akcja
1 Kliknij dysk zdalny Remote drive 

2 Wpisz nazwę serwera i ścieżkę dostępu zgodnie z przykładem:  
\\nazwaserwera\nazwafolderu.

3 Kliknij przycisk Open.
Rezultat: Zawartość podanego folderu na serwerze zostanie wyświetlona 
podobnie jak w „Internet Explorer”. 

Otwieranie projektu archiwalnego

Zakładka Extract Archive umożliwia otwieranie archiwalnych projektów. 
Otwieranie projektów archiwalnych:

Krok Akcja
1 Wybierz zakładkę Extract Archive.

Rezultat: Zostanie otwarte menu plików archiwalnych.

2 Wybierz folder, który zawiera szukany projekt archiwalny.

3 Wybierz projekt archiwalny i kliknij przycisk Open.
Rezultat: Nastąpi otwarcie menu projektów archiwalnych.

4 Wybierz urządzenia Reference devices i biblioteki Reference library, które 
chcesz otworzyć i naciśnij przycisk Extract.
Rezultat: SoMachine wypakuje wybrane elementy z archiwum i otworzy projekt.
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Co to za sekcja?
Sekcja zawiera następujące tematy:

Temat Strona
Funkcje zakładki tworzenia nowej maszyny 33

Zacznij od standardowego projektu 34

Zacznij od pustego projektu 36

Zacznij z Architektury TVD 37

Zacznij Aplikacje 40

Otwórz istniejący projekt 42

3.3	 Tworzenie nowej maszyny Create new Machine
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Funkcje zakładki tworzenia nowej maszyny

Funkcje 

Za pomocą funkcji Create new Machine można rozpocząc nowy projekt od zera 
lub z wybranego szablonu.
Zawiera nastepujące funkcje:

pp Zacznij od standardowego projektu Start with standard project
pp Zacznij od pustego projektu Start with empty project
pp Zacznij z Architektury TVD Start with TVD architecture
pp Zacznij Aplikacje Start with application
pp Otwórz istniejący projekt Start with existing project
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Zacznij od standardowego projektu Start with Standard Project

Opis funkcji

Funkcja Start with standard project umożliwia stworzenie projektu dla sterownika 
PLC lub panela operatorskiego HMI. W jednym kroku można wpisać nazwe 
projektu POU i wybrać język programowania.
SoMachine tworzy projekt o podanej nazwie, zawierające wybrane urządzenie 
i język programowania oraz automatycznie przydziela program POU do głównego 
tasku (MAST).

Home
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Start with Standard Project

Function of the Sub-Task

The Start with standard project sub-task allows you to create a new project for a 
controller or HMI of your choice. In one single step you can enter a name for the 
Program Organization Unit (POU) (for controllers and HMIs with controller), and 
select the programming language for this POU. 

SoMachine creates a project with the name you entered, including the selected 
device, the programming language as well as the POU, that is automatically 
associated to a master (MAST) task.
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Tworzenie nowego standardowego projektu

Instrukcja tworzenia nowego projektu:

Krok Akcja Komentarze
1 W zakładce Home wybierz Create 

new machine → Start with standard 
project.

–

2 Wybierz sterownik PLC lub panel HMI 
z menu Device.

Jeśli zostało wybrane urządzenie do, 
którego oprogramowanie SoMachine 
udostępnia przykładowy projekt (np. 
ATV IMC) zostanie wyświetlony 
odpowiedni komentarz poniżej Project 
Initialization Settings. Zostanie także 
podany link do miejsca gdzie projekt 
ten jest dostępny.

3 W zakładce Device Name należy 
nadać nazwę danemu sterownikowi 
lub panelowi HMI. 

Nazwa nie może zawierać spacji oraz 
przekroczyć liczbę 32 znaków.

4 Jeśli został stworzony standardowy 
projekt należy nadać nazwę głównego 
programu POU w polu POU Name.

Pole tekstowe POU Name jest 
dostępne wyłącznie jeśli wybierzemy 
sterownik PLC lub HMI ze 
sterownikiem PLC. W przypadku 
wyboru samego panela HMI to pole nie 
będzie dostępne. Nazwa nie powinna 
zawierać spacji. 

5 Po wyborze sterownika PLC lub HMI 
ze sterownikiem PLC należy wybrać 
język programowania Implementation 
Language.

–

6 Nacisnij przycisk Create Project.
Rezultat: Nastąpi otwarcie zakładki 
zapisania projektu Save Project 
As, który umożliwia wybór miejsca 
zapisania projektu oraz podania nazwy 
pliku.

–

7 Wybierz folder docelowy oraz naciśnij 
zapisz Save.
Rezultat: SoMachine otworzy projekt 
i przejdzie do zakładki Program.

W zakładce Program widoczne są 
następujące elementy:

pp Nazwa wybranego urządzenia
pp Nazwa programu POU
pp Task MAST wywołujący program 
POU
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Zacznij od pustego projektu Start with empty project

Funkcje

Zacznij od pustego projektu Start with empty project pozwala na stworzenie 
nowego projektu od zera bez żadnych wstępnych ustawień. Nastąpi otwarcie 
zakładki zapisania projektu Save Project As, który umożliwia wybór miejsca 
zapisania projektu oraz podania nazwy pliku.
Naciśnij zapisz Save i wybierz folder docelowy. SoMachine otworzy projekt 
i przejdzie do zakładki Properties. 
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Zacznij z Architektury TVD Start with TVD architecture

Funkcje

Zacznij z Architektury TVD Start with TVD architecture umożliwia stworzenie 
nowego projektu na bazie Przetestowanych  i Udokumentowanych Architektur 
(TVDA). SoMachine posiada wiele projektów TVDA, gotowych do użycia 
i zaadoptowania do własnego projektu. Można wybrać sprawdzona architekturę 
TVDA bezpośrednio z listy lub użyć funkcji wyszukiwania TVD Architecture 
Finder, która za pomocą odpowiednich filtrów znajdzie najbardziej odpowiednią 
architekturę spełniającą nasze wymagania.
UWAGA: Architektury TVD zostały stworzone przy aktualnie obowiązujących 
normach europejskich. Oczywiście wymagania aktualnego projektu będą się różnić 
od zaproponowanego rozwiązania. W tym przypadku niezbędne jest odpowiednie 
zaadoptowanie projektu do własnych wymagań i założeń.     
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1.	 Wyszukiwarka TVD TVD Architecture Finder pozwala na wyszukanie odpowiedniej 
architektury do naszych wymagań.

2.	 Lista wszystkich architektur spełniających nasze wymagania podane w TVD Architekture 
Finder.

3.	 Dodatkowe informacje na temat wybranej architektury TVD oraz przycisk Open 
otwierający wybrany projekt.

Home
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1 The TVD Architecture Finder in the selection pane assists you in finding the suitable 
tested validated documented architecture by answering the questions.

2 The work area provides a list of the tested validated documented architectures available 
and highlights the project that best suits your requirements after you have answered the 
questions in the TVD Architecture Finder.

3 The information pane provides further information related to the tested, validated and 
documented architecture that is selected in the work area. It contains the Open button to 
open the selected project.
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Tworzenie projektu w oparciu o architektury TVD

Instrukcja tworzenia nowego projektu:

Krok Akcja
1 W zakładce Home wybierz Create new machine → Start with TVD 

architecture.

2 Odpowiedz na pytania i naciśnij przycisk Recommended Project.
Rezultat: Zostanie podświetlona na zielono aplikacja najbardziej pasująca do 
podanych wymagań.

3 Klikamy dwa razy na architekturę TVD którą chcemy użyć.
Rezultat: Zostanie otwarta zakładka zapisu Save Project As. Należy wybrać 
folder docelowy oraz nadać nazwę projektowi.

4 Naciśnij zapisz Save i wybierz folder docelowy. SoMachine otworzy projekt 
i przejdzie do zakładki Properties. 
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Start with Application

Funkcje

Funkcja startu z aplikacji pozwala stworzenie programu dedykowanego pod 
konkretną aplikację.
SoMachine dostarcza wiele różnych przykładów aplikacji, które są dedykowane 
pod konkretne sterowniki PLC, HMI, urządzenia wykonawcze:

pp Transport poziomy
pp Aplikacje dźwigowe
pp Maszyny pakujące...

1.	 Lista dostępnych aplikacji
2.	 Obszar z projektami odpowiadającymi wybranej aplikacji.
3.	 Informacje na temat wybranej aplikacji, zawiera przycisk Open służący do otwarcia 

wybranego projektu.

Home
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Start with Application

Function of the Sub-Task

The Start with application sub-task allows you to create a new project on the basis 
of sample projects for dedicated applications. 

SoMachine provides a variety of application project examples, that are project shells 
dedicated to the following applications, including controller, HMI, field devices and 
application functions:

Controller Templates
Conveying
Hoisting
Packaging

1 The selection pane lists those Applications SoMachine provides application projects for. 
2 The work area shows those application projects that are available for the application 

selected in the selection pane.
3 The information pane provides further information related to the application project that is 

selected in the work area. It contains the Open button to open the selected project.



41

Wstęp

Tworzenie nowego projektu

Instrukcja tworzenia nowego projektu:

Krok Akcja
1 W zakładce Home wybierz Create new machine → Start with application
2 Z listy aplikacji Applications wybierz odpowiednii projekt do twojej maszyny.

Rezultat: Zostaną wyświetlone dostepne projekty.

3 Kliknij dwa razy na projekt, który chcesz wykorzystać do tworzenia swojej 
aplikacji lub wciśnij przycisk Open.
Rezultat: Nastąpi otwarcie funkcji zapisu Save Project As, która umożliwia 
wybór folderu i nadanie nazwy projektowi.

4 Naciśnij Save aby zapisać projekt w wybranym folderze. SoMachine otworzy 
projekt i przejdzie do zakładki Properties.
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Otwórz istniejący projekt

Funkcje

Otwarcie istniejącego projektu umożliwia stworzenie nowego projektu na podstawie 
już istniejącej aplikacji. Znajdź istniejący projekt i/lub biblioteki na dysku lokalnym 
lub sieciowym. W celu zabezpieczenia istniejącego pliku przed nadpisaniem 
automatycznie zostanie otwarta funkcja zapisu Save As. Wpisz nową nazwę 
projektu/biblioteki.
Zakładka jest identyczne jak Browse for existing project w menu Show existing 
machine.  
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Co jest zawartością?
Sekcja zawiera następujące tematy:

Temat Strona
Praca z maszyną 44

Uruchomienie maszyny - Start 45

Uruchomienie maszyny - Zgranie  projektu z urządzenia 47

Zmiana Firmware 50

3.4	 Praca z maszyną
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Praca z maszyną

Funkcje pracy z maszyna

Zakładka Machine Workflow dostarcza funkcje dedykowane do uruchomienia 
maszyny. W tym miejscu nie możemy dokonywać zmian w projekcie.
Zakładka Machine Workflow zawiera następujące funkcje:

pp Start Commision machine - start with project
pp Zgranie projektu z urządzenia Commision machine - upload project from 
device

pp Zmiana firmware Update firmware
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Start Commision machine - start with project

Funkcje

Funkcja Commision machine - start with project umożliwia wyszukanie 
dostępnych projektów SoMachine znajdujących się na dysku lokalnym lub 
sieciowym. 

1.	 Dostępne dyski podobnie jak w Windows Explorer
2.	 Obszar wyświetlający wszystkie dostępne projekty w wybranej lokacji.
3.	 Lista Files of type umożliwia filtrowanie wyświetlanych plików (pliki projektów lub 

pliki bibliotek lub pliki projektów CoDeSys w wersji starszej niż V3.0 lub pliki bibliotek 
CoDeSys w wersji starszej niż V3.0)

4.	 Ustawienie sposobu wyświetlania listy projektów (ikony czy lista).
5.	 Informacje o wybranym projekcie Project information aby otworzyć dany plik należy 

kliknąć przycisk Open.

Home
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Commission Machine - Start with Project

Function of the Sub-Task

The sub-task Commission machine - start with project allows the machine 
commissioner to browse for already available SoMachine projects on the local 
drives or on connected network drives. 

1 The task selection pane shows the connected drives similar to a Windows Explorer.
2 The work area displays the SoMachine projects that are available in the folder you have 

selected in the selection pane.
3 The Files of type list allows you to display All files or to display only Project files or 

Library files or CoDeSys project files (before V3.0) or CoDeSys library files (before 
V3.0) in this work area.

4 The View list allows you to change from the thumbnail view of the projects to a more 
detailed List view.

5 The information pane displays Project Information related to the project that is selected 
in the work area. To open the selected project, click the Open button.
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Otwieranie projektu

Aby otworzyć projekt należy:

Krok Akcja
1 W menu Home wybierz Machine workflow → Commision machine-start with 

project.
Rezultat: Zostaną pokazane dostępne lokacje, tak jak w Windows Explorer. 

2 Wyszukaj folder gdzie znajduje się projekt.

3 Otwórz projekt przez kliknięcie na niego dwa razy lub wcisnięcie przycisku 
Open. 
Rezultat: SoMachine otworzy projekt pokazując tylko menu Commisioning 
Machine oraz dostepne komendy.
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Commission Machine - Upload Project from Device

Funkcje

Funkcja Commission machine - upload project from device umożliwia zgranie 
projektu z podłączonego urządzenia do komputera PC.
Uwaga:
Ta funkcja jest tylko dostępna w sterownikach wyposażonych w dodatkową 
pamięć:

pp ATV IMC
pp M258

Dodatkowo ta funkcja jest dostępna w tych panelach XBTGC, które mogą używać 
pamięci USB jako dodatkowa pamięć i XBTGT/GK, które mogą używać pamięci 
CF. 
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Commission Machine - Upload Project from Device

Function of the Sub-Task

The sub-task Commission machine - upload project from device allows the 
machine commissioner to upload a SoMachine project from a connected device to 
the PC running SoMachine. 

NOTE: 

This function is only available for the following controllers that are equipped with 
additional memory:

ATV IMC
M258

Furthermore it is available for those XBTGC types that can use a USB flash drive as 
secondary storage and for XBTGT/GK controllers that can use the Compact Flash 
(CF) card as secondary storage.
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Zgranie projektu

Aby zgrać projekt należy:

Krok Akcja
1 W zakładce Home  wybierz Machine workflow → Commission machine-

upload project from device
Rezultat: Nastąpi otwarcie zakładki Select Device. 

2 Select Device wybierz urządzenie z którego chcesz ściągnąć projekt.
Jeśli urządzenie nie jest dostępne należy kliknąć skanowanie dostępnych 
urządzeń Scan network.

3 Naciśnij przycisk OK.
Rezultat: Nastąpi otwarcie zakładki Project Archive:

4 Project Archive wybierz przycisk ... w celu wskazania lokacji do zapisania 
projektu na dysku.
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Uploading a Project for Machine Commissioning

To upload a project from a connected device for machine commissioning, proceed 
as follows:

Step Action

1 In the Home tab select Machine workflow → Commission machine - upload 
project from device.
Result: A Select Device dialog box opens.

2 In the Select Device dialog box select the device you want to upload the project 
from.
If the device is not displayed, click the Scan network button to search for all 
available devices.

3 Click the OK button.
Result: The Project Archive dialog box opens:

4 In the Project Archive dialog box click the ... button to browse to the folder on 
your SoMachine PC where the uploaded project will be saved.
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Krok Akcja
5 W zakładce Archive contents zaznacz elementy, które mają być zgrane do 

wybranego folderu.

6 Naciśnij Extract aby zgrać zaznaczone elementy.

7 W trakcie procesu zgrywania należy potwierdzić nadpisanie istniejących 
projektów w danym folderze.

8 Potwierdź wiadomość otwarcia projektu.
Rezultat: Nastąpi otwarcie ekranu Commissioning i wyświetlenie konfiguracji 
danego projektu.

Więcej informacji znajduje się w rozdziale Commissioning.
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Zmiana Firmware

Funkcje

Funkcja umożliwia zmianę firmware w sterowniku za pomoca oprogramowania 
SoMachine.
Wykonanie zmiany firmware skasuje całą aplikację ze sterownika i wyczyści 
pamięć Flash. 

Uwaga
Utrata aplikacji 

pp Utwórz backup aplikacji przed zmianą firmware w sterowniku.
pp Ponownie wgraj aplikacje do sterownika po zmianie firmware.

Nie wykonanie powyższych kroków grozi utratą aplikacji lub uszkodzeniem 
urządzenia.



51

Wstęp

Poniższy widok pokazuje okno zmiany firmware w sterowniku M238:

Należy wybrać sposób wgrania firmware przez naciśnięcie odpowiedniej ikony 
USB lub M238 serial w zależności od przewodu który używamy.
Rezultat: Zostanie uruchomiony odpowiedni proces wgrania firmware, postępuj 
zgodnie z instrukcją na ekranie.  
Więcej informacji znajduje się w „M238 ExecLoader User Guide”  
(Start → Programs → Schneider Electric → SoMachine → Tools → 
ExecLoader User Guide).
Uwaga: Do otwarcia tego dokumentu niezbędne jest posiadanie programu Adobe 
Reader, który nie jest częścią oprogramowania SoMachine.
Ekran zawiera link do wszystkich dostępnych wersji firmware.

Home
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The following screenshot shows the sub-task function with the Modicon M238 Logic 
Controller:

To update the firmware, click the corresponding firmware download icon for USB or 
for serial line connections.

Result: The proper Exec Loader wizard is started. Follow the instructions on the 
screen that guide you through the update process. For further information refer to 
the M238 ExecLoader User Guide that is provided with the SoMachine installation. 
You can access it via the Start menu as follows: Start → Programs → Schneider 
Electric → SoMachine → Tools → ExecLoader User Guide.

NOTE: Please note that the Adobe ReaderTM is required to open this PDF 
document. This reader is not part of the SoMachine installation but can be 
downloaded from http://www.adobe.com/go/getreader.

The information pane provides a link to a download area where the latest firmware 
updates are available.
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3.5	 Centrum Pomocy

Centrum Pomocy

Funkcje

Centrum Pomocy zawiera dodatkowe  informacje na temat oprogramowania 
SoMachine.
Zawiera:

pp Szybki przegląd
pp Dokumentację szkoleniową
pp E-learning
pp Przykłady

Home
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3.5 Learning Center

Learning Center

Sub-Tasks

The Learning Center task provides additional information for quickly making 
yourself familiar with SoMachine.

It includes the following sub-tasks:
Quick overview
Training Manual
E-Learning
Examples
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Szybki przegląd

Szybki przegląd zawiera krótki 2 min. film przedstawiający podstawowe funkcje 
oraz interfejs użytkownika. 

Dokumentacja szkoleniowa

Dokumentacja szkoleniowa zawiera pliki PDF z prezentacją  i instrukcją 
zapoznającą nas z oprogramowaniem SoMachine.

E-learning

E-learning zawiera interaktywną prezentację pokazującą krok po kroku 
poszczególne funkcje oprogramowania SoMachine.

Przykłady

Przykłady projektów wraz z dokumentacją PDF. Ta część nie instaluje się wraz 
z SoMachine, należy ją ściągnąć ze strony:  
http://www.adobe.com/go/EN_US-H-GET-READER.
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Co jest zawartością?
Ta część zawiera następujące rozdziały:

Temat Strona
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Properties

What’s in this Chapter?

This chapter contains the following topics:

Topic Page

General Overview of the Properties Tab 56

Description of the General Task 58

Description of the Description Task 59

Description of the Custom Information Task 61
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Ogólny przegląd

Zakładka właściwości

Zakładka właściwości umożliwia wpisanie dodatkowych informacji na temat 
projektu. Informacje tekstowe i graficzne, są opcjonalne. Ta zakładka jest widoczna 
wyłącznie po otworzeniu projektu.
Zakładka właściwości zawiera następujące funkcje:

pp Ogólne
pp Opis
pp Informacje dodatkowe
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Widok okna właściwości

1.	 Pole wyboru
2.	 Pole informacji o pliku i autorze projektu
3.	 Pole informacji o projekcie, przyciski zapisu projektu (Save, Save as, Save/Send 

archive).

Properties
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Elements of the Properties Tab

1 The task selection pane shows the tasks of the Properties tab.
2 The work area provides entry fields for file information and author information.
3 The information pane displays information entered in the work area and allows you to save 

and archive your project by using the command buttons (Save, Save as, Save/Send 
archive).
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Opis główny

Główne funkcje

Główne funkcje umozliwiają zapis projektu lub zapisanie archiwum projektu:
pp File Information (informacja o pliku)
pp Author Information (informacja o autorze)
pp Project Information (informacja o projekcie) z przyciskiem Save, Save as 
i Save/Send archive.

Informacja o pliku

Zawiera nazwę projektu i folder w którym jest on zapisany.

Informacja o autorze

To pole zawiera dodatkowe informacje o projekcie oraz o autorze projektu. 
Wpisane tu dane są wyświetlane po prawej stronie ekranu.
Uwaga: W polu tytuł i autor nie można używać następujących znaków:
-” („ „ )” nawiasów
-” ,” przecinków

Po naciśnięciu przycisku Save wpisane informacje zostaną zapamiętane.

Zmiana nazwy projektu lub miejsca zapisu

Nacisnij przycisk Save as i zapisz plik pod inną nazwą lub w innym folderze.

Archiwizacja projektu

Stworzenie archiwum wymaga wybrania przycisku Save/Send archive z menu 
Project Information.
Mamy do dyspozycji dwie funkcje:

pp Zapisz archiwum za pomocą przycisku Save.
pp Wyślij archiwum jako załącznik do maila.
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Opis główny

Pole opisu

Pole opisu umożliwia dodanie zdjęcia projektu. 

Zdjęcie można dodać za pomocą przycisku Add. Dodatkowo widoczne jest pole 
konfiguracji urządzeń.

Properties
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Description of the Description Task

The Description Task

The Description task allows you to add an image to your project. This optional 
customer image helps you to identify your project. 

The work area provides the button Add to add a preferred Customer Image to your 
SoMachine project and shows the Configuration View corresponding to your 
settings in the Configuration tab.
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Priorytet wyświetlania zdjęć projektu

SoMachine sprawdza dostępne zdjęcia i wyświetla je w zależności od priorytetu.

Poziom priorytetu Zdjęcia
wysoki Zdjęcia maszyny

średni widok konfiguracji

niski ikony SoMachine

Zdjęcia maszyny

W tej sekcji można umieścić zdjęcia maszyny

Dodawanie zdjęć

Aby dodać zdjęcie należy:

Krok Akcja
1 Naciśnij przycisk Add.

Rezultat: Otworzy się menu Add customer image to project
2 Ustaw folder docelowy, wybierz zdjęcie i kliknij Open.

Rezultat: Zostanie wyświetlone zdjęcie w oknie informacji.

Uwaga: SoMachine wspiera format JPG. Rozmiar zdjęcia nie powinien 
przekraczać 1 MB w innym przypadku zdjęcie zostanie zapisane w zredukowanym 
rozmiarze.

Zmiana lub usunięcie zdjęcia

Zmiana zdjęcia następuje przez naciśnięcie przycisku Change i wyboru lokacji 
nowego zdjęcia.

Widok konfiguracji

Widok konfiguracji pokazuje wszystkie elementy automatyki oraz architekturę 
komunikacji.
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Opis panelu informacji

Panel informacji

W tym oknie możemy wprowadzić wszystkie informacje, które uważamy za istotne 
dla projektu oraz dodać załączniki w postaci plików.

Properties
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Description of the Custom Information Task

The Custom Information Task

The Custom Information task allows you to customize project information you may 
consider relevant. The work area provides entry fields for custom information as well 
as the possibility to add attachments to your project.
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Pola informacji

SoMachine sprawdza dostępne zdjęcia i wyświetla je w zależności od priorytetu.
Menu informacji składa się z tekstowych pól umożliwiających wpisanie 
dodatkowych informacji ważnych dla danego projektu.
W zakładce Custom Field wpisz nazwę pola, które chcesz utworzyć.  
W zakładce Value wpisz wszystkie informacje, które mają sie tam pojawić.  
Wszystkie informacje będą wyświetlane po prawej stronie okna pod warunkiem, że 
zaznaczymy odpowiednie pole Info.

Dodane dokumenty

Wciśnij przycisk Add Attachmeant aby dodać załącznik oraz wybierz folder 
docelowy.
Jeśli załącznik został dodany, zostana wyświetlone dodatkowe funkcje:

pp Viev attachmeant (podgląd załącznika)
pp Save attachmeant as file (zapis załacznika)
pp Remove attachmeant from project (usuń załącznik).

Ważne informacje

Menu dodanych załączników zawiera okienko do zaznaczenia załączników które 
powinny być wyświetlane w głównym widoku jako informacje ważne. Zostanie 
wyświetlona dodatkowa ikona symbolizująca ważny załącznik.

Properties

62 EIO0000000067 04/2012

Custom Information Fields

The Custom Information Fields are text boxes for any optional information you 
might want to give to personalize your project. The fields and their values you define 
here can be displayed in the information pane on the right-hand side if you activate 
the respective Info check box.

In the Custom Field text boxes enter a name for a new field you want to create. 
Enter the content that should appear in this field in the Value text boxes.

For every line of information you want to be displayed as Project Information in the 
information pane on the right-hand side, select the check box in the Info column.

Attached Documents

Click the Add Attachment button to attach 1 or more documents to your project file.

A dialog box will be displayed, where you can browse to the destination folder.

After you have attached a file to your project, the section Add Attachment displays 
a check box for Important Information as well as the icons for:

View attachment, which opens the attached file.
Save attachment as file, which opens a Save as dialog box.
Remove attachment from project, which deletes the link between the project 
and the attached file.

Important Information

The section Attached Documents provides the check box Important Information 
for each of the attached documents. For each document you consider as important 
to read, select the check box. The task menu will then show a small SoMachine icon 
next to the task Custom Information to indicate that it includes important 
information. 
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Configuration

What’s in this Chapter?

This chapter contains the following sections:

Section Topic Page

5.1 General Information 64

5.2 Graphical Configuration Editor 68



64

Konfiguracja

Opis menu i konfiguracji

Przegląd

Menu konfiguracji jest wyświetlane wyłącznie po otwarciu projektu SoMachine.
Zawiera ono wszystkie potrzebne funkcje do skonfigurowania sprzętu oraz 
komunikacji w maszynie. Ustawienia wykonane tutaj, są dostępne w programie 
CoDeSys i Vijeo Designer.

5.1	 Informacje ogólne
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Elementy menu konfiguracji

Widok menu konfiguracji z przykładową konfiguracją.

1.	 Lista dostępnych urządzeń PLC, HMI  możliwych do skonfigurowania poprzez 
przeciągnięcie ich na pole konfiguracji. Dostępna jest także funkcja wyszukania 
odpowiedniego urządzenia.

2.	 Graficzne pole konfiguracji pokazujące aktualną konfigurację sprzętową i sieciową.
3.	 Pole informacyjne pokazujące dane na temat podświetlonego elementu.

Dodawanie urządzeń

Dodawanie nowych urządzeń odbywa się przez wybranie danego urządzenia 
z listy i przeciągnięcie go na obszar pola konfiguracji.

Configuration
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Elements of the Configuration Tab

The following graphic displays the Configuration tab with a sample configuration:

1 The task selection pane shows the list of controllers, HMIs, and miscellaneous devices you 
can drag into the graphical configuration editor as well as a Search function to search for 
the required device.

2 The work area includes the graphical configuration editor with its display manager at the 
bottom.

3 The information pane provides further information on the element selected in the task 
selection pane or in the work area (devices, connections, communication managers). 

Adding Devices

The task selection pane of the Configuration tab lists the devices you can add to 
the configuration in the graphical configuration editor grouped by type. To add a 
device, click the entry of the suitable group, select the device from the list and drag 
it to the work area.
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Wyświetlanie wszystkich wersji dostępnych urządzeń

Zaznaczając okienko „Display all versions „ (tylko dla ekspertów) wyświetlimy 
wszystkie dostępne wersje każdego urządzenia.
Uwaga: Ta funkcja jest przeznaczona dla użytkowników posiadających wiedzę 
ekspercką. Użycie starszych wersji sterownika wymusza ręczne skonfigurowanie 
bibliotek.

 Ostrzeżenie
Niekompatybilność urządzenia 
Upewnij się, że każda alternatywna wersja wybranego urządzenia jest w pełni 
kompatybilna z instrukcjami używanymi w programie do kontroli maszyny.

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.

Wyświetlanie urządzeń innych firm

Ustawienia domyślne pokazują wyłącznie urządzenia firmy Schneider Electric aby 
wyświetlić wszystkie dostępne urządzenia należy zaznaczyć okienko z napisem 
„Display all vendors”.

 Ostrzeżenie
Niekompatybilność urządzenia 

pp Upewnij się, że każde alternatywne urządzenie jest w pełni kompatybilna z instrukcjami 
używanymi w programie do kontroli maszyny.

pp W sprawie kompatybilności urządzeń proszę skontaktować się ze wsparciem 
technicznym Schneider Electric

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.
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Funkcja wyszukiwania

Do szybkiego wyszukiwania urządzeń służy funkcja „Search” . Po kliknięciu tego 
przycisku nastąpi otwarcie menu wyszukiwania.

Do wyboru mamy dwie funkcje wyszukiwania:
pp wyszukiwanie proste
pp wyszukiwanie na podstawie podanego wyrażenia

Proste wyszukiwanie polega na wpisaniu referencji urządzenia wraz ze znakiem 
(?), który zastępuje dowolny jeden znak  lub (*) zastępujący dowolną liczbę 
znaków. Następnie wciskamy przycisk wyszukiwania „Search”.
Wyszukiwanie na podstawie podanego wyrażenia polega na podaniu słowa, które 
pasuje do szukanej aplikacji i naciśnięciu przycisku „Search”.  Więcej informacji 
na ten temat można znaleźć w pomocy online SoMachine.
W obu przypadkach wynikiem wyszukiwania będzie lista urządzeń skojarzonych 
z podaną frazą. 

Configuration
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Search Function

To ease finding the intended device, SoMachine additionally provides a search 
function. Open it by clicking the Search item in the task selection pane.

You can choose between the following 2 search functions:
search based on simple wildcards
search based on regular expressions

To search for a device by using simple wildcards, select the item Use simple 
wildcards from the list below the textbox. Enter the product reference of the device 
you are searching in the text box. As wildcards you can use a question mark (?), 
which replaces exactly one character, or an asterisk (*), which can be used as a 
wildcard for none or several characters. Click the Search button to start the search. 

To search for a device by using regular expressions, select the item Use regular 
expressions from the list. Enter the name of the device you are searching in the text 
box and use the regular expressions that suit your requirements. Click the Search 
button to start the search. For further information on regular expressions refer to the 
documentation in the CoDeSys online help. 

In both cases SoMachine will return a list of devices meeting the search phrase you 
entered or will display a message indicating that no devices were found.
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Zawartość

Ta sekcja zawiera następujące tematy:

Temat Strona
Opis ogólny 69

Dodawanie i kasowanie urządzeń 71

Konfiguracja urządzeń 73

Detekcja błędów w konfiguracji 81

Dostęp do funkcji programowych i aplikacyjnych za pomocą edytora 
graficznego konfiguracji

83

Tworzenie połączeń sieciowych 85

5.2	 Edytor graficzny konfiguracji
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Opis ogólny

Przegląd

Edytor graficzny umożliwia wykonanie konfiguracji sprzętowej i sieciowej maszyny 
i wizualizacji graficznej całej architektury. Ustawienia wykonane tutaj będą także 
dostępne w menu programowania „Program” i Vijeo Designer.

1.	 Graficzne przedstawienie konfiguracji sprzętowej i sieciowej.
2.	 Pasek narzędzi edytora graficznego.

W momencie początku tworzenia projektu ekran edytora graficznego jest pusty. 
Należy wybrać urządzenie z listy po lewej stronie ekranu i przeciągnąć je na pole 
edytora graficznego.

Configuration
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General Description

Overview

The graphical configuration editor provides necessary functions to perform the 
entire hardware and network configuration of your machine in a graphical way. The 
configuration settings performed here will also be available in the Program tab as 
well as in Vijeo-Designer.

1 The graphical configuration editor in the work area displays your machine configuration in 
a graphical way.

2 The display manager simplifies the use of the graphical configuration editor.

When you start creating a new project from scratch, the graphical configuration 
editor will be empty. It will then prompt you to drag a device from the list on the left-
hand side into this empty area. 
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Narzędzia edytora graficznego

Narzędzia znajdują się na dole edytora graficznego i zawiera następujące funkcje:

Dostępne elementy Opis
Zoom  
(Przybliżenie)

Suwak przybliżenia umożliwia kontrole wielkości 
poszczególnych elementów edytora graficznego.

100% Naciśnięcie przycisku 100% przywraca domyślną wielkość 
elementów w edytorze graficznym.

Show All  
(Pokaż wszystko)

Pokaż wszystkie elementy dostępne w edytorze 
graficznym na jednym ekranie.

Reroute  
(Przerysuj)

Przerysowanie ponowne połączeń pomiędzy 
poszczególnymi elementami.

Reroute On Drop 
(Przerysowanie nowego 
węzła)

Funkcja umożliwia przerysowanie połączeń sieciowym za 
każdym razem gdy dodajemy nowe urządzenie.

Allow overlapping lines 
(Redukcja równoległych 
połączeń)

Umożliwia zredukowanie równoległych połączeń do jednej 
linii.

Collapse All  
(Zwiń wszystko)

Zwinięcie wszystkich modułów rozszerzeń.

Expand Last  
(Rozwinięcie ostatniego 
modułu)

Rozwinięcie modułów rozszerzeń ostatnio wybranego 
urządzenia.

Expand All  
(Rozwiń wszystko)

Rozwinięcie wszystkich modułów rozszerzeń dołączonych 
do urządzeń.

Configuration

70 EIO0000000067 04/2012

Display Manager 

To simplify its use, the graphical configuration editor contains a display manager at 
the bottom of the pane.

The display manager contains the following functions:

Display Manager Item Description

Zoom The Zoom slider controls the magnification of the 
graphical configuration editor. 

100% 

Click the 100% button to display the elements in the 
graphical configuration editor without magnification in 
their original size.

Show All 

Click the Show All button to display the elements 
available in the graphical configuration editor.

Reroute 

Click the Reroute button to redraw the connecting 
lines between the items.

Reroute On Drop Activate this function to redraw the connecting lines 
between the items with every new device you drag 
into the graphical configuration editor.

Allow overlapping lines Activate this function to allow the graphical 
configuration editor to draw 1 line if several 
connecting lines are in parrallel instead of drawing 
each line separately. This setting speeds up the 
drawing time.

Collapse All 

Click the Collapse All button to collapse the 
subdevices, that are expansion modules.

Expand Last 

Click the Expand Last button to expand the 
subdevices (expansion modules) of the last device 
you selected.

Expand All 

Click the Expand All button to expand the 
subdevices, that are expansion modules.
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Click the 100% button to display the elements in the 
graphical configuration editor without magnification in 
their original size.

Show All 

Click the Show All button to display the elements 
available in the graphical configuration editor.

Reroute 

Click the Reroute button to redraw the connecting 
lines between the items.

Reroute On Drop Activate this function to redraw the connecting lines 
between the items with every new device you drag 
into the graphical configuration editor.

Allow overlapping lines Activate this function to allow the graphical 
configuration editor to draw 1 line if several 
connecting lines are in parrallel instead of drawing 
each line separately. This setting speeds up the 
drawing time.

Collapse All 

Click the Collapse All button to collapse the 
subdevices, that are expansion modules.

Expand Last 

Click the Expand Last button to expand the 
subdevices (expansion modules) of the last device 
you selected.

Expand All 

Click the Expand All button to expand the 
subdevices, that are expansion modules.
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Dodawanie i kasowanie urządzeń

Przegląd

Menu konfiguracji zawiera edytor graficzny umożliwiający wizualizacje konfiguracji 
sprzętowej i sieciowej maszyny.
W przypadku dodania lub usuwania urządzenia SoMachine automatycznie 
reguluje alokację pamięci dla poszczególnych urządzeń i należy to uwzględnić 
w ustawieniach pamięci dla wejść i wyjść sterownika. 

 Ostrzeżenie
Niekontrolowane zachowanie urządzenia
Należy sprawdzić i zmodyfikować jeśli to niezbędne adresy uzyte w programie po zmianie 
konfiguracji.

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.

Uwaga: Schneider Electric rekomenduje stosowanie adresowania symbolicznego 
w celu ograniczenia ciągłych zmian w programie oraz możliwości wystąpienia 
błędnego adresowania We/Wy.

Dodawanie urządzeń

Aby dodać urządzenie postępuj następująco:

Krok Akcja
1 Wybierz urządzenie, które chcesz dodać z listy po lewej stronie edytora 

konfiguracji.
Dodatkowe informacje na temat wybranego urządzenia zostaną wyświetlone po 
prawej stronie edytora.

2 Przeciągnij wybrane urządzenie na pole edytora graficznego.
Rezultat: Urządzenie pojawi sie w polu edytora i mozliwe jest dowolne 
przemieszczanie go za pomocą lewego przycisku myszki. Urządzenie jest 
gotowe do konfiguracji.

Uwaga: Jeśli zostanie dodane urządzenie HMI nastąpi automatyczne otwarcie 
programu Vijeo Designer.
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Nadawanie nazwy urządzeniom

Nadanie nazwy urządzeniu odbywa się przez naciśnięcie prawym przyciskiem 
myszy na urządzenie i wybraniu komendy Rename device lub naciśnięcie nazwy 
znajdującej się pod urządzeniem, po jego wybraniu.
Rezultat: Edycja nazwy domyślnej (np. MyController) i możliwość jej zmiany.

Usuwanie urządzeń

Usuwanie urządzenia z edytora graficznego odbywa się przez naciśnięcie prawego 
klawisza myszy i wybraniu Delete device lub wybraniu danego urządzenia 
i naciśnięciu klawisza delete z klawiatury komputera. Po potwierdzeniu tej 
czynności urządzenie zostanie usunięte z edytora wraz z połączeniami sieciowymi.
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Konfiguracja urządzeń

Przegląd

Edytor graficzny daje dostęp do ustawień urządzenia

Konfiguracja parametrów urządzenia

Konfiguracja urządzenia jest dostępna po dwukrotnym naciśnięciu na urządzenie 
lub naciśnięciu lewego klawisza myszy i wybraniu opcji Edit device parameters. 
Oprogramowanie SoMachine otworzy menu ustawień urządzenia. 
Widok poniżej pokazuje przykładową konfigurację parametrów sterownika PLC 
M238.

Skonfiguruj urządzenie tak jak jest to opisane w sekcji konfiguracji instrukcji 
danego urządzenia.
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Configuring Devices

Overview

The graphical configuration editor provides access to configuration dialog boxes of 
the devices.

Configuring Device Parameters

To configure the device you added to the graphical configuration editor, you can 
either double-click the device or right-click the device and select Edit device 
parameters from the context menu. SoMachine will then open the Parameters 
configuration dialog box for your device. The tasks displayed on the left-hand side 
in the task selection pane vary depending on the selected device.

The following graphic shows a sample Configuration → Parameters screen for an 
M238 logic controller.

Configure your device as described in the Configuration section of the respective 
user manual.
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Powrót do edytora graficznego odbywa się za pomocą przycisku Back lub 
dwukrotnym naciśnięciu widoku graficznym Configuration Overview po lewej 
stronie ekranu.
Uwaga: Jeśli zostanie dodane urządzenie HMI musi ono być połączone do 
odpowiedniego sterownika. Połączenie pomiędzy HMI a sterownikiem musi być 
aktywowane za pomocą funkcji Set active path.

Konfiguracja funkcji wbudowanych

Konfiguracja wbudowanych funkcji urządzenia, takich jak mapowanie wejść i wyjść, 
konfiguracja szybkich liczników, wyjście impulsowe, PWM odbywa sie przez 
wybór pola Embedded Functions. Następnie wybieramy interesującą nas funkcję 
i parametryzujemy tak jak w sekcji Input/Output Configuration (HSC,PTO,PWM) 
instrukcji programowania danego sterownika.
Uwaga: Schneider Electric rekomenduje stosowanie adresowania symbolicznego 
w celu ograniczenia ciągłych zmian w programie oraz możliwości wystąpienia 
błędnego adresowania We/Wy.

 Ostrzeżenie
Niekontrolowane zachowanie urządzenia
Należy sprawdzić i zmodyfikować jeśli to niezbędne adresy uzyte w programie po zmianie 
konfiguracji.

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.
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Konfiguracja komunikacji

Konfiguracja portów komunikacyjnych urządzenia odbywa się przez wybór zakładki 
Communication. Należy wybrać z listy odpowiedni typ komunikacji Serial Line 
(komunikacja szeregowa), Ethernet, CanOpen etc. i skonfigurować parametry  
fizyczne i typ protokołu komunikacyjnego. 
W Protocol Settings (ustawienia protokołu) mamy do dyspozycji przycisk 
Remove/Change Protocol, który umożliwia usunięcie lub edycję parametrów 
protokołu komunikacyjnego.
Można także kliknąć bezpośrednio na poszczególne porty w edytorze graficznym 
ale to skutkuje stworzeniem nowej konfiguracji i usuwa poprzednie ustawienia.

Wybierz odpowiedni protokół z listy i dodaj go przez kliknięcie  przycisku Add and 
close.
Rezultat: Nastąpi wyświetlenie konfriguracji wybranego protokołu po prawej 
stronie ekranu.
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Configuring Communication Settings

To configure the communication ports of your device, select in the device 
configuration the entry Communication. Select the suitable sub entry (Serial Line, 
Ethernet, CANopen etc.) from this list and configure the Physical Settings as well 
as Protocol Settings of the port as described in the respective hardware user 
guide. 

In the Protocol Settings screen SoMachine provides a Remove/Change Protocol 
button that opens the following dialog box to change or remove the configured 
protocol.

You can also open this dialog box by clicking the port of an already available device 
in the graphical configuration editor. But please note that this leads to a new 
configuration of the port and removes the already available configured 
communication settings.

Select the suitable protocol manager from the list and click the Add and close 
button.

Result: The configuration dialog box for the selected protocol will be displayed on 
the right-hand side of the SoMachine screen. 
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Konfiguracja interfejdu początkowego

To configure empty interfaces of your device, proceed as follows:.

Krok Akcja
1 Kliknij pusty kwadrat reprezentujący odpowiedni port twojego urządzenia.
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Configuring Empty Interfaces

To configure empty interfaces of your device, proceed as follows:

Step Action

1 Click the empty rectangle, representing an empty port, of your device graphic.

Result: The Add device dialog box will be displayed. Its contents, that is the available fieldbusses and 
/ or communication managers, depends on the selected device and the specific port. 

2 From the Add device dialog box select the item you want to define for the selected port (in the example 
below a CANopen Optimized manager).

3 Click the Add and close button.
Result: The selected fieldbus or communication manager is now added to the port and the configuration 
dialog box for the selected protocol will be displayed on the right-hand side of the SoMachine screen.

Rezultat: Zostanie wyświetlona lista dostępnych protokołów (okno Add device) komunikacyjnych 
w zależności od wybranego urządzenia.

2 Z okna Add device należy wybrać protokół, który nas interesuje. (w przykładzie poniżej został wybrany 
protokół CANopen Optimized).
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Configuring Empty Interfaces

To configure empty interfaces of your device, proceed as follows:

Step Action

1 Click the empty rectangle, representing an empty port, of your device graphic.

Result: The Add device dialog box will be displayed. Its contents, that is the available fieldbusses and 
/ or communication managers, depends on the selected device and the specific port. 

2 From the Add device dialog box select the item you want to define for the selected port (in the example 
below a CANopen Optimized manager).

3 Click the Add and close button.
Result: The selected fieldbus or communication manager is now added to the port and the configuration 
dialog box for the selected protocol will be displayed on the right-hand side of the SoMachine screen.

3 Naciśnij przycisk Add and close.
Rezultat: Wybrany protokół zostanie dodany do portu urządzenia, a jego parametry wyświetlone po 
prawej stronie ekranu.
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Dodawanie urządzeń (Slave)

Dodawanie urządzeń (Slave) do sieci komunikacyjnej na przykładzie protokołu 
CANopen:

Krok Akcja
1 Kliknij na pusty port w edytorze konfiguracyjnym.
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Adding Slave Devices to a Fieldbus Manager

To add a slave device to a fieldbus manager, proceed as described in the following 
(using a CANopen device as an example):

Step Action

1 Click on a free port of the fieldbus manager in your graphical configuration editor.

Result: The Add device dialog box will be displayed.Rezultat: Nastąpi otwarcie okna Add device
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Adding Slave Devices to a Fieldbus Manager

To add a slave device to a fieldbus manager, proceed as described in the following 
(using a CANopen device as an example):

Step Action

1 Click on a free port of the fieldbus manager in your graphical configuration editor.

Result: The Add device dialog box will be displayed.
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Krok Akcja
2 Wybierz odpowiednie urządzenie z listy i wciśnij przycisk Add lub Add and close.

Rezultat: Ikona dodanego urządzenia pojawi się w edytorze graficznym podłączona do menadżera 
CANopen_Optimized.
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To delete a slave device, select it in the graphical configuration editor and hit the 
DELETE key or right-click the slave device and select Remove from the context 
menu.

2 Select a suitable device from the list and click the Add or Add and close button.
Result: The icon of the selected device will be displayed in the graphical configuration editor, connected 
to the CANopen_Optimized manager.

Step Action

Usuwanie urządzeń z sieci odbywa się przez wybranie go i naciśnięcie przycisku 
DELETE na klawiaturze komputera lub wyborze funkcji Remove w edytorze 
graficznym okna Add device.
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Dodawanie modułów rozszerzeń

Krok Akcja
1 Kliknij przycisk Add Expa... w edytorze graficznym
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Adding Expansion Modules

To add expansion modules to your device, proceed as follows:

Step Action

1 Click in the graphical configuration editor on the area Add Expa... of the device.

Result: The Add device dialog box opens, displaying only those expansion modules that can be 
connected to the selected device like in the graphic below for an M238 logic controller.
Rezultat: Nastąpi otwarcie okna Add device z listą dostępnych modułów rozszerzeń dla danego 
urządzenia (tak jak na widoku poniżej dla sterownika M238)
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Adding Expansion Modules

To add expansion modules to your device, proceed as follows:

Step Action

1 Click in the graphical configuration editor on the area Add Expa... of the device.

Result: The Add device dialog box opens, displaying only those expansion modules that can be 
connected to the selected device like in the graphic below for an M238 logic controller.

2 Wybierz moduł z listy i wciśnij przycisk Add lub Add and close.
Rezultat: Moduł zostanie dodany po prawej stronie sterownika .
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Moduły rozszerzeń są wyświetlane po prawej stronie urządzenia. Można ukryć 
te moduły przez naciśnięcie przycisku Add Expa... aby je skonfigurować należy 
kliknąć na nie dwa razy.
Uwaga: Jeśli dodamy moduł TWDNOI10M3 (moduł master AS-Interface) nastapi 
otwarcie menadżera konfiguracji sieci Virtual AS Interface bus. Dodawanie 
urządzeń do sieci AS odbywa się identycznie jak w przypadku konfiguracji innych 
sieci komunikacyjnych opisanych powyżej.

Zamknięcie okna konfiguracji

Zamknięcie okna konfiguracji odbywa się przez kliknięcie przycisku Back lub 
podwójne kliknięcie grafiki konfiguracji Configuration Overview po lewej stronie 
ekranu.
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Detekcja błędów konfiguracji

Informacje o błędach konfiguracji

Edytor graficzny zaznacza na czerwono błędnie skonfigurowane urządzenia.
Okno poniżej pokazuje błędnie skonfigurowaną sieć CanOpen przez przydzielenie 
tego samego adresu dwóm urządzeniom.
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Detecting Configuration Errors

Indication of Detected Configuration Errors

The graphical configuration editor indicates errors detected in the configuration by 
displaying the respective icons in red.

The graphic below provides an example of a detected CANopen configuration error 
with 2 devices being assigned the same Node ID:
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Naprawa błędów konfiguracji

Oprogramowanie asystuje przy usuwaniu błędów.
Przykład rozwiązania problemu nadania tego samego adresu dwóm urządzeniom.

Krok Akcja
1 Kliknij na czerwoną ikonę (w poniższym przykładzie edytor CANopen) aby wyświetlić dodatkowe 

informacje na temat błędu.

2 Kliknij na przycisk Modify address configuration
Rezultat: Wyświetli się okno Address settings.
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Correcting Detected Configuration Errors

SoMachine assists you in correcting detected configuration errors. 

You can solve a detected configuration error concerning the multiple use of node IDs 
(shown in the above example) as follows:

NOTE: Be sure that any and all physical address setting mechanisms on the 
devices, if any, conform to the address settings in the software configuration.

Step Action

1 Click the red icon (in the above example the CANopen Manager) to display further information on the 
specific detected configuration error in the information pane on the right-hand side.

2 To solve this issue, click the Modify address configuration button.
Result: An Address settings dialog box will be displayed.

3 In the Address settings dialog box you can check the addresses and correct them manually by 
changing the Node ID of 1 device or you can click the Fix address conflicts button to have the address 
conflict automatically corrected by SoMachine.

3 W oknie Address settings można sprawdzić aktualny adres urządzenia i w razie potrzeby dowolnie 
go zmienić za pomocą parametru Node ID lub przez kliknięcie Fix address conflicts, który przydzieli 
adresy automatycznie.

Uwaga: Upewnij się, że wszystkie adresy w urządzeniach odpowiadają adresom 
skonfigurowanym w oprogramowaniu SoMachine.
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Dostęp do ekranu programowania i funkcji aplikacyjnych z poziomu edytora 
graficznego.

Przegląd

Edytor graficzny daje dostęp bezpośrednio do środowiska programowania 
CoDeSys.

Programowanie

Kliknij prawym przyciskiem na urządzenie, następnie wybierz Open program-
Application.
Rezultat: Nastąpi otwarcie zakładki Program, dającej dostęp do interfejsu 
programowania.

Wybór aktywnej aplikacji

W przypadku kilku aplikacji dostępnych w edytorze konfiguracji mamy możliwość 
wyboru, która aplikacja ma być aktywna.
Definiowanie aktualnej aplikacji odbywa się przez kliknięcie prawym przyciskiem 
myszy na urządzenie i wyborze funkcji Set application active.
Rezultat: Zostanie wyświetlone zielone kółko wskazujące na aktywną aplikację.

Dodawanie aplikacji

Jeśli twoje urządzenie nie posiada jeszcze aplikacji, można ją stworzyć 
następująco:
Należy nacisnąć prawym przyciskiem myszy na urządzenie i wybrać funkcję Add 
application, wpisać nazwę i nacisnąć Open.
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Zmiana Firmware

Zmianę firmware można dokonać przez naciśnięcie prawym przyciskiem myszy 
na urządzenie i wybranie funkcji Update firmware. Zostanie otwarty specjalny 
przewodnik, który przeprowadzi użytkownika przez cały proces.
Zmiana Firmware skasuje całkowicie aplikację z pamięci sterownika.

 Uwaga
Utrata aplikacji 

pp Utwórz backup aplikacji przed zmianą firmware w sterowniku.
pp Ponownie wgraj aplikacje do sterownika po zmianie firmware.

Nie wykonanie powyższych kroków grozi utratą aplikacji lub uszkodzeniem 
urządzenia.

Zmiana wersji urządzenia

Funkcja Update Device Version umożliwia zmianę wersji każdego z urządzeń do 
najnowszego dostępnego. Nie ma możliwości na dowolną zmianę wersji.
Przykładem zastosowania tej funkcji jest sytuacja w której nasze urządzenie 
jest oznaczone czerwonym kółkiem. To oznacza, że ta wersja urządzenia nie 
jest zainstalowana. Zastosowanie funkcji Update Device Version spowoduje 
zastąpienie wersji urządzenia najnowszą mozliwą zainstalowaną w naszym 
oprogramowaniu. Po wykonaniu tej czynności czerwone kółko zniknie.
W przypadku informacji o manualnej zmianie wersji urządzenia należy odnieść się 
do dokumentacji „Updating Devices to their Latest Version” dostępnej w oknie Start 
(Windows) → Schneider Electric → SoMachine → Documentation.

Zmiana urządzenia

Oprogramowanie SoMachine umożliwia zmianę urządzenia skonfigurowanego w 
twojej aplikacji na podobne kompatybilne. Więcej informacji znajduje się rozdziale 
„Zmiana urządzenia”.
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Tworzenie połączeń sieciowych

Przegląd

Edytor graficzny umożliwia proste połączenie portów komunikacyjnych przez 
połączenie ich liniami.
Edytor automatycznie sprawdza kompatybilność łączonych portów i podpowiada 
rozwiązanie. 

Tworzenie połączeń sieciowych

Krok Akcja
1 Przesuń kursor nad port komunikacyjny, który chcesz połączyć.

Rezultat: Kursor zmieni swój wygląd na krzyżyk. Typ portu zostanie wyświetlony na ekranie konfiguracji.

2 Naciśnij i przytrzymaj kursor na porcie komunikacyjnym, który chcesz połączyć.
Rezultat: Kursor zamieni się w ołówek i nastąpi rysowanie linii w trakcie ruchu.

3 Przeciągnij linie do drugiego portu który chcesz połączyć.
Rezultat: Ołówek narysuje linie pomiędzy dwoma protami.

4 Zwolnij lewy przycisk myszy nad drugim portem, który chcesz połączyć.
Rezultat: Ołówek zamieni się w normalny kursor, a linia zmieni kolor w zależności od typu połączenia 
(definicja kolorów poniżej).
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Krok Akcja
5 Zostanie otwarte menu zawierające wszystkie funkcje niezbędne do skonfigurowania parametrów 

komunikacji obydwu urządzeń:
pp Copy parameters from start to end device (kopiuj parametry z początkowego do końcowego 
urządzednia)

pp Copy parameters of end device to start device (kopiuj parametry z końcowego do początkowego 
urządzednia)

pp Setup communication parameters of both devices (usuwa parametry dla obydwu urządzeń)
Jeśli zostanie wybrana funkcja Setup communication parameters of both devices nastąpi otwarcie 
menu umożliwiające ustawienie parametrów każdego z urządzeń indywidualnie. To menu zostanie 
także otwarte w przypadku podwójnego kliknięcia na linię łączącą urządzenia lub wyborze funkcji Edit 
parameters.
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Color Definitions

The type of network connection is indicated by the color of the connection lines:

5 A context menu will be displayed providing the following possibilities to configure the communication 
parameters of the 2 devices:

Copy parameters from start to end device
Copy parameters of end device to start device
Setup communication parameters of both devices

If you select the command Setup communication parameters of both devices, the configuration 
dialog box for this communication type will be displayed where you can enter the suitable settings 
manually. This dialog box will also be displayed by double-clicking a network connection line or right-
clicking it and selecting Edit parameters from the context menu.

To save your settings, select the Save command from the General Functions Menu (see page 26).
To return to the graphical configuration editor, click the Back button on the left-hand side of the screen 
or double-click the Configuration Overview graphic.
To leave the settings on both sides unchanged, click anywhere else in the graphical configuration editor. 
The context menu will be closed.

Step Action

Network Connection Line Color Network Connection Type

black Modbus

blue Ethernet

purple CANopen

gray connection to a generic port (no compatibility 
check performed by SoMachine)

Zapisanie ustawień odbywa się przez kliknięcie na komendę Save z menu głównego. Powrót do 
edytora konfiguracji odbywa się przez kliknięcie przycisku Back lub podwójnego kliknięcia na grafikę 
Configuration Overview aby anulować dokonane zmiany należy kliknąć na dowolny obszar w edytorze 
konfiguracji (nastąpi zamknięcie aktualnego menu)

Definicja kolorów

Typ połączeń jest oznaczony odpowiednim kolorem

Kolor połączenia sieciowego Typ połączenia sieciowego
czarny Modbus

niebieski Ethernet

fioletowy CANopen

szary połączenie ogólnego (brak kompatybilnego 
połączenia)
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Kasowanie połączeń sieciowych

Kasowanie połączenia sieciowego odbywa sie przez zaznaczenie danej linii 
i wyborze opcji Delete z dostępnego menu lub wciśnięciu klawisza DELETE 
na klawiaturze komputera. Jeśli zaakceptujemy tą czynność nastąpi usunięcie 
połączenia sieciowego. Ustawienia parametrów komunikacji pozostaną bez zmian. 

Sprawdzenie błędów

Oprogramowanie SoMachine automatycznie sprawdza poprawność połączeń i 
wyświetla komunikaty w przypadku błędu.
Jest możliwość wyłączenia tej funkcji przez kliknięcie prawym przyciskiem myszy 
na połączenie sieciowe i wybranie funkcji Disable consistency checks (wybrane 
połaczenie sieciowe zostanie zaznaczone czerwonym paskiem).
Ponowna aktywacja sprawdzania poprawności odbywa się przez kliknięcie 
prawym przyciskiem myszy na połączenie sieciowe i wybraniem funkcji Disable 
consistency checks.
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Co zawiera ta część?
Ta część zawiera następujące rozdziały:

Sekcja Temat Strona
6.1 Informacje ogólne 90

6.2 Zarządzanie obiektami aplikacji 93

6.3 Dodawanie urządzeń 109

6.4 Zarządzanie bibliotekami 119

6.5 Zarządzanie portami komunikacyjnymi 139

6.6 Komendy SoMachine ułatwiające programowanie 161

6.7 Komendy SoMachine 170

6.8 Wymiana danych SoMachine-HMI 182

6.9 SoMachine przykładowy program 192

6.10 Zarządzanie przykładowym programem 204

6.11 Zarządzanie funkcjami 217

6.12 Wgranie i uruchomienie aplikacji 226

6.13 Wyszukanie najnowszego firmware 231
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What’s in this Chapter?

This chapter contains the following sections:

Section Topic Page

6.1 General Information 90

6.2 Managing the Application Objects 93

6.3 Adding Devices 109

6.4 Managing the Libraries 119

6.5 Managing the Communication Ports 139

6.6 SoMachine Commands Simplifying Programming 161

6.7 SoMachine Commands 170

6.8 SoMachine Controller-HMI Data Exchange 182

6.9 SoMachine Templates 192

6.10 Managing Device Templates 204

6.11 Managing Function Templates 217

6.12 Downloading and Running Applications 226

6.13 Check for the Latest Firmware 231
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Opis ogólny zakładki Program

Przegląd

Zakładka Program jest widoczna wyłącznie po otworzeniu projektu SoMachine.
Dostajemy dostęp do środowiska programowania CoDeSys. Wszystkie ustawienia 
konfiguracyjne dokonane wcześniej, są widoczne w menu Devices view. Mogą 
byc one modyfikowane, usuwane i/lub dodawane z tego poziomu. Wszystkie 
zmiany dokonane w tym miejscu będą widoczne w zakładce konfiguracji.

6.1	 Informacje ogólne
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Elementy zakładki Program

Poniższa grafika pokazuje widok zakładki Program z przykładową konfiguracją:

1.	 zakładka menu
2.	 narzędzia

Program
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Elements of the Program Tab

The following graphic shows the Program tab with a sample configuration:

1 menu bar
2 toolbar
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pp 3 edytor
pp 4 panel wiadomości
pp 5 informacje i status
pp 6 status
pp 7 urządzenia

Ten interfejs użytkownika zawiera kilka obszarów, które można dowolnie ustawiać 
na ekranie w zależności od wymagań użytkownika.
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6.2	 Zarządzanie obiektami aplikacji

Co zawiera ta sekcja?

Ta sekcja zawiera następujące tematy:

Temat Strona
Dodawanie zadań programu (Task) 94

Dodawanie i deklarowanie podprogramów 95

Dodawanie bibliotek 97

Dodawanie i deklaracja zmiennych 100

Dodawanie konfiguracji symboli 102

Dodawanie innych obiektów 103

Wstęp do danych logowania 104

Wstęp do zmiennych sieciowych (NVL) 106
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Dodawanie zadań programu (Task)

Wstęp

Okno urządzeń umożliwia dodawanie zadań do aplikacji

Procedura

Aby dodać urządzenie postępuj następująco:

Krok Akcja
1 Naciśnij prawy przycisk na Task Configuration i wybierz z menu  

Add Object → Task... 
2 W menu Add Task podaj nazwę zadania.

Uwaga: Nazwa nie może zawierać spacji, polskich znaków oraz nie może 
przekroczyć 32 znaków.

3 Naciśnij Open
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Dodawanie i deklarowanie podprogramów

Wstęp

Okno Devices umożliwia dodawanie POU  (Program Organization Units)  
podprogramów , bloków funkcyjnych i funkcji do twojej aplikacji.

Dostępne, są różne POU:
pp Program stanowiący podstawową jednostkę służącą do wprowadzania kodu 
źródłowego.

pp Function Block: Blok funkcyjny do wielokrotnego użytku w programie, 
posiadający swoje zmienne wejściowe i wyjściowe.

pp Function: Funkcja umożliwiająca wykonanie konkretnej operacji.

Dodawanie POU

Aby dodać POU należy:

Krok Akcja
1 Naciśnij prawym klawiszem myszki na Aplication i wybierz Add Object → 

POU.

2 W menu Add POU nadaj nazwę POU.
Uwaga: Nazwa nie może zawierać polskich znaków oraz spacji. Jeśli nie podasz 
żadnej nazwy zostanie ona przydzielona automatycznie.
Wskazówka: Nadanie nazwy własnej POU ułatwia organizację projektu.



96

Program

Krok Akcja
3 Wybierz typ POU:

pp Program
pp Function Block:

	 a. �Wybierz Extends i kliknij na wyszukiwarkę aby wybrać blok funkcyjny 
z Input Assistant.

	 b. Wcisnij przycisk OK
	 c. �Wybierz Implements i kliknij na wyszukiwarkę aby wybrać interfejs z Input 

Assistant.
	 d. Wcisnij przycisk OK.
	 e. �Z listy Method implementation language, wybierz odpowiedni język 

programowania do edycji tego bloku funkcyjnego.
pp Function:

	 a. �Kliknij na wyszukiwarkę aby wybrać typ Return type, który chcesz mieć 
w Input Assistant.

	 b. Wcisnij przycisk OK
4 Z listy Implementation language, wybierz odpowiedni język programowania do 

edycji tego programu.

5 Wciśnij przycisk Open.

Deklaracja POU

Przynajmniej 1 POU musi być zadeklarowane w Task Configuration:

Krok Akcja
1 Podwójnie kliknij na zakładkę Task Configuration sterownika.

2 Wybierz odpowiedni Task i w zakładce POU wciśnij Add POU.

3 W sekcji Categories z menu Input Assistant wybierz Programs (Project).
4 Odhacz okienko Structured view.

5 W polu Items wybierz odpowiednie POU.

6 Kliknij przycisk OK.
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Dodawanie bibliotek

Wstęp

Okno Devices umożliwia dodawanie bibliotek za pomocą menadżera Library 
Manager. Dodawanie standardowych bibliotek odbywa sie przez bezpośrednie 
dodanie ich z listy dostępnych bibliotek. Dodawanie własnych bibliotek opisane jest 
w dodatkowej dokumentacji.

Dodawanie standardowych bibliotek

Kompatybilność standardowych bibliotek jest kontrolowana przez oprogramowanie 
SoMachine, co umożliwia otwieranie projektów i wgrywanie ich do urządzeń o innej 
wersji. 
Za każdym razem jak uaktualniasz oprogramowanie SoMachine zweryfikuj 
używane biblioteki w projekcie. 

 Ostrzeżenie
Niekontrolowane zachowanie urządzenia 

pp Sprawdź czy biblioteki w twoim programie odpowiadają wersji oprogramowania 
SoMachine.

pp Sprawdź czy wersja bibliotek zgadza sie ze specyfikacją aplikacji.

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.
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Procedura dodawania standardowych bibliotek

Dodawanie standardowych bibliotek odbywa sie następująco:

Krok Akcja
1 Kliknij dwukrotnie na Library Manager w oknie Devices.

Rezultat: Nastąpi otwarcie edytora Library Manager pokazującego listę bibliotek zainstalowanych dla 
danego urządzenia.

2 W edytorze kliknij Add library... .
Rezultat: Nastąpi otwarcie okna Add Library.

3 W oknie Add Library wybierz zakładkę Placeholder.

Program
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Procedure of Adding Standard SoMachine Libraries

To add a standard library that is included in the SoMachine scope of delivery, use 
the placeholder concept as described in the following:

Step Action

1 Double-click the Library Manager node in the Devices window.
Result: The Library Manager editor opens, showing the libraries that are by default inserted with the 
selected device.

2 In the editor click the Add library... link.
Result: The Add Library dialog box opens.

3 In the Add Library dialog box select the Placeholder tab.
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Krok Akcja
4 Konfiguracja mechanizmu Placeholder odbywa się następująco:

pp wybierz z listy Placeholder name. Nazwy sa identyczne z nazwami bibliotek,oprócz bibliotek 
Schneider Electric, które są poprzedzone symbolem SE_).

pp Wybierz odpowiednią bibliotekę z listy.Wersja biblioteki jest uzależniona od wersji urządzenia.

5 Wcisnij OK.
Rezultat: Biblioteka zostanie dodana do menadżera Library Manager, np. SE_Standard = Standard, 
33.3.1.10 (System).
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Dodawanie i deklaracja zmiennych
Wstęp

Sekcja opisuje różnego typu zmienne oraz sposób dodania ich do naszej aplikacji.

Typy zmiennych

Zadeklarowane zmienne mogą być różnego typu i mieć różne zachowanie 
w aplikacji. Zmienne podtrzymywane mogą pamiętać swój stan po utracie 
zasilania, resecie, lub zmianie programu. dostepnych jest kilka typów zmiennych 
„retain”, „persistent” lub kombinacja „retain-persistent” 
Uwaga: Więcej informacji znajduje sie w online help SoDeSys .

Mapowanie pamięci

Tabela poniżej pokazuje więcej informacji na temat poszczególnych sterowników:

Urządzenie Dokumentacja
Sterownik PLC Modicon M238 Memory mapping (see Modicon M238 Logic

Controller, Programming Guide)

Sterownik PLC Modicon M258 Memory mapping (see Modicon M258 Logic
Controller, Programming Guide) 

Kontroler Motion Modicon M238 Memory mapping (see Modicon LMC058 Motion
Controller, Programming Guide)

Sterownik zintegrowany w napędzie  
ATV IMC

Memory mapping (see ATV IMC Drive Controller,
Programming Guide)

Sterownik zintegrowany XBTGC Memory mapping (see Magelis XBTGC HMI
Controller, Programming Guide)
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Dodawanie zmiennych Persistent

Zmienne Persistent, są zmiennymi globalnymi aby dodać te zmienne należy 
postępować następująco:

Krok Akcja
1 Kliknij prawym przyciskiem myszy na zakładkę Application i wybierz Add Object → Persistent 

Variables....
2 W menu Add Persistent Variables wpisz nazwę listy w polu Name.

3 Kliknij Open.
Przykład:

Program
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Adding a Persistent Variables List

Persistent variables are declared in a global variables list called Persistent 
Variables. To add this list in an application, do the following: 

Declaring Persistent and Retain Variables

Refer to the CoDeSys part of the online help.

Step Action

1 Right-click the Application node of the controller, or the Application node of the 
HMI, and choose Add Object → Persistent Variables....

2 In the Add Persistent Variables dialog box type a name for this list in the Name text 
box.

3 Click Open.
Example:

Result: A persistent variable node is created in the Devices view.
Note: The variables list is edited in the editing area whereby 
VAR_GLOBAL PERSISTENT RETAIN already is preset in the first line.
Example:

Rezultat: Zostanie stworzona zakładka Persistent variable w widoku Devices.
Uwaga: Lista zmiennych jest poprzedzona wpisem:
VAR_GLOBAL PERSISTENT RETAIN w pierwszej linii edytora. 
Przykład:

Program
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Adding a Persistent Variables List

Persistent variables are declared in a global variables list called Persistent 
Variables. To add this list in an application, do the following: 

Declaring Persistent and Retain Variables

Refer to the CoDeSys part of the online help.

Step Action

1 Right-click the Application node of the controller, or the Application node of the 
HMI, and choose Add Object → Persistent Variables....

2 In the Add Persistent Variables dialog box type a name for this list in the Name text 
box.

3 Click Open.
Example:

Result: A persistent variable node is created in the Devices view.
Note: The variables list is edited in the editing area whereby 
VAR_GLOBAL PERSISTENT RETAIN already is preset in the first line.
Example:

Deklaracja zmiennych Persistent i Retain

Odnieś się do pomocy online CoDeSys
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Dodawanie konfiguracji symboli

Wymagania wstępne

Zmienne, które będą wymieniane pomiędzy sterownikiem PLC, a panelem 
operatorskim HMI za pomocą protokołu SoMachine muszą być zadeklarowane 
w konfiguracji symboli Symbol Configuration. Tylko wtedy będą dostępne w Vijeo 
Designer.

Dodawanie konfiguracji symboli

Aby dodać Symbol Configuration należy postępować następująco:

Krok Akcja
1 Kliknij prawym przyciskiem myszy na zakładkę Application i wybierz Add Object → Symbol 

configuration....
Rezultat: Zostanie wyświetlone okno Add Symbol configuration.

2 W oknie Add Symbol configuration zostanie wyświetlona nazwa Symbol configuration w polu Name.
Kliknij Open.
Rezultat: Zakładka Symbol configuration dodana do drzewka Application w oknie Devices. 
Po prawej stronie ekranu zostanie wyświetlony edytor konfiguracji symboli.

Uwaga: Tylko jedna konfiguracja symboli morze być stworzona dla danego 
urządzenia.
Więcej szczegółów wymiany zmiennych pomiędzy sterownikiem i panelem 
operatorskim znajduje się w rozdziale „Wymiana danych SoMachine-HMI”
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Dodawanie innych obiektów

Dostępne obiekty

W zależności od sterownika mamy do dyspozycji następujące obiekty:
pp CAM table dostepne wyłącznie dla sterownika posiadającego protokół 
CANmotion, w formie tekstowej lub tabela.

pp Data Server ustanawia połączenie point-to-point pomiędzy lokalną aplikacją i 
zdalnym źródłem danych (np. OPC serwer).

pp DataLogManager tworzenie własnych plików logowania informujących o statusie 
maszyny.

pp DUT (Data Unit Type) tworzenie własnych typów danych.
pp Global Variable List tworzenie zmiennych globalnych dostępnych dla całej 
aplikacji.

pp Image Pool Zbiór dodatkowych obrazów, wizualizacji.
pp Interface organizowanie metod używanych w blokach funkcyjnych.
pp POUs for implicit checks funkcjonalność sprawdzania błędów w programie np. 
dzielenie przez zero.

pp Relocation Table tabela zmiennych do przydzielania automatycznych adresów.
pp Text List dynamiczna zmiana tekstu np. na inny język w wizualizacji.
pp Trace oscyloskop do podglądu przebiegu zmiennych w czasie.
pp Visualization tworzenie własnej wizualizacji do monitorowania i sterowania 
aplikacją.

pp Visualization Manager obsługa wizualizacji.
Więcej informacji w pomocy online programu CoDeSys.

Dodawanie obiektów

Aby dodać obiekt do aplikacji postępuj następująco:

Krok Akcja
1 Przyciśnij prawy klawisz myszy na zakładce Application i wybierz Add Object.

Wybierz odpowiedni obiekt.

2 W zakładce Add wybierz komendę Open.
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Wstęp do danych logowania

Przegląd

Monitorowanie i analiza danych aplikacji za pomocą pliku .log.

Schemat pokazuje aplikację z dwoma blokami funkcyjnymi LogRecord 
i Dump. LogRecord FB zapisuje dane do bufora, który przesyła dane do pliku 
.log w pamięci sterownika. Plik zostaje zapisany automatyczne w momencie 
przekroczenia 80% pamięci lub wymuszony przez funkcje Dump. Plik jest dostępny 
na serwerze FTP sterownika lub możliwy do zgrania przez oprogramowanie 
SoMachine lub web serwer.
Uwaga: Ta funkcja jest dostępna wyłącznie w sterownikach z funkcją obsługi 
plików. Oprogramowanie nie sprawdza kompatybilności sterownika z funkcja pliku 
.log.

Program

104 EIO0000000067 04/2012

Introduction to Data Logging

Overview

You can monitor and analyze application data by examining the data log file (.log).

The figure shows an application that includes the 2 function blocks, LogRecord and 
Dump. The LogRecord function block writes data to the buffer, which empties into 
the data log file (.log) located into the controller’s memory. The buffer dumping is 
automatic when 80% full or it can be forced by the Dump function. As a standard FTP 
client, a PC can access this data log file when the controller acts as an FTP server. 
It is also possible to upload the file with SoMachine or by the controller’s web server.

NOTE: Only controllers with file management functionality can support data logging. 
Refer to your controller’s programming manual to see if it supports file management. 
The software itself does not evaluate your controller for compatibility with data 
logging activities.

FB
LogRecord

FB
Dump

Bufor 
pliku .log

Dane x
Dane y
Dane z

Nowy 
plik .log

LogFile.log

Dane 1
Dane 2
Dane 3
Dane 4
Dane 5
Dane 6

…

Autom
atyczne

 zgranie pliku

Wymuszenie zgrania pliku

Aplikacja
sterownika

Pamięć 
sterownika

Dostęp do pliku poprzez 
Web Serwer lub serwer 
FTP sterownika.

Plik .log

Plik .log

Komenda 
zgrania pliku
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Widok przykładowego pliku .log.
Entries in File: 8; Last Entry: 8;

18/06/2009;14:12:33;cycle: 1182;

18/06/2009;14:12:35;cycle: 1292;

18/06/2009;14:12:38;cycle: 1450;

18/06/2009;14:12:40;cycle: 1514;

18/06/2009;14:12:41;cycle: 1585;

18/06/2009;14:12:43;cycle: 1656;

18/06/2009;14:14:20;cycle: 6346;

18/06/2009;14:14:26;cycle: 6636;

Procedura uruchomienia

Należy skonfigurować obsługę pliku .log zanim zaczniemy pisać program.
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Wstęp do zmiennych sieciowych (NVL)

Przegląd

Lista zmiennych sieciowych (NVL) zawiera zmienne które mogą być wymieniane 
pomiędzy urządzeniami działającymi w jednej sieci, pod warunkiem że sterownik 
posiada taką funkcjonalność.
Lista zmiennych musi być zadeklarowana w sterowniku wysyłającym 
i odbierającym. Wartości są transmitowane w sposób broadcastowy za pomocą 
protokołu User Datagram Protocol (UDP). UDP jest protokołem internetowym 
IP zdefiniowanym przez IETF RFC 768. UDP/IP nie wymaga informacji zwrotnej 
i dzięki temu jest idealnym rozwiązaniem dla transmisji danych.
Wymiana danych NVL ma pewne ograniczenia i nie może odpowiadać za przesył 
danych związanych z bezpieczeństwem maszyny.
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 Ostrzeżenie
Niekontrolowane zachowanie urządzenia 

pp Należy uwzględnić możliwość utraty komunikacji NVL i przewidzieć bezpieczne 
procedury do obsługi tego błędu.

pp Dla krytycznych funkcji aplikacji należy przewidzieć redundantne rozwiązanie
pp Należy dokładnie przetestować rozwiązanie przed zastosowaniem jej do użytku

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.

Należy zastosować odpowiednią diagnostykę i zarządzanie błędami do 
monitorowania statusu komunikacji. NVL jest przeznaczona do wymiany danych 
i monitoringu i nie powinna być stosowana w kluczowych funkcjach działania 
aplikacji.

Lista zmiennych sieciowych (NVL)

Zmienne sieciowe, są deklarowane w dwóch typach list:
pp Global Variables Lists (GVL) w sterowniku wysyłającym
pp Global Network Variables Lists (GNVL) w sterowniku odbierającym

Odpowiednio lista GVL i GNVL posiadają zadeklarowane te same zmienne. 
Zawartość poszczególnych list można edytować klikając dwa razy na listę w 
zakładce Devices.
GVL zawiera zmienne wysyłane. W zakładce Network properties możemy 
ustawić parametry transmisji. W zależności od tych ustawień zmienne, są 
rozsyłane w sieci i mogą być odbierane przez wszystkie sterowniki z odpowiednią 
listą GNVL.
Uwaga: Do wymiany zmiennych sieciowych muszą być zainstalowane 
odpowiednie biblioteki, które są dodawane automatycznie po stworzeniu 
komunikacji UDP i ustawieniu parametrów.
Zmienne sieciowe, są rozsyłane do jednego lub kilku odbiorców GNVL. Dla 
każdego sterownika można zdefiniować GVL i GNVL czyli każdy sterownik może 
wysyłać i odbierać zmienne sieciowe.
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Lista GVL może być zaimportowana z innego projektu. Tworząc listę GNVL 
nadawca GVL może być wybrany z listy wszystkich dostępnych w sieci lub może 
być zaimportowany z wcześniej wyeksportowanego pliku GVL (np. używając 
zakładki Link to File).
Uwaga: wyeksportowany plik jest niezbędny w przypadku listy GVL zdefiniowanej 
w innym projekcie.

Dostępność i ograniczenia NVL 

Lista poniżej przedstawia sterowniki obsługujące komunikację NVL:

Nazwa funkcji M238 M258
LMC058

XBTGC
XBT GK
XBT GT

ATV IMC

Lista Zmiennych 
Sieciowych NVL 

Nie Tak Tak Tak *

*ATV IMC supports NVL only in freewheeling tasks.

Schemat poniżej pokazuje sieć zawierającą 1 nadawce i rekomendowaną liczbę 
7 odbiorców:

Controller Sender A (nadawca A): Nadawca z listąt (GVL) i odbiorca z listą 
(GNVL)
Controller Receiver 1...7 ( Odbiorca 1...7): Odbiorcy (GNVL) z nadawcy A (GVL)
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A sender GVL can be provided by the same or by another project. So, when creating 
a GNVL, the sender GVL can either be chosen from a selection list of all available 
GVLs within the network, or it can be read from an export file, which previously has 
been generated (for example, by using the Link to File dialog box) from the GVL. 

NOTE: An export file is needed if the sender GVL to be used is defined within 
another project.

NVL Considerations

The following table shows the list of controllers that support the network variables 
list (NVL) functionality:

The figure shows a network consisting of 1 sender and the recommended maximum 
of 7 receivers:

Controller Sender A: Sender with the global variables list (GVL) and receiver controller with 
global network variables lists (GNVLs)

Controller Receiver 1...7: Receivers (with GNVL) from A and sender controller (GVL) only 
for A

Function Name M238 M258
LMC058

XBTGC
XBT GK
XBT GT

ATV IMC

Network Variables List No Yes Yes Yes*

*ATV IMC supports NVL only in freewheeling tasks.
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6.3	 Dodawanie urządzeń

Co zawiera ta sekcja?

Ta sekcja zawiera następujące tematy:

Temat Strona
Dodawanie sterownika 110

Dodawanie modułów rozszerzeń 111

Dodawanie menadżera komunikacji 113

Dodawanie urządzeń do menadżera komunikacji 115

Dodawanie urządzeń używając szablonu 118
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Dodawanie sterownika

Wstęp

W momencie dodania sterownika do projektu, automatycznie zostaną dodane 
wszystkie zakładki związane z danym sterownikiem w oknie w oknie Devices.
Poniższa instrukcja przedstawia procedurę dodawania sterownika. Szczegółowe 
dane na temat sterowników znajdują się w instrukcji obsługi danego sterownika. 

Procedura

Aby dodać sterownik do projektu w menu Program postępuj następująco:

Krok Akcja
1 Kliknij prawym przyciskiem myszy w oknie Devices i wybierz Add Device... .
2 W oknie Add Device wybierz Schneider Electric z listy Vendor.
3 Wybierz sterownik, który chcesz dodać.

4 Nadaj nazwę sterownikowi w zakładce Name.
Uwaga: Nazwa nie może zawierać polskich znaków, spacji oraz być dłuższa niż 
32 znaki. Jeśli nie nadamy nazwy to zostanie ona nadana automatycznie.
Wskazówka: Nadanie własnej nazwy uprości organizację projektu.

5 Kliknij na przycisk Add Device.
Rezultat: Wybrane urządzenie pojawi się w oknie Devices.  
Okno Add Device pozostanie otwarte i umożliwia:

pp dodanie następnego sterownika patrz punkt 3.
pp kliknięcie na przycisk Close i powrót do zakładki Program.
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Dodawanie modułów rozszerzeń

Wstęp

Do projektu można dodać następujące moduły rozszerzeń:

Moduł rozszerzeń Sterownik
TM2 Cyfrowe We/Wy M238 Sterownik PLC, XBTGC HMI

Sterownik

2 TM2 Analogowe We/Wy M238 Sterownik PLC, XBTGC HMI
Sterownik

TM2 szybki licznik We/Wy M238 Sterownik PLC

AS-Interfejs M238 Sterownik PLC

TM5 Cyfrowe We/Wy M258 Sterownik PLC, LMC058
Sterownik Motion

TM5 Analogowe We/Wy M258 Sterownik PLC, LMC058
Sterownik Motion

TM5 Eksperckie We/Wy M258 Sterownik PLC, LMC058
Sterownik Motion

TM5 zasilanie We/Wy M258 Sterownik PLC, LMC058
Sterownik Motion

CANopen (XBT ZGCCAN, XBT ZGCCANS0) XBTGC HMI Sterownik

TM7 Cyfrowe We/Wy M258 Sterownik PLC, LMC058
Sterownik Motion

TM7 Analogowe We/Wy M258 Sterownik PLC, LMC058
Sterownik Motion

 Ostrzeżenie
Niekontrolowane zachowanie urządzenia 

pp Należy stosowań wyłącznie oprogramowanie firmy Schneider Electric do programowania 
powyższych sterowników.

pp Zaktualizuj swoją aplikację za każdym razem jak zmieniasz konfigurację sprzętową.

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.



112

Program

Procedura dodawania modułów rozszerzeń

Aby dodać moduł rozszerzeń postępuj następująco:

Krok Akcja
1 Kliknij prawym przyciskiem myszy na sterownik w oknie Devices i wybierz Add Device... .
2 W oknie Add Device wybierz Schneider Electric z listy Vendor.
3 Wybierz moduł, który chcesz dodać.

4 Nadaj nazwę modułowi w zakładce Name.
Uwaga: Nazwa nie może zawierać polskich znaków, spacji oraz być dłuższa niż 32 znaki. Jeśli nie 
nadamy nazwy to zostanie ona nadana automatycznie.
Wskazówka: Nadanie własnej nazwy uprości organizację projektu.

5 W sekcji Action nie należy zmieniać ustawienia domyślnego Append Device ponieważ dla modułów 
rozszerzeń akcja Insert device i Plug device nie jest dostępna.

6 Wciśnij przycisk Add Device.
Rezultat: Wybrany moduł pojawi się w oknie Devices.  
Okno Add Device pozostanie otwarte i umożliwia:

pp dodanie następnego modułu patrz punkt 3.
pp kliknięcie na przycisk Close i powrót do zakładki Program.

Uwaga: Jeśli dodamy moduł TWDNOI10M3 (AS-Interfejs master), nastąpi 
automatyczne dodanie odpowiedniego menadżera komunikacji. Jeśli chcemy 
dodać urządzenia do menadżera komunikacji AS-Interfejs należy postępować 
zgodnie z rozdziałem Komunikacja urządzeń.

Konfiguracja modułów rozszerzeń

Więcej informacji na temat konfiguracji modułów rozszerzeń znajduje się 
w instrukcji programowania odpowiednich sterowników.
TM2 Expansion Modules Configuration 

pp Programming GuidelTM5 Expansion Modules Configuration 
pp Programming GuidelTM5 PCI Modules Configuration 
pp Programming GuidelModicon TM7 Expansion Blocks Configuration 
pp Programming Guide (seeModicon TM7, Expansion Blocks Configuration, 
ProgrammingGuide)
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 Dodawanie menadżera komunikacji

Przegląd

Menadżer komunikacji jest niezbędny jeśli chcemy skonfigurować interfejs 
komunikacyjny np. CANbus lub połączenie szeregowe.
Istnieją 2 typu menadżerów komunikacyjnych:

pp Menadżer protokołu np. CANopen lub Modbus
pp Menadżer komunikacji ogólny

Menadżery komunikacji dostępne w SoMachine, są opisane poniżej:

Nazwa Typ 
Interfejsu

Opis

ASCII Manager Szeregowy Prosta transmisja danych z urządzeniami 
z portem szeregowym.

SoMachine-Network Manager Szeregowy Stosowana do transparentnego połączenia 
XBTGT, XBTGK lub XBTGH HMI ze 
sterownikiem za pomocą protokołu 
SoMachine. Umożliwia wgranie aplikacji do 
PLC i HMI za pomocą jednego połączenia.

Modbus IOScanner Szeregowy Protokół Modbus RTU lub ASCII 
stosowany do cyklicznej wymiany danych 
z urządzeniami w sieci Modbus.

Modbus Manager Szeregowy Stosowany do komunikacji Modbus RTU 
lub ASCII master-slave.

CANopen Optimized CAN Komunikacja CANopen ze sterownikami 
M238, XBTGC, XBTGT, XBTGK, ATV IMC.

CANopen Performance CAN Komunikacja CANopen ze sterownikami 
M258 i LMC058.

CANmotion CAN Komunikacja CANmotion ze sterownikiem 
Motion (tylko port CAN1).

Modbus TCP Slave Device Ethernet Komunikacja Modbus TCP ze 
sterownikami z portem Ethernet.

EtherNet/IP Ethernet Komunikacja EtherNet/IP ze sterownikami 
z portem Ethernet (M258 i LMC058).
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Dodawanie menadżera komunikacji

Aby dodać menadżer komunikacji należy:

Krok Akcja
1 W oknie Devices kliknij prawym przyciskiem myszy na odpowiedni interfejs 

komunikacyjny (SerialLine lub CANbus) i wybierz Add Device... .
Rezultat: Zostanie wyświetlone okno Add Device.

2 W oknie Add Device wybierz z listy Vendor pozycję <All vendors>.
Uwaga: Można sortować urządzenia klikając na listę Vendor.

3 Wybierz menadżer komunikacyjny z listy.

4 Nadaj nazwę w zakładce Name.
Uwaga: Nazwa nie może zawierać polskich znaków, spacji oraz być dłuższa niż 
32 znaki. Jeśli nie nadamy nazwy to zostanie ona nadana automatycznie.

5 Wciśnij przycisk Add Device.

6 Skonfiguruj Menadżer komunikacji.
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Dodawanie urządzeń do menadżera komunikacyjnego

Przegląd

Możemy dodać urządzenia slave sieci CANopen i Modbus za pomocą komendy 
Add Device.
Urządzenie, które zamierzamy dodać musi być dostępne w Device Repository 
(lista dostępnych urządzeń). Procedura dodawania nowych urządzeń  np. 
CANopen slave za pomocą pliku EDS jest opisana w pomocy online CoDeSys)

Dodawanie urządzeń

Krok Akcja
1 W oknie Devices kliknij prawym przyciskiem myszy na odpowiedni interfejs 

komunikacyjny (SerialLine lub CANbus) i wybierz Add Device... .
Rezultat: Zostanie wyświetlone okno Add Device.

2 W oknie Add Device wybierz z listy Vendor pozycję <All vendors>.
Uwaga: Można sortować urządzenia klikając na listę Vendor.

3 Wybierz urządzenie, który chcesz dodać.

4 Nadaj nazwę w zakładce Name.
Uwaga: Nazwa nie może zawierać polskich znaków, spacji oraz być dłuższa niż 
32 znaki. Jeśli nie nadamy nazwy to zostanie ona nadana automatycznie.
Wskazówka: Nadanie własnej nazwy uprości organizację projektu.

5 Wciśnij przycisk Add Device.
Rezultat: Wybrane urządzenie pojawi się w odpowiednim menadżerze 
komunikacji. 
Okno Add Device pozostanie otwarte i umożliwia:

pp dodanie następnego urządzenia patrz punkt 2.
pp kliknięcie na przycisk Close i powrót do zakładki Program.

Dostęp do informacji diagnostycznych

Aby mieć dostęp do informacji diagnostycznych protokołu CANopen należy użyć 
biblioteki CiA 405.
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Dostęp do informacji diagnostycznych (dla użytkowników zaawansowanych)

W zakładce Service Data Object , są dostępne funkcje Abort if error (anuluj 
w przypadku błędu) i Jump to line if error (przejdź do linii w przypadku błędu) 
służące do obsługi błędów konfiguracji. Więcej informacji na ten temat znajduje się 
w pomocy online CoDeSys.
Do optymalizacji działania sieci CAN diagnostyka jest realizowana za pomocą 
biblioteki CanConfig Extern dostępnej w menadżerze bibliotek (Library 
Menager).
Struktura g_aNetDiagnosis zawiera aktualne informacje diagnostyczne z 
urządzeń w sieci. 
Struktura może być użyta do:

pp Monitorowania odpowiedzi po wysłaniu ramki SDO.
pp Monitorowanie mastera w celu wykrycia błędów inicjalizacji urządzeń slave.

Struktura musi być aktywna w aplikacji podczas testów maszyny lub procesu. Po 
zakończeniu procesu uruchomienia i stwierdzenia stabilnego stanu komunikacji 
można dezaktywować tą część kodu.
w przypadku późniejszych zmian w konfiguracji maszyny należy ponownie 
aktywować funkcję diagnostyczną.

 Ostrzeżenie
Niekontrolowane zachowanie urządzenia 

pp Użyj struktury g_aNetDiagnosis w aplikacji w celu monitorowania odpowiedzi 
pochodzących z urządzeń w sieci CAN.

pp Upewnij się że nie nastąpi uruchomienie maszyny w przypadku  otrzymania błędu 
konfiguracji SDO. 

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.

Po dodaniu biblioteki CanConfig Extern do aplikacji użyj funkcji Net Diagnostic 
do monitorowania urządzeń w sieci CAN.
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Do lepszego zrozumienia struktury diagnostyki sieci CAN przedstawiamy poniższy 
przykład kodu z komentarzami:

IF g_aNetDiagnosis[CAN_Net_Number].ctSDOErrorCounter = 0 THEN
	 (* Brak błędów w konfiguracji*)
ELSE
	 (* Wykryto błąd w konfiguracji, odczytaj kod błędu.*)
	 // odczytaj adres slave który wysłał informację o błędzie
	 ReadLastErrorNodeID :=
g_aNetDiagnosis[CAN_Net_Number].usiNodeID;
	 // wartość indexu błędnego SDO
	 ReadLastErrorIndex :=
g_aNetDiagnosis[CAN_Net_Number].wIndex;
	 // wartość subindexu błędnego SDO
	 ReadLastErrorSubIndex :=
g_aNetDiagnosis[CAN_Net_Number].bySubIndex;
	 //kod błędu SDO
	 ReadLastErrorSdoAbortCode := g_aNetDiagnosis
	 [CAN_Net_Number].udiAbortCode;
(* Nie pozwól na start maszyny lub procesu *)

END_IF

Uwaga: W przykładzie CAN_Net_Number wynosi 0 dla portu CAN0 i 1 dla portu 
CAN1.
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Dodawanie urządzeń używając szablonu urządzeń

Przegląd

Jest możliwe dodanie urządzenia za pomocą szablonu. Więcej informacji 
w rozdziale Zarządzanie szablonami urządzeń. 
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6.4	 Zarządzanie bibliotekami

Co zawiera ta sekcja?

Ta sekcja zawiera następujące tematy:

Temat Strona
Informacje ogólne na temat bibliotek 120

Zarządzanie bibliotekami w SoMachine 123

Biblioteki Schneider Electric 127

Inne biblioteki używane w SoMachine 135

Tworzenie własnych bibliotek 138
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Informacje ogólne na temat bibliotek

Zawartość bibliotek

Biblioteki dostarczają następujące atrybuty, które są wykonywane w systemie 
sterownika:

pp funkcje i bloki funkcyjne
pp definicje typów danych
pp zmienne globalne
pp zmienne systemowe
pp wizualizacje obiektów

Zarządzanie bibliotekami w projekcie jest wykonywane za pomocą menadżera 
bibliotek Library Manager. Instalowanie nowych bibliotek jest wykonywane 
w zakładce Library Repository.

Główne informacje o bibliotekach

W Library Manager i Library Repository znajdują się następujące informacje 
o bibliotekach:

Informacja Opis Przykład
Nazwa nazwa biblioteki M238 PLCSystem

Wersja wersja biblioteki 1.0.1.8

Firma biblioteka należy do firmy Schneider Electric

Nazwa skrócona krótka nazwa którą można uzywać 
w programie

SEC

Kategoria grupowanie bibliotek w kategorie Sterownik → M238

Edytor bibliotek Library Repository

Library Repository to edytor zarządzający bibliotekami zainstalowanymi 
w SoMachine, umożliwia usuwanie/dodawanie bibliotek. Nie można używać 
bibliotek, które nie zostały zainstalowane za pomocą Library Repository. 
Po zainstalowaniu SoMachine zestaw podstawowych bibliotek jest instalowany 
domyślnie.
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Zarządzanie bibliotekami

W projekcie SoMachine, są dostępne w menadżery bibliotek w zależności od 
zastosowania:

Zastosowanie Lokacja
biblioteki dostępne dla całego 
projektu

w oknie POU

biblioteki dostępne dla 
poszczególnych sterowników

w oknie Devices jako zakładka w menu Application.
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Zdjęcie poniżej pokazuje menadżer bibliotek w oknie POU oraz menadżer bibliotek 
w oknie Devices po lewej stronie zakładki Program w SoMachine.

Więcej informacji na temat zarządzania bibliotekami znajduje się w pomocy online 
CoDeSys: Concepts and Base Components / Library Management.

Więcej informacji na temat Library Repositiry znajduje się w pomocy online 
CoDeSys: Menu Commands / Installation / Library Repository.

Więcej informacji na temat Library Manager znajduje się w pomocy online 
CoDeSys: Editors / Library Manager Editor.

Program
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The figure below shows the Library Manager in the POUs window and the Library 
Manager in the Devices window on the left-hand side of the SoMachine Program 
tab:

For more information about library management, refer to CoDeSys online help: 
Concepts and Base Components / Library Management.

For more information about Library Repository, refer to CoDeSys online help: 
Menu Commands / Installation / Library Repository.

For more information about Library Manager, refer to CoDeSys online help: Editors 
/ Library Manager Editor.

In SoMachine, features embedded in libraries might be used for the automation as 
well as for the system (internal). In both cases, libraries are managed with the 
Library Manager of SoMachine.



123

Program

Zarządzanie bibliotekami w SoMachine

Organizacja bibliotek w Library Repository

Istnieją dwa typy bibliotek:
Automation libraries: biblioteki do użytku w programie użytkownika 
System libraries: wewnętrzne biblioteki SoMachine nie uzywane w programie
Domyslne nazwy firm w SoMachine:

pp 3S - Smart Software Solution GmbH
pp CAA Technical Workgroup
pp Schneider Electric
pp System

Biblioteki są pogrupowane w następujące kategorie:
pp (Miscellaneous): biblioteki bez kategori
pp Application: biblioteki do aplikacji automatyki
pp Communication: biblioteki do komunikacji
pp Controller: biblioteki dedykowane sterownikom
pp Devices: biblioteki dedykowane urządzeniom (TeSys, Altivar, Lexium)
pp Intern: biblioteki wewnętrzne i systemowe
pp Solution: biblioteki aplikacyjne (Pakowanie, Dźwigowe, Transport poziomy, etc.)
pp System: biblioteki systemowe
pp Target: bilioteki przeznaczone do odpowiednich platform
pp Use Cases: biblioteki o tym samym zastosowaniu
pp Util: biblioteki z dodatkowymi funkcjami



124

Program

Nazwa ogólna

Nazwa ogólna biblioteki umożliwia dostęp do komponentów biblioteki (funkcje, 
bloki funkcyjne, zmienne...). Użycie nazwy ogólnej jest opcjonalne ale niezbędne 
w przypadku jeśli 2 komponenty z dwóch różnych bibliotek mają te same nazwy. 
W tym przypadku ogólna nazwa <nazwaogólna>.<komponent pozwala na dostęp 
do odpowiedniego komponentu.

Przypadek Opis
1 Istnieje blok funkcyjny GEN w bibliotece Util. Nazwa ogólna biblioteki  

Util to Util. Blok funkcyjny GEN może być zadeklarowany z lub bez nazwy 
ogólnej pod warunkiem, że występuje tylko raz:
MyGenerator: Util.GEN;
lub MyGenerator: GEN;

2 Blok funkcyjnyk GEN został stworzony w projekcie. Użycie nazwy ogólnej  
Util umożliwia dostęp do bloku funkcyjnego GEN w bibliotece Util. Bez 
zastosowania nazwy ogólnej blok funkcyjny GEN jest dostępny z poziomu:
MyGenerator_Util: Util.GEN;
MyGenerator_Project: GEN;

3 Następna biblioteka zawierająca blok funkcyjny GEN jest zadeklarowana 
w projekcie z nazwą ogólną NweLib. Użycie nazwy ogólnej jest obowiązkowe 
do dostępu do właściwego bloku funkcyjnego dostępnego w:
MyGenerator_Util:Util.GEN
MyGenerato_NewLib:NewLib.GEN;

Domyślna nazwa ogólna jest zdefiniowana dla każdej biblioteki. Nazwa ogólna 
biblioteki Schneider Electric zaczyna się od SE.
Domyślna nazwa ogólna biblioteki deklarowana w projekcie może być zmieniona 
w edytorze Library Properties w menu Library Manager (W menadżerze bibliotek 
klikamy prawym przyciskiem myszy na bibliotekę i wybieramy Properties)

Placeholder

Mechanizm Placeholder służy do zarządzania kompatybilnością pomiędzy 
wersjami urządzeń i bibliotek.
W przypadku aktualizacji SoMachin lub urządzeń, odpowiednie pliki DDF (Device 
Description Files), są instalowane. Plik DDF zawiera placeholder, który definiuje 
wersję bibliotek kompatybilnych z wersją urządzenia.



125

Program

W przypadku ręcznej konfiguracji bibliotek w projekcie, należy zastosować 
mechanizm placeholder w celu kompatybilności wersji bibliotek.
Uwaga: Placeholder jest zdefiniowany w pliku DDF. W przypadku tworzenia nowej 
biblioteki należy zdefiniować placeholder dla tej biblioteki. 
W projekcie stworzonym w poprzedniej wersji SoMAchine, wersja biblioteki będzie:

pp niezmieniona dla bibliotek zadeklarowanych z konkretną wersją,
pp automatycznie aktualizuje do najnowszej wersji
pp automatycznie aktualizuje do najnowszej wersji zdefiniowanej w urządzeniu za 
pomocą pliku DDF.

 Ostrzeżenie
Niekontrolowane zachowanie urządzenia 

pp Sprawdź czy biblioteki w twoim programie odpowiadają wersji oprogramowania 
SoMachine.

pp Sprawdź czy wersja bibliotek zgadza sie ze specyfikacją aplikacji.

Niezastosowanie się do tych instrukcji grozi uszkodzeniem ciała lub 
maszyny.

Sposób deklarowania bibliotek w projekcie:
Biblioteki są automatycznie deklarowane w momencie dodawania:

pp sterownika:
pp biblioteki podstawowe IEC 61131: Standard i Util
pp biblioteki  PLCSystem
pp innych bibliotek do kontroli funkcji wewnętrznych (np. : M238 szybki licznik)

pp specjalne funkcje sterownika (np. : DataLogManager, Wizualizacja)
pp menadżera komunikacji (no.: menadżer CANopen lub CANmotion )
pp urządzenie slave (np. : TeSys, Altivar, Lexium)

Niektóre biblioteki muszą być dodane ręcznie (np. : Toolbox i Solution).
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Uwaga: Należy używać wyłącznie funkcji i bloków funkcyjnych udokumentowanych 
w pomocy online lub już przetestowanych.



127

Program

Biblioteki Schneider Electric

Wstęp

Wszystkie biblioteki Schneider Electric, są wymienione poniżej.
Uwaga:
Kolumna USER:

pp TAK: Funkcje i Bloki Funkcyjne mogą być użyte w programie użytkownika.
pp NIE: Przeznaczone wyłącznie dla specjalnych systemów i funkcji 
administracyjnych. Przeważnie brak dokumentacji.

Kategoria: (Miscellaneous)

Następująca tabela opisuje bibliotekę dostępną w kategorii Miscellaneous: 

Nazwa Nazwa ogólna Opis USER
FeatureNotSupported brak Wirtualna pusta biblioteka używana 

przez system
NIE

Kategoria: Aplication

Następująca tabela opisuje bibliotekę dostępną w kategorii Aplication:

Nazwa Nazwa ogólna Opis USER
SE_LMC_Utility SE_LMC_Utility Funkcje używane przez bibliotekę 

Profibus DP slave.
NIE

Uwaga: Opis pozostałych bibliotek należy szukać w kategori Communication i Util.
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Kategoria: Communication

Następująca tabela opisuje bibliotekę dostępną w kategorii Communication:

Nazwa Nazwa ogólna Opis USER
IoDrvASI
patrz AS-Interface (Modicon M238 
Logic Controller, Programming Guide)

SEN_ASI Funkcje zarządzania siecią AS-Interface TAK

IoDrvDistributedIo SEN_DIO Funkcje zarządzania siecią CANopen 
i We/Wy

NIE

IoDrvModbusSerial SEN_MODBUS Urządzenia Modbus, zarządzanie 
funkcją I/O skanera wiecej informacji 
patrz w pomocy online CoDeSys 
Programming System Help / Editors / 
Device Editors / Modbus Configuration 
Editor / Modbus Device Editor)

NIE

IoDrvTM5PCDPS SEN_PROFIBUS Biblioteka Profibus-DP slave NIE

M2xx Communication
patrz funkcja Get/Set Serial Line
Configuration (patrz Modicon M238 
Logic Controller, Programming Guide)

SEN_COM Konfiguracja portu szeregowego 
w sterownikach M238, M258 i LMC058

TAK

Modem
patrz Modem Library (SoMachine,
Modem Functions, Modem Library 
Guide)

SEN_MOD Konfiguracja modemu w sterownikach 
M238, M258 i LMC058

TAK

PLCCommunication
patrz PLCCommunication Library
(SoMachine, Modbus and ASCII
Read/Write Functions, 
PLCCommunication Library Guide)

SEN Zarządzanie wymiany danych pomiędzy 
sterownikiem i urządzeniem po 
protokole Modbus lub ASCII.
Uwaga: Biblioteka nie jest kompatybilna 
z ATV IMC.

TAK

SE_NetVarUdp
patrzo SE_NetVarUdp Library

Wymiana danych pomiędzy 
sterownikami poprzez sieć.

TAK
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Kategoria: Controller

Następująca tabela opisuje bibliotekę dostępną w kategorii Controller:

Nazwa Nazwa ogólna Opis USER
DataLogging
patrz DataLogging Library
(SoMachine, Data Logging Functions, 
DataLogging Library Guide)

SEDL Zarządzanie plikiem logowania 
sterownika LogFile.

TAK

Następująca tabela opisuje bibliotekę dostępną w kategorii  
Controller → STV IMC:

Nazwa Nazwa ogólna Opis USER
ATV IMC HSC
patrz High Speed Counting (ATV IMC 
Drive Controller, High Speed
Counting, ATV IMC HSC Library 
Guide)

SEC_HSC Zarządzanie szybkim licznikiem 
ATV IMC

TAK

ATV IMC PLCSystem
patrz PLCSystem Library (ATV IMC 
Drive Controller, System Functions 
and Variables, ATV-IMC PLCSystem 
Library Guide)

SEC Funkcje systemowe i zmienne ATV IMC TAK

ATV IMC SysLib V2.3 SEC_SL23 Funkcje i bloki funkcyjne do 
kompatybilności z Controller Inside 
(CoDeSys v2.3)

TAK

ATV IMC UserLib
patrz  ATV IMC - UserLib Library 
Guide (ATV IMC Controller, ATV IMC
UserLib Library Guide)

SEC_USER Zarządzanie ATV IMC - ATV71 TAK

Następująca tabela opisuje bibliotekę dostępną w kategorii Controller → LMC058:

Nazwa Nazwa ogólna Opis USER
IoDrvTM5SEAISG SEC_TM5SEAISG Biblioteka urządzenia TM5SEAISG, 

kalibracja usługi pomiarowej.
TAK

LMC058 Expert IO
pp patrz szybki licznik (Modicon 
LMC058 Motion Controller, High 
Speed Counting, LMC058 Expert 
I/O Library Guide)

pp patrz Pulse Width Modulation 
(Modicon LMC058 Motion 
Controller, Pulse Width Modulation, 
LMC058 Expert I/O Library Guide)

SEC_EXP Zarządzanie modułami We/Wy 
LMC058.

TAK
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Nazwa Nazwa ogólna Opis USER
LMC058 Motion
patrz szybki licznik (Modicon LMC058 
Motion Controller, High Speed 
Counting, LMC058 Expert I/O Library 
Guide)

SEC_MC Funkcja używana do szybkiego odczytu 
wartości z osi motion oraz resetu błędu. 

TAK

LMC058 PLCSystem
patrz PLCSystem Library (Modicon 
LMC058 Motion Controller, System 
Functions and Variables, LMC058 
PLCSystem Library Guide)

SEC Funkcje systemowe i zmienne LMC058 TAK

LMC058 Relocation Table SEC_RELOC Biblioteka systemowa do tabeli relokacji
(Modicon LMC058 Motion Controller, 
Programming Guide).

NIE

Następująca tabela opisuje bibliotekę dostępną w kategorii Controller → M238:

Nazwa Nazwa ogólna Opis USER
M238 ASi Interface SEC_ASIITF Biblioteka systemowa do zarządzania 

AS-Interface.
NIE

M238 HSC
patrz szybki licznik
(Modicon M238 Logic Controller, High 
Speed Counting, M238 HSC Library 
Guide)

SEC_HSC Zarządzanie szybkim licznikiem M238. TAK

M238 PLCSystem
patrz PLCSystem Library (Modicon 
M238 Logic Controller, System 
Functions and Variables, M238 
PLCSystem Library Guide)

SEC Funkcje systemowe i zmienne M238. TAK

M238 PTOPWM
patrz Pulse Train Output / Pulse Width 
Modulation (Modicon M238 Logic 
Controller, Pulse Train Output, Pulse 
Width Modulation, M238 PTOPWM 
Library Guide)

SEC_PTOPWM Zarządzanie PTO i PWM M238. TAK

M238 Relocation Table SEC_RELOC Biblioteka systemowa do tabeli relokacji
(Modicon M238 Logic Controller, 
Programming Guide).

NIE
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Następująca tabela opisuje bibliotekę dostępną w kategorii Controller → M258:

Nazwa Nazwa ogólna Opis USER
IoDrvTM5SEAISG SEC_TM5SEAISG Biblioteka urządzenia TM5SEAISG, 

kalibracja usługi pomiarowej.
TAK

M258 Expert IO
pp patrz szybki licznik (Modicon M258 
Logic Controller, High Speed 
Counting, M258 Expert I/O Library 
Guide)

pp patrz Pulse Width Modulation 
(Modicon M258 Logic Controller, 
Pulse Width Modulation, M258 
Expert I/O Library Guide)

SEC_EXP Zarządzanie modułami We/Wy M258. TAK

M258 PLCSystem
patrz PLCSystem Library (Modicon 
M258 Logic Controller, System 
Functions and Variables, Modicon 
M258 PLCSystem Library Guide)

SEC Funkcje systemowe i zmienne M258. TAK

M258 Relocation Table SEC_RELOC Biblioteka systemowa do tabeli relokacji
(Modicon M258 Logic Controller, 
Programming Guide).

NIE

Następująca tabela opisuje bibliotekę dostępną w kategorii Controller → XBTGC:

Nazwa Nazwa ogólna Opis USER
XBT PLCSystem SEC Funkcje systemowe i zmienne XBT. TAK

XBTGC HSC
patrz szybki licznik (Magelis XBT GC 
HMI Controller, High Speed Counting, 
XBT GC HSC Library Guide)

SEC_HSC Szybki licznik XBTGC. TAK

XBTGC PLCSystem
patrz PLCSystem Library (Magelis 
XBTGC, XBTGT, XBTGK HMI 
Controller, System Functions and 
Variables, XBT PLCSystem Library 
Guide)

SEC Funkcje systemowe i zmienne XBTGC. TAK

XBTGC PTOPWM
patrz Pulse Train Output / Pulse Width 
Modulation (Magelis XBTGC HMI 
Controller , Pulse Train Output, Pulse 
Width Modulation, XBTGC Library 
Guide)

SEC_PTOPWM Zarządzanie PTO i PWM XBTGC. TAK
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Kategoria: Devices

Następująca tabela opisuje bibliotekę dostępną w kategorii Devices:

Nazwa Nazwa ogólna Opis USER
Altivar Library
patrz Altivar Library Guide

SE_ATV Bloki funkcyjne do sterowania 
przemiennikami częstotliwości ATV 
zgodne z IEC 61131-3

TAK

CANmotion Lexium Library
patrz CANmotion Lexium Library 
Guide

SEM_LXM_SM Bloki funkcyjne do sterowania serwo 
i silnikami krokowymi za pomocą 
protokołu CANmotion.

TAK

Integrated Lexium Library
patrz Integrated Lexium Library Guide

SE_ILX Bloki funkcyjne do sterowania 
silnikami zintegrowanymi ILx zgodne 
z IEC 61131-3

TAK

Lexium Library
patrz Lexium Library Guide

SE_LXM Bloki funkcyjne do sterowania LXM32, 
LXM05 i SD3 za pomocą protokołu 
CANopen zgodne z IEC 61131-3.

TAK

Lexium 23 Library
patrz Lexium 23 Library Guide. 
Uwaga: Biblioteka dostępna po 
zainstalowaniu aktualizacji.

SE_LXM23 Bloki funkcyjne do sterowania LXM23 
za pomocą protokołu CANopen zgodne 
z IEC 61131-3.

TAK

TeSys Library
patrz TeSys Library (SoMachine, 
TeSys Motor Starters Functions, 
TeSys Library Guide)

SE_TESYS Sterowanie rozrusznikami silnikowymi 
TeSys U i TeSys T. Biblioteka umożliwia 
także sterowanie w 1 lub 2 kierunkach / 
1 lub 2 prędkościach.

TAK

Kategoria: Intern

Następująca tabela opisuje bibliotekę dostępną w kategorii Intern → IoDrivers:

Nazwa Nazwa ogólna Opis USER
IoDrvPROFIBUSDPV1Slave IoDrvPROFIBUSDPV1 

Slave
Bloki funkcyjne do sterowania 
przemiennikami częstotliwości ATV 
zgodne z IEC 61131-3

NIE

IoDrvSlave IoDrvSlave Bloki funkcyjne do sterowania serwo 
i silnikami krokowymi za pomocą 
protokołu CANmotion.

NIE
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Kategoria: Solution

Następująca tabela opisuje bibliotekę dostępną w kategorii Solution:

Nazwa Nazwa ogólna Opis USER
Conveying Templates
patrz Developing Conveying 
applications by using Template 
Libraries.pdf w Windows Start menu 
Schneider Electric → SoMachine → 
Documentation.

Conveying_
Templates

pp Urządzenia transportu poziomego 
(taśmociąg)

pp Funkcje transportu poziomego

TAK

Conveying
patrz SoMachine Conveying 
Application Functions Conveying 
Library Guide

SE_CONV Bloki funkcyjne do transportu 
poziomego

TAK

Hoisting
patrz SoMachine Hoisting Application 
Functions Hoisting Library Guide

SE_HOIST Bloki funkcyjne do transportu 
pionowego.

TAK

Packaging
patrz SoMachine Packaging 
Application Functions Packaging 
Library Guide

SE_PACK Bloki funkcyjne do aplikacji pakujących TAK

Uwaga: Biblioteki aplikacyjne muszą być zainstalowane z dodatkowej płyty 
SoMachine Solution Extension DVD.

Kategoria: System

Następująca tabela opisuje bibliotekę dostępną w kategorii System:

Nazwa Nazwa ogólna Opis USER
SystemConfigurationItf SystemConfigurationItf Biblioteka systemowa konfiguracji 

używana przez bibliotekę 
IoDrvTM5PCDPS.

NIE

SystemInterface SystemInterface Biblioteka systemowa używana przez 
bibliotekę IoDrvTM5PCDPS.

NIE
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Kategoria: Util

Następująca tabela opisuje bibliotekę dostępną w kategorii Util:

Nazwa Nazwa ogólna Opis USER
EnergyEfficiencyToolbox
patrz Energy Efficiency Toolbox 
Library Guide w Schneider Electric 
Libraries → Solution Libraries 
w pomocy online SoMachine.

EET Bloki funkcyjne do liczenia zużycia 
energii poszczególnych urządzeń jak 
i przedstawienia ogólnego zużycia 
energii dla maszyny.

TAK

ModbusEnergyEfficiencyToolbox
patrz Modbus Energy Efficiency 
Toolbox Library Guide w Schneider 
Electric Libraries → Solution 
Libraries pomocy online SoMachine.

MEET Bloki funkcyjne do liczenia zużycia 
energii urządzeń w sieci Modbus 
i przedstawienia ogólnego zużycia 
energii dla maszyny.

TAK

MachineEnergyDashboard
patrz the Machine Energy Dashboard
Library Guide (SoMachine, Machine
Energy Dashboard Library Guide)

MED Informacja o ogólnym zuzyciu energii 
przez maszynę bazujące na bibliotece 
EnergyEfficiencyToolbox. 

TAK

Toolbox
patrz Toolbox (SoMachine, 
Miscellaneous Functions, Toolbox 
Library Guide)

SE_TBX Zestaw funkcji i bloków funkcyjnych 
jako rozszerzenie biblioteki Standard 
i Util.

TAK

Toolbox_Advance
patrz Toolbox (SoMachine, 
Miscellaneous Functions, Toolbox 
Library Guide)

SE_TBXADV Funkcje używane do kontroli interwałów 
w zadaniach cyklicznych (Cyclic Task)

TAK
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Inne biblioteki używane w SoMachine

Wstęp

Biblioteki nie pochodzące z Schneider Electric, są wymienione poniżej:
Uwaga:
Kolumna USER:

pp TAK: Funkcje i Bloki Funkcyjne mogą być użyte w programie użytkownika.
pp NIE: Przeznaczone wyłącznie dla specjalnych systemów i funkcji 
administracyjnych. Przeważnie brak dokumentacji.

Biblioteki 3S - Smart Software Solution GmbH

Biblioteki zawierające się w Intern i System  służą do obsługi systemu 
wewnętrznego i nie są dostępne dla użytkownika w kolumnie USER oznaczenie 
NIE. Biblioteki, które mogą być używane przez użytkownika, są oznaczone jako 
TAK.
Biblioteki dostępne w kategorii Use Cases: biblioteki zawierające funkcje CAA 
(więcej informacji patrz CoDeSys Programming System Help / Libraries / System 
Libraries / CAA Libraries).
Następująca tabela opisuje bibliotekę dostępną w kategorii Intern → Soft Motion:

Nazwa Nazwa ogólna Opis USER
SM3_Basic SM3_Basic Funkcje SoftMotion (więcej 

informacji patrz CoDeSys 
Programming System Help /
Libraries / SoftMotion Libraries /
SM3_Basic Library)
Uwaga: Biblioteka kompatybilna 
tylko ze sterownikiem LMC058.

TAK

SM3_CNC SM3_CNC Funkcje CNC SoftMotion (więcej 
informacji patrz CoDeSys 
Programming System Help /
Libraries / SoftMotion Libraries /
SM3_CNC Library)
Uwaga: Biblioteka kompatybilna 
tylko ze sterownikiem LMC058.

TAK

SM3_Drive_••• – Biblioteki systemowe SoftMotion. NIE
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Biblioteki Systemowe

Następująca tabela opisuje bibliotekę dostępną w kategorii (Miscellaneous):

Nazwa Nazwa ogólna Opis USER
CmpEventMgr – Biblioteki systemowe zarządzające 

zdarzeniami (Event)
NIE

Następująca tabela opisuje bibliotekę dostępną w kategorii  
Application → Common:

Nazwa Nazwa ogólna Opis USER
Standard64 Standard64 Funkcje do obsługi długich 

zmiennych znakowych i czasowych.
TAK

Standard Standard Standardowe funkcje i bloki 
funkcyjne zgodne z IEC (patrz 
CoDeSys Programming System 
Help / Libraries / Standard Library).

TAK

Util Util Dodatkowe funkcje i bloki funkcyjne 
zgodne z IEC (patrz CoDeSys 
Programming System Help/ 
Libraries / Util Library).

TAK

Biblioteki dostępne w kategorii Intern: niektóre z tych bibliotek, są używane 
wyłącznie przez system wewnętrzny.
Następująca tabela opisuje bibliotekę dostępną w kategorii System → SysLibs:

Nazwa Nazwa ogólna Opis USER
Cmp•••
Sys•••
ISys•••

– Biblioteki systemowe NIE

SysTime
patrz zarządzanie 
zegarem czasu 
rzeczywistego 
(SoMachine, Getting 
& Setting Real Time 
Clock,SysTime Library 
Guide)

SysTime Zarządzanie zegarem czasu 
rzeczywistego w sterowniku

TAK
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Następująca tabela opisuje bibliotekę dostępną w kategorii System → SysLibs23:

Nazwa Nazwa ogólna Opis USER
Sys•••23 – Biblioteki systemowe do 

zarządzania migracją projektów 
CoDeSys v2.3.

NIE

Biblioteki CAA (CoDeSys Automation Alliance)

Następująca tabela opisuje bibliotekę dostępną w kategorii Application → CAA:

Nazwa Nazwa ogólna Opis USER
CAA••• – Biblioteki z grupy CAA (patrz 

CoDeSys Programming System 
Help / Libraries /System Libraries / 
CAALibraries).

NIE

CAA CiA 405
patrz biblioteki CAA 
CiA 405 (SoMachine, 
CANopen Management 
Functions, CAACiA 405 
Library Guide)

CIA405 Bloki funkcyjne do zarządzania 
protokołem CANopen.

TAK

Następująca tabela opisuje bibliotekę dostępną w kategorii Intern → CAA:

Nazwa Nazwa ogólna Opis USER
CAA••• – Biblioteki z CAA (więcej informacji 

na temat CAA patrz CoDeSys 
Programming System Help / 
Libraries / System Libraries / CAA 
Libraries).

NIE
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Tworzenie własnych bibliotek

Przegląd

Oprogramowanie SoMachine umożliwia zapisanie projektu (<projectname>.project) 
jako plik biblioteki (<projectname>.library). Zapisany plik biblioteki zawiera tylko 
elementy okna POU.

Procedura

Aby stworzyć własną bibliotekę w zakładce Program należy postępować 
następująco:

Krok Akcja
1 SoMachine umożliwia stworzenie biblioteki na dwa sposoby:

pp Używając menu File → New i wybór Empty Library project template 
z Categories → Basic Controllers.

pp Lub używającmenu File → Save project as... i wybraniu Save as type -  
Library file.

2 Wypełnij wszystkie pola obowiązkowe w File Project → Project Information.

3 Projekt biblioteki zawiera:
pp funkcje i bloki funkcyjne
pp definicje danych
pp zmienne globalne
pp wizualizacje
pp biblioteki 

Uwaga: Plik biblioteki zawiera tylko elementy z zakładki POU.
Uwaga: Dodając standardowe biblioteki należy zawsze używać mechanizmu 
opisanego w rozdziale dodawania bibliotek.

4 Wybież komendę File → Save project and install library into library 
repository.
Rezultat: Biblioteka zostanie zainstalowana na komputerze i może być 
stosowana w dowolnym projekcie używając menadżera bibliotek.

Uwaga: Więcej informacji znajduje się w pomocy online CoDeSys.
Sprawdzenie potencjalnych błędów odbywa się za pomocą komendy Check 
all Pool objects w menu Build aby zapisać bibliotekę należy wybrać Save the 
project as a compiled library lub Save project and install library into library 
repository.
Najpierw należy napisaną bibliotekę sprawdzić za pomocą standardowych narzędzi 
dostępnych w SoMachine, używanych do kompilacji programów, a potem zapisać 
jako bibliotekę. Po zapisie biblioteki nie ma już możliwości edycji kodu źródłowego.
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6.5	 Zarządzanie portami komunikacyjnymi

Co zawiera ta sekcja?

Ta sekcja zawiera następujące tematy:

Temat Strona
Konfiguracja portu Ethernet 140

Konfiguracja portu CANopen 143

Konfiguracja portu szeregowego 149

Konfiguracja portu Rofibus DP 152

Konfiguracja portu AS-Interface 155
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Konfiguracja portu Ethernet

Przegląd

Komunikacja Ethernet jest możliwa z urządzeniami z protokołem EtherNet/IP 
i Modbus TCP.

Przed ustanowieniem komunikacji Ethernet należy fizycznie połączyć urządzenia 
ze sterownikiem. Więcej informacji na temat połączeń znajduje się w pomocy 
online.

Dodawanie urządzeń w sieci EtherNet/IP lubModbus TCP

Dodawanie urządzeń w sieci EtherNet/IP lub Modbus TCP w sterowniku M258, 
odbywa się następująco:

Krok Akcja
1 Kliknij prawym przyciskiem myszy zakładkę Ethernet w oknie Devices, wybierz opcję Add Device... .

Rezultat: Nastąpi otwarcie okna Add Device.
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Krok Akcja
2 W oknie Add Device wybierz zakładkę Ethernet/IP lub Modbus TCP Slave Device i dodaj urządzenie.

Podaj nazwę w polu Name i kliknij Add Device. 

Program
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2 In the Add Device dialog box select EthernetIP node to create an EtherNet/IP slave device. Or select 
the ModbusTCP Slave Device to create a Modbus TCP slave device.
Enter a Name and click the Add Device button. 

Step Action
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Krok Akcja
3 Dodaj następne urządzenie lub wciśnij przycisk Close aby zamknąć.

Rezultat: Zakładka Ethernet zawiera urządzenie sieci EtherNet/IP i/lub Modbus TCP o podanej nazwie.

4 Kliknij dwa razy na urządzenie i skonfiguruj w edytorze po prawej stronie. Poniższy obraz pokazuje 
przykładową konfigurację urządzenia w sieci Modbus TCP:

Program
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For further information on the individual settings refer to the CoDeSys online help.

3 Add another device or click the Close button to close the dialog box.
Result: The Ethernet node in the Devices window now contains a sub node for EtherNet/IP and/or 
Modbus TCP with the name you entered.

4 Double-click the sub node and configure your Ethernet device in the editor on the right-hand side. 
The figure below shows the configuration of a ModbusTCP slave device as an example:

Step Action

Więcej informacji znajduje się w pomocy online programu CoDeSys.



143

Program

Konfiguracja sieci CANopen

Opis ogólny

Dla sieci CANopen należy najpierw zdefiniować mastera sieci oraz prędkość 
transmisji. Poniższa instrukcja opisuje sposób konfiguracji prędkości transmisji 
oraz CANopen master w sterowniku M238.

Przed ustanowieniem komunikacji CANopen należy fizycznie połączyć wszystkie 
urządzenia w sieci. Więcej informacji znajduje się w instrukcji sterownika.

Konfiguracja prędkości transmisji

Aby skonfigurować prędkość transmisji należy:

Krok Akcja
1 W oknie Devices dwukrotnie kliknij na zakładkę CAN.
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Configuring the CANopen Interface

Overview

For CANopen communications you must first define the transmission rate and 
configure a CANopen master. The following paragraphs describe how to define the 
transmission rate in the CANopen configuration dialog box and to create and 
configure the CANopen Manager that serves as CANopen master using an M238 
Logic Controller as an example. 

Before you can establish a CANopen connection you must physically connect your 
CANopen devices to your controller. For detailed information on this hardware 
connection, refer to the hardware manual of your controller.

Configuring the Transmission Rate

To configure the transmission rate for CANopen communications, proceed as 
follows:

Step Action

1 In the Devices window double-click the entry CAN that is provided as a subitem of your M238 Logic 
Controller if it is equipped with a CANopen interface.

Result: The tabbed configuration dialog box for CANopen communications will be displayed on the right-
hand side.
Rezultat: Nastąpi otwarcie edytora CANopen po prawej stronie ekranu.
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Krok Akcja
2 Skonfiguruj prędkość transmisji w zakładce CANbus:
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2 In the CANbus tab configure the transmission rate:

From the Baudrate list select the transmission rate of your CANopen connection, by default 
250,000 bit/s.
To inhibit access to the NMT commands and Service data object (SDO) parameters, that are provided 
in the Status tab of each device when you are logged in, while the controller is in RUN mode, select the 
Online Bus Access check box.

Step Action

Z listy Baudrate wybierz odpowiednią prędkość transmisji sieci CANopen, domyślnie jest ustawione 
250,000 bit/s.
Aby zablokować dostęp do komend NMT oraz parametrów SDO, które są dostępne w zakładce Status 
po zalogowaniu do sterownika w trybie RUN, należy zaznaczyć opcję Online Bus Access.
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Tworzenie i konfiguracja menadżera CANopen

Aby stworzyć i skonfigurować menadżer CANopen należy:

Krok Akcja
1 W oknie Devices dwukrotnie kliknij na zakładkę CAN i wybierz opcję Add Device... .
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Creating and Configuring the CANopen Manager

To create and configure the CANopen Manager, that serves as CANopen master 
and that is required for CANopen communications, proceed as follows:

Step Action

1 In the Devices window right-click the node CAN that is provided as a sub node of your M238 Logic 
Controller and select the command Add Device... from the context menu:

Result: The Add Device dialog box opens. Rezultat: Nastąpi otwarcie okna Add Device.
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Krok Akcja
2 W oknie  Add Device należy wybrać CANopen_Manager, podać nazwę i wcisnąć przycisk Add Device:
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2 In the Add Device dialog box select the CANopen_Manager.
Adapt the default Name, if required, and click the Add Device button: 

Step Action
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Krok Akcja
3 Okno Add Device zostaje otwarte. Wciśnij przycisk Close aby zamknąć okno.

Rezultat: Zostanie dodany CANopen Manager do zakładki CAN.
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For further information on CANopen configurations, refer to the CoDeSys online 
help.

For adding a CANopen device, refer to the Adding Devices chapter (see page 109).

Nodeguarding Settings

The node Life time (Life time = Guard time x Life time factor) must be greater than 
twice the task cycle time:

Guard time > task cycle time
Life time factor >= 2

Schneider Electric recommends the following settings:

3 The Add Device dialog box remains open. Click the Close button to close the dialog box.
Result: The CAN node in the Devices window now contains a CANopen Manager sub node.

4 To configure your CANopen device, double-click its entry in the Devices window.
Result: The configuration dialog box for CANopen devices, the so-called CANopen_Manager, will be 
displayed on the right-hand side. When configuring the CANopen_Manager and the CANopen devices, 
consider the hints on nodeguarding and heartbeat settings in the following paragraphs.

Step Action

Parameter Value

Guard time 200 ms

Life time factor 2 (1 is not allowed)

4 Aby skonfigurować urządzenie CANopen należy kliknąć na nie dwa razy.
Rezultat: Zostanie wyświetlony menadżer CANopen po prawej stronie ekranu. Należy ustawić także 
odpowiedne monitorowanie sieci CANopen konfigurując mechanizm nodeguarding lub heartbeat.

Więcej informacji znajduje się w pomocy online CoDeSys.
Dodawanie urządzeń do sieci CANopen jest opisane w rozdziale Dodawanie 
urządzeń.

Ustawienia mechanizmu nodeguarding

Czas nadzoru ustawiony w mechanizmie nodeguarding (Life time=Guard time x 
Life time factor) powinien być większy niż podwójny cykl programu sterownika:

pp Guard time (czas monitorowania) > cykl programu sterownika
pp Life time factor (współczynnik) >=2

Schneider Electric rekomenduje następujące ustawienia:

Parametr Wartość
Guard time (Czas monitorowania) 200 ms

Life time factor (współczynnik) 2 (wartość 1 jest niedozwolona)
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Ustawienia mechanizmu Heartbeat

CANopen_Manager heartbeat producer time (czas nadzoru mechanizmu 
heartbeat) musi być równy lub większy cyklowi sterownika, aby zapobiec 
zakłóceniom należy wybrać czas, który jest wielokrotnością cyklu sterownika:

pp CANopen_Manager Producer time >=cykl sterownika 
Node heartbeat consumer time (czas całkowity mechanizmu heartbeat) musi być 
większy niż dwukrotność CANopen_Manager Producer time:

pp Node consumer time >= 2,5 x CANopen_Manager Producer time. 
Node heartbeat producer time musi być równy lub większy niż cykl sterownika:

pp Node Producer time >=cykl sterownika

Schneider Electric rekomenduje następujące ustawienia:

Parametr Wartość
CANopen_Manager Producer time 200 ms

Node Consumer time 500 ms

Node Producer time 200 ms

Uwaga: Mechanizm Nodeguarding może być aktywowany tylko jeśli heartbeat 
producer i consumer są dezaktywowane.
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Konfiguracja portu szeregowego

Opis

Dodanie urządzenia musi być poprzedzone konfiguracją Protocol Manager. 
Zanim skonfigurujemy połączenie należy fizycznie połączyć urządzenie ze 
sterownikiem.

Konfiguracja komunikacji

Aby stworzyć i skonfigurować połączenie szeregowe należy:

Krok Akcja
1 W menu Devices kliknij dwa razy na zakładkę Serial Line.

Rezultat: Po prawej stronie ekranu nastąpi otwarcie okna konfiguracji.

2 Skonfiguruj ustawienia w zakładce Configuration.
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Configuring the Serial Line Interfaces

Overview

You must first define the communication settings and configure a Protocol 
Manager before you can add devices.

Before you can establish a connection you must physically connect your devices to 
your controller. For detailed information on this hardware connection, refer to the 
hardware manuals of your controller and connected devices.

Configuring Communication Settings

To configure communication settings for serial line interfaces, proceed as follows:

Step Action

1 In the Devices window double-click the desired Serial Line subnode of your controller.
Result: The tabbed configuration dialog box for serial line communications will be displayed on the right-
hand side.

2 Configure the communication settings in the Configuration tab:

Note: The communication settings must be identical for each device connected.Uwaga: Ustawienia muszą być identyczne dla wszystkich podłączonych urządzeń.
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Protocol Managers (Menadżer protokołu)

Dla każdego interfejsu szeregowego wymagany jest jeden z poniższych 
menadżerów:

Menadżer protokołu Opis
ASCII Manager Używany do wysyłania i/lub odbierania 

danych ze standardowych urządzeń.

Modbus Manager Używany do protokołu Modbus RTU lub 
ASCII w trybie master lub slave.

Modbus IOScanner Menadżer protokołu Modbus RTU lub 
ASCII używany do bezwarunkowej 
wymiany danych (skanowanie We/Wy) 
z urządzeniami Modbus slave.

SoMachine Network Manager Niezbędny jeśli chcemy się połączyć 
z XBTGT, XBTGK lub XBTGH HMI za 
pomocą protokołu SoMachine (wgranie 
programu równocześnie do PLC i HMI za 
pomocą jednego połączenia).

Istnieje jeden menadżer protokołu dla każdego połączenia szeregowego, może on 
być usunięty i skonfigurowany według indywidualnych wymagań.
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Dodawanie menadżera protokołu

Aby dodać menadżer protokołu należy:

Krok Akcja
1 W oknie Devices dwukrotnie kliknij na zakładkę Serial Line i wybierz opcję Add Device... .

Rezultat: Zostanie wyświetlone okno Add Device.

2
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Adding a Protocol Manager

To add a Protocol Manager to a serial line interface, proceed as follows:

You can now add your devices as described in the Adding Devices to a 
Communication Manager chapter (see page 115).

Step Action

1 In the Devices window right-click the Serial Line nubnode and select the command Add Device from 
the context menu.
Result: The Add Device dialog box will be displayed.

2

From the Add Device dialog box select the Protocol Manager that suits your requirements, adapt the 
Name and click the Add Device button.
Result: The selected manager will now be displayed in the Devices window as a subnode of the Serial 
Line node.

3 To configure the Protocol Manager, double-click its entry in the Devices window.
Result: The tabbed configuration dialog box for the selected Protocol Manager will be displayed on the 
right-hand side. For further information on configuring the individual Protocol Managers, refer to the 
Programming Guide of your controller or to the CoDeSys part of the online help.

W oknie Add Device wybierz menadżer protokołu, który odpowiada twojemu interfejsowi 
komunikacyjnemu, wpisz nazwę i kliknij przycisk Add Device.
Rezultat: Wybrany menadżer zostanie wyświetlony w zakładce Devices - Serial Line.

3 Aby skonfigurować menadżer protokołu naciśnij dwa razy na jego nazwę w oknie Devices.
Rezultat: Zostanie wyświetlone okno konfiguracji protokołu menadżera po prawej stronie ekranu.  
Więcej informacji w instrukcji programowania odpowiedniego sterownika PLC i pomocy online CoDeSys.

Możliwe jest teraz dodanie urządzenia do menadżera komunikacji  
(patrz strona 115).
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Konfiguracja interfejsu Profibus DP

Przegląd

Zanim ustanowimy komunikacje Profibus DP należy fizycznie podłączyć 
urządzenie Profibus slave do sterownika. Więcej informacji znajduje się 
w odpowiedniej instrukcji do danego urządzenia.

Następujące sterowniki M258 obsługują połączenie Profibus DP:
pp TM258LD42DT4L
pp TM258LF42DR
pp TM258LF42DRS0
pp TM258LF42DT4L
pp TM258LF42DT4LS0
pp TM258LF66DT4L

Następujące sterowniki LMC058 obsługują połączenie Profibus DP:
pp LMC058LF424
pp LMC058LF424S0
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Dodawanie modułu PCI Profibus Slave

Dodanie modułu odbywa się następująco:

Krok Akcja
1 Kliknij prawym przyciskiem myszy na zakładkę Empty (Empty) w menu Devices i wybierz komendę 

Plug Device...:
Rezultat: Nastąpi otwarcie menu Plug Device.

2 Wybierz z listy moduł TM5PCDPS.
Nadaj nazwę i kliknij przycisk Plug Device:
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Adding a Profibus DP Slave PCI Expansion Module

To add a Profibus DP Slave PCI expansion module to your M258 / LMC058 
controller, proceed as follows:

Step Action

1 In the Devices window right-click the node Empty (Empty) that is provided as a sub node of the node 
PCI Slots of your M258 / LMC058 controller and select the command Plug Device... from the context 
menu:
Result: The Plug Device dialog box opens. 

2 In the Plug Device dialog box select the entry TM5PCDPS from the list of PCI Communication 
Modules.
Adapt the default Name if required, and click the Plug Device button:
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Krok Akcja
3 Menu Plug Device pozostaje otwarte. Dodaj następne urządzenie lub zamknij okno.

Rezultat: Zostanie dodany moduł TMPPCDPS w menu Devices.

4 Aby skonfigurować moduł Profibus DP Slave należy dwukrotnie na niego kliknąć w menu Devices.
Rezultat: Menu konfiguracji zostanie otwarte po prawej stronie ekranu.

Więcej informacji znajduje się w instrukcji użytkowania modułów TM5 PCI.
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Konfiguracja AS-interfejs

Przegląd

AS-Interfejs jest obsługiwany wyłącznie przez sterownik M238. 
Należy dodać moduł AS-Interfejs Master, a następnie skonfigurować odpowiednie 
moduły AS-Interfejs Slave.

Dodawanie i konfiguracja modułu AS-Interfejs

Krok Akcja
1 Należy kliknąć prawym przyciskiem myszy na sterownik w menu Devices (np. TM238LFDC24DT) 

i wybrać opcję Add Device.
Rezultat: Nastąpi otwarcie okna Add Device.
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Krok Akcja
2 W menu Add Device należy rozwinąć Communication Expansion Modules i wybrać TWDNOI10M3.
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2 In the Add Device dialog box expand the Communication Expansion Modules item and select the 
entry TWDNOI10M3.

Adapt the default Name, if required, and click the Add Device button.
Result: The node of your controller now contains the AS-Interface Master Module as sub node 
TWDNOI10M3 (TWDNOI10M3) → ASi_Master (ASi Master) in the Devices window. 

Step Action

Należy wpisać nazwę i kliknąć Add Device.
Rezultat: Nastąpi dodanie modułu AS-Interfejs Master (TWDNOI10M3 (TWDNOI10M3) → ASi_Master 
(ASi Master) w oknie Devices.
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Krok Akcja
2 W menu Add Device należy rozwinąć Communication Expansion Modules i wybrać TWDNOI10M3.
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2 In the Add Device dialog box expand the Communication Expansion Modules item and select the 
entry TWDNOI10M3.

Adapt the default Name, if required, and click the Add Device button.
Result: The node of your controller now contains the AS-Interface Master Module as sub node 
TWDNOI10M3 (TWDNOI10M3) → ASi_Master (ASi Master) in the Devices window. 

Step Action

Należy wpisać nazwę i kliknąć Add Device.
Rezultat: Nastąpi dodanie modułu AS-Interfejs Master (TWDNOI10M3 (TWDNOI10M3) → ASi_Master 
(ASi Master) w oknie Devices.
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Krok Akcja
3 Aby skonfigurowaćr AS-Interface Master Module,należy dwukrotnie kliknąć na jego ikonę w oknie 

Devices.
Skonfigurujr AS-Interface Master Module w edytorze po prawej stronie ekranu.
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For further information on configuring AS-Interface Master Modules, refer to the 
CoDeSys online help.

Creating and Configuring an AS-Interface Slave Module

To create an AS-Interface slave module, proceed as follows:

3 To configure your AS-Interface Master Module, double-click its entry in the Devices window.
Configure your AS-Interface Master Module in the editor on the right-hand side.

Step Action

Step Action

1 Right-click the TWDNOI10M3 (TWDNOI10M3) → ASi_Master (ASi Master) node in the Devices window 
and select the Add Device command from the context menu.
Result: The Add Device dialog box will be displayed.

Więcej informacji znajduje się w pomocy online CoDeSys.
Dodanie i konfiguracja modułu AS-Interfejs Slave

Krok Akcja
1 Kliknij prawym przyciskiem myszy na ikonę (TWDNOI10M3 (TWDNOI10M3)→ASi_Master (ASi Master) 

w oknie Devices i wybierz komendę Add Device.
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Krok Akcja
2 Wybierz urządzenie AS-Interfejs slave z listy i kliknij Add Device.
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2 Select an AS-Interface slave device from the list, adapt the default Name, if required, and click the Add 
Device button.

Step Action
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Krok Akcja
3 Okno Add Device pozostaje otwarte. Należy dodać następny moduł AS-Interfejs lub kliknąć przycisk 

Close.
Rezultat: Nastąpi dodanie AS-Interfejs slave TWDNOI10M3 (TWDNOI10M3)→ASi-Master (ASi 
Master) w oknie Devices.

4 Aby skonfigurować moduł AS-Interfejs kliknij dwa razy na moduł w oknie Devices. Skonfiguruj moduł 
AS-Interfejs w menu po prawej stronie ekranu. 
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For further information on configuring AS-Interface slave modules, refer to the 
CoDeSys part of the online help.

3 The Add Device dialog box remains open. Add another AS-Interface slave device, or click the Close 
button to close the dialog box.
Result: The node of your controller now contains the AS-Interface slave device as a new sub node of 
TWDNOI10M3 (TWDNOI10M3) → ASi_Master (ASi Master) in the Devices window. 

4 To configure your AS-Interface slave device, double-click its entry in the Devices window.
Configure your AS-Interface slave device in the editor on the right-hand side.

Step Action

Więcej informacji znajduje się w pomocy online CoDeSys.
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6.6	 Komendy SoMachine

Co zawiera ta sekcja?

Ta sekcja zawiera następujące tematy:

Temat Strona
Asystent dodawania bloków funkcyjnych 162

Zmiana urządzenia 166
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Asystent dodawania bloków funkcyjnych

Przegląd

SoMachine zawiera asystenta dodawania bloków funkcyjnych (FFB Finder), który 
umożliwia szybkie i proste dodawanie oraz wyszukiwanie odpowiednich funkcji 
i bloków funkcyjnych. 

Wszystkie funkcje i bloki funkcyjne, są dostępne w następujących językach 
programowania:

pp CFC
pp LD
pp IL
pp FBD
pp ST

Jak znaleźć funkcję lub blok bunkcyjny za pomocą FFB Finder.

Należy otworzyć FFB Finder i postępować następująco:
pp wybierz z menu Edit→FFB finder
pp kliknij prawym przyciskiem myszy w polu edytora programowania i wybierz 
komendę FFB Finder.
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Nastąpi otwarcie edytora FFB Finder:
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The FFB Finder dialog box opens:
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Menu FFB Finder zawiera następujące elementy:

Element Opis
Find what - 
Wyszukiwanie

Wyszukiwanie po nazwie funkcji lub bloku funkcyjnego. Możliwość stosowania znaków ?, * 
zamiast jednego lub wielu znaków.

Company - Firma Wyszukiwanie na podstawie firmy, która tworzyła daną funkcje lub blok funkcyjny.
pp 3S - Smart Software Solutions GmbH
pp CAA Technical Workgroup
pp Schneider Electric
pp System

Ten parametr jest fabrycznie ustawiony na All Companies (wszystkie firmy).

Match case - 
Wyszukanie 
szczegółowe

Wyszukiwanie wszystkich skojarzonych tematów z szukaną frazą.

Include comments 
in search - 
Wyszukiwanie 
w komentarzach

Wyszukiwanie frazy także w komentarzach funkcji i bloków funkcyjnych.
Domyślnie ta funkcja jest nieaktywna.

Search in project 
Librairies only - 
Przeszukuj tylko 
biblioteki z projektu

Wyszukiwanie tylko w bibliotekach, które zostały użyte w programie. Domyślnie asystent 
wyszukuje we wszystkich zainstalowanych bibliotekach na komputerze.

Znajdź Naciśnij Find lub przycisk ENTER w celu rozpoczęcia wyszukiwania.

Rezultat wyszukiwania za pomocą FFB Finder

Każda funkcja lub blok funkcyjny pasujący do kryterium wyszukiwania zostanie 
wyświetlona w liście Results z podaniem nazwy, biblioteki z której pochodzi, wersji 
oraz nazwy firmy. Komentarz zostanie wyświetlony po prawej stronie ekranu.
Kolumna Loaded po lewej stronie ekranu sygnalizuje czy dana funkcja lub blok 
funkcyjny jest już użyty w projekcie.
Więcej informacji jest wyświetlane w momencie wybrania odpowiedniej pozycji 
z listy rezultatu wyszukiwania.
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Integracja Funkcji/Bloku funkcyjnego w programie

Integracja funkcji/bloku funkcyjnego w programie następuje po wybraniu go z listy:
pp przez podwójne naciśnięcie myszki
pp lub naciśnięciu przycisku OK.

Wybrana pozycja zostanie dodana na ekranie i automatycznie zostanie 
załadowana odpowiednia biblioteka do menadżera bibliotek. 
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Zmiana urządzenia

Przegląd

SoMachine 3.0 umożliwia zmianę skonfigurowanego urządzenia na inne z tej 
samej rodziny sterowników. SoMachine automatycznie konwertuje aplikacje 
i wyświetla zmiany, które zostały dokonane w polu komentarza (Messages).
Opcja Change Device (Zmień urządzenie) może automatycznie dodać lub usunąć 
moduły co ma wpływ na adresowanie i biblioteki.
Aby uniknąć nieprzewidzianego zachowania należy:

pp Upewnić się, że nowy sterownik wspiera wszystkie funkcje i obsługuje porty 
komunikacyjne niezbędne w twoim projekcie.

pp Postaraj się unikać adresowania bezpośredniego w twojej aplikacji.
pp Wykonaj kopię zapasową projektu przed zmianą sterownika.
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Zmiana urządzenia

Krok Akcja
1 Wykonaj kopię zapasową projektu: File → Save Project As... 
2 Kliknij prawym przyciskiem myszy w menu Devices na urządzenie, które chcesz zmienić.

3 Wybierz komendę Change Device (Zamień urządzenie)
Rezultat: Nastąpi otwarcie menu z kompatybilnymi urządzeniami.
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Changing a Device

To change a device to a compatible device, proceed as follows:

Step Action

1 Perform a backup of the project to the hard disk of the PC by executing the File → Save Project As... 
command before changing a device.

2 Right-click the device you want to change in the graphical editor of the Configuration tab or in the 
Devices pane of the Program tab.

3 Select the Change Device command from the context menu.
Result: The Change Device dialog box is displayed. It lists those devices that are compatible to the 
device you selected and provides further information on the selected device:
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Krok Akcja
4 Należy wybrać odpowiedni sterownik z listy.

5 Kliknąć przycisk Change Device.
Rezultat: Zostanie wyświetlona informacja o potencjalnych danych jakie mogą być utracone.

6 Jeśli chcesz kontynuować naciśnij OK.
Jeśli nie została wykonana kopia zapasowa to wciśnij Cancel i zapisz projekt na dysku.
Rezultat po naciśnięciu OK: Nastąpi konwersja urządzenia na wybrane z listy oraz zostanie wyświetlony 
komentarz z informacjami.

7 Należy sprawdzić czy projekt zawiera właściwą konfigurację i funkcje. Jeśli nie to należy skorzystać 
z kopi zapasowej projektu.

Specjalny przypadek: Zamiana urządzenia HMI na inne urządzenie HMI z większą rozdzielczością 
ekranu

Tak jak w przypadku sterowników jest możliwość zamiany urządzenia HMI na 
inne z tej samej rodziny. W tym przypadku ekran Change Device będzie zawierał 
listę urządzeń, które umożliwiają automatyczną adaptację wyższej rozdzielczości 
ekranu.
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Ekran zmiany urządzenia HMI

Program
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Change Device dialog box for HMI devices

If the new HMI device has a bigger screen and thus a higher screen resolution, the 
option Adapt to increased screen resolution is by default enabled. It automatically 
adapts the contents of the HMI panels and the popup windows as well as the fonts 
of the HMI panels to the increased screen resolution of the new HMI device.

NOTE: This process cannot be undone automatically. You must verify and, if 
necessary, manually adapt the contents of the panels after the conversion.

Jeśli nowe urządzenie posiada większy ekran nastąpi automatyczne zaznaczenie 
funkcji adaptacji. Nastąpi automatyczna konwersja wszystkich ekranów 
i dopasowanie do większego ekranu i rozdzielczości.
Uwaga: Ten proces nie może być cofnięty.
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6.7	 Komendy SoMachine

Co zawiera ta sekcja?

Ta sekcja zawiera następujące tematy:

Temat Strona
Komendy SoMachine pozwalające na dostęp do maszyny 171

Opis komendy Build All 172

Opis komendy Create Boot Application 173

Opis komendy USB Mass Storage 174

Opis komendy Remote Connection Command 176

Opis komend Imortu/Eksportu projektu Vijeo Designer 181
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Komendy SoMachine pozwalające na dostęp do maszyny

Przegląd

Następujące komendy umożliwiają zarządzaniem aplikacji sterownika i HMI za 
pomocą jednego kliknięcia myszki.

Komenda Menu Akcja
Export Vijeo-Designer project
Eksport projektu Vijeo Designer

File
Plik

Wyodrębnienie projektu Vijeo Designer 
z SoMachine.

Import Vijeo-Designer project
Import  projektu Vijeo Designer

File
Plik

Importuj projekt Vijeo Designer do 
SoMachine.

USB Mass Storage
Pamięć przenośna USB

Project
Projekt

Komenda umożliwiająca zapis obrazu 
plików systemowych oraz skryptów 
zarządzających na pamięci USB.

Build all
Przebuduj cały projekt

Build
Przebuduj

Komenda kompilująca cały projekt  
(PLC i HMI).

Create boot application
Stwórz aplikację startową PLC

Online Komenda zapisująca aplikację startową 
w sterowniku PLC.

Remote connection
Połączenie zdalne

Online Komenda umożliwiająca połączenie 
SoMachine 3.1 i sterownika za pomocą 
Ethernetu.

Multiple Download
Wgranie całej aplikacji do 
wszystkich urządzeń

Online Komenda wgrywająca całą aplikację do 
docelowych urządzeń. (PLC i HMI).

Save Data to File / Restore Data
from File
Zapisz dane do pliku/Odtwórz 
dane z pliku

Online Zapis aplikacji na PC / Odczyt aplikacji 
z PC.
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Opis komendy Build All

Przegląd

Komenda Build All wykonuje dwie operacje:
pp Kompiluje całą aplikację
pp Tworzy docelową aplikację HMI

Procedura

Uruchom komendę Build All w następujący sposób:

Krok Akcja
1 Uruchom komendę Build All.

Rezultat: Nastąpi kompilacja całego projektu.
Informacja o kompilacji zostanie wyświetlona w polu Message.

2 W polu Message wybierz Build z listy po lewej stronie. Zostaną wyświetlone 
informację o statusie kompilacji.

3 Aby wyświetlić podsumowanie wszystkich informacji wybierz pozycję Vijeo 
Designer z listy po lewej stronie ekranu.

4 Aby zweryfikować wiadomości zawarte w oknie Message można kliknąć dwa 
razy na informacę dotyczącą Vijeo Designer.



173

Program

Opis komendy Create Boot Application

Przegląd

Komenda Create boot application z menu Online umożliwia stworzenie aplikacji 
startowej sterownika PLC.
Uwaga: Ta funkcja działa tylko ze sterownikiem PLC.

Procedura

Krok Akcja
1 W menu Device wybierz zakładkę Aplikacji którą chcesz wgrać jako startową 

do sterownika PLC.

2 Wybierz komendę Create boot application z menu Online.
Rezultat: SoMachine automatycznie przebuduje aplikację. W przypadku 
błędów zostaną one wyświetlone w polu Message. Jeśli kompilacja się 
powiedzie pojawi się okno Save As.

3 Należy wybrać folder docelowy do zapisu aplikacji i wcisnąć przycisk Save.
Rezultat: Zostanie wyświetlona informacja o nadpisaniu plików aplikacji.

4 Wciśnij Yes w celu zapisania następujących plików:
pp Myapplication.App
pp Myapplication.crc
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Opis komendy USB Mass Storage

Przegląd

Komenda umożliwiająca zapis obrazu plików systemowych oraz skryptów 
zarządzających na pamięci USB. Ta funkcja jest dostępna wyłącznie dla sterownika 
M258.

Zapisywanie danych SoMachine na pamięci przenośnej USB

Krok Akcja
1 Podłącz pamięć USB do komputera z oprogramowaniem SoMAchine.

2 Wybierz USB Mass Storage z menu Project.
Rezultat: Nastąpi automatyczne przebudowanie aplikacji. Jeśli nie ma żadnych błędów, to nastąpi 
otwarcie okna USB Mass Storage.
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Description of the USB Mass Storage Command

Overview

The USB Mass Storage... command in the Project menu allows you to save the file 
system image together with a file management script on a USB mass storage 
device. This function is only available for M258 Logic Controllers.

Saving SoMachine Data on a USB Mass Storage Device

To save your SoMachine project to a USB Mass Storage device, proceed as follows:

Step Action

1 Plug the USB mass storage device into a USB port of your PC running SoMachine.

2 From the Project menu select the command USB Mass Storage....
Result: SoMachine will automatically build the application. If errors are detected during the build 
process, an error detection message will be issued and the process will be cancelled. If the build process 
is executed successfully, the USB Mass Storage dialog box will be displayed.

3 In the USB Mass Storage dialog box click the plus sign to create a new row for a new command.

4 Select the commands for the script that will be executed on the controller from the Command list box or 
select already available macros from the Macros list.

5 Select the source for the commands from the Source list box or click the ... button to navigate to the 
folder that contains the source.

6 To change the Destination subfolder on the USB mass storage device, open the Destination list and 
select the suitable folder.

7 To create the script, click the Generate button at the bottom or the gearwheel icon from the toolbar at 
the top of the dialog box.
Result: A Browse For Folder dialog box opens. 

8 Browse to the root directory of your USB mass storage device (do not open a subfolder) and click Open.
Result: The SoMachine project and the file management script are saved to the USB mass storage 
device. 

3 Kliknij symbol + w celu dodania nowej linii komend.

4 Wybierz komendy z listy Command lub użyj gotowych makro z listy Macros.

5 Wybierz docelowe źródło z listy Source lub kliknij przycisk nawigacji i wskaż odpowiednik folder.

6 Aby zmienić folder docelowy na USB należy otworzyć listę Destination i wybrać odpowiedni folder.

7 Aby wygenerować skrypt należy kliknąć przycisk Generate lub ikonę koła zębatego znajdującą się na 
górze okna.
Rezultat: Nastąpi otwarcie okna Browse For Folder.

8 Wybierz docelowy folder w pamięci USB (nie należy otwierać tego folderu) i kliknij Open.
Rezultat: Projekt SoMachine i skrypty zarządzania plikami zostaną zapisane w pamięci USB.
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Instalowanie projektu SoMAchine w sterowniku

Należy podłączyć pamięć USB do portu USB sterownika PLC.

Zostanie automatycznie uruchomiony skrypt znajdujący się na pamięci USB. 
Wykonanie skryptu będzie sygnalizowane za pomocą diody LED na sterowniku: 

Wykonywana akcja Wskazanie 
diody LED

Komentarz

Podłączenie pamięci USB 
do sterownika

świeci czerwona 
dioda LED

Dioda świeci na czerwono dopóki nie 
zostanie ustanowiona komunikacja 
z pamięcią USB.

Wykonanie skryptu zielona dioda 
LED mruga

Nie można odłączać pamięci USB 
w trakcie wykonywania skryptu.

Zakończenie wykonywania 
skryptu

zielona dioda 
LED jest 
włączona

Można odłączyć pamięć USB.

Błąd w wykonywaniu 
skryptu

świeci czerwona 
dioda LED

Należy sprawdzić plik log (Log File) 
który został wygenerowany i zapisany 
w pamięci USB w celu ustalenia 
przyczyny błędu.

Log File

Log File jest automatycznie zapisywany w folderze zawierającym skrypt.
Plik zapisuje każde wykonanie skryptu wraz z informacjami: dane, czas, informacja 
o aplikacji, status wykonania skryptu i informacji o przyczynie błędu.
Każda nowa informacja nie nadpisuje starych danych.
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Opis komendy Remote Connection Command

Przegląd

Komenda Remote connection z menu Online otwiera okno, które umożliwia 
ustanowienie komunikacji ze sterownikiem za pomocą Ethernetu.
Połączenie zdalne umożliwia wgranie aplikacji, monitoring, diagnostykę oraz 
zmianę stany sterownika RUN/STOP.
Przed dokonaniem zdalnego połączenia należy sprawdzić czy nikt z obsługi 
maszyny nie jest w strefie ruchomych części maszyny lub elementów pod 
napięciem.
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Opis funkcjonalny

Po ustanowieniu połączenia zdalnego jesteśmy w stanie połączyć się ze 
sterownikiem po Ethernecie. Połączenie zdalne korzysta z portu 1105 sterownika 
i bazuje na TCP/IP.
Jeśli  zostanie uruchomiona komenda skanowania sieci (Scan Network) bez 
połączenia zdalnego wtedy zostaną wykryte tylko sterowniki będące w sieci 
lokalnej lub podłączone za pomocą USB. Dostęp do sterownika za pomocą 
połączenia zdalnego jest możliwy tylko jeśli znany jest adres IP danego sterownika. 
Można stworzyć kilka zdalnych połączeń z tym samym adresem IP. Może być to 
przydatne w pewnych specyficznych konfiguracjach.
Ta funkcja umożliwia dostęp do sterownika za pomocą Ethernetu w następujących 
przypadkach:

pp PC i sterownik, są zlokalizowane w różnych pod sieciach.
pp PC i sterownik, są zlokalizowane w różnych domenach i połączone za pomocą 
internetu.

pp Sterownik jest zlokalizowany w podsieci z połączeniem ADSL.
UWAGA: Połączenie zdalne działa tylko jeśli port 1105 jest odblokowany.
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Scenariusze sieciowe umożliwiające zdalne połączenie

Scenariusz 1: PC i sterownik, są zlokalizowane w różnych pod sieciach.

Scenariusz 2: PC i sterownik, są zlokalizowane w różnych domenach i połączone 
za pomocą internetu.
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Network Scenarios Allowing to Access Remote Controllers

The following network scenarios allow access to remote controllers by using the 
Remote connection command.

Scenario 1: SoMachine PC and remote controller are located in separate subnets:

Scenario 2: SoMachine PC and remote controller are located in separate domains 
that are linked by the internet:

Program
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Network Scenarios Allowing to Access Remote Controllers

The following network scenarios allow access to remote controllers by using the 
Remote connection command.

Scenario 1: SoMachine PC and remote controller are located in separate subnets:

Scenario 2: SoMachine PC and remote controller are located in separate domains 
that are linked by the internet:
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Scenariusz 3: Sterownik jest zlokalizowany w podsieci z połączeniem ADSL.
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Scenario 3: SoMachine PC and remote controller are located in separate subnets 
behind an ADSL connection:

Specifying Controllers for Remote Connection

To specify controllers located in other TCP/IP subnets than the SoMachine PC, 
proceed as follows:

Step Action Comment

1 Open the Remote connection... dialog box from the Online → Remote 
connection... menu.

–

2

In the Remote IP address text field enter the correct IP address of the 
controller you want to establish a remote connection to.

The default destination port 
number is 1105. To access 
the remote controller on a 
different port, enter the port 
number after the IP number, 
separated by a colon 
according to the following 
syntax:
a.b.c.d:<port number>
for example: 
111.111.111.111:1106
NOTE: It can be useful to 
specify the port number 
when you are trying to 
access different controllers 
located behind a router with 
a NAT (network access 
table).

Specyfikacja dla sterowników do połączenia zdalnego

Krok Akcja Komentarz
1 Otwórz okno Remote connection... z menu Online → Remote 

connection... .
–

2
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Scenario 3: SoMachine PC and remote controller are located in separate subnets 
behind an ADSL connection:

Specifying Controllers for Remote Connection

To specify controllers located in other TCP/IP subnets than the SoMachine PC, 
proceed as follows:

Step Action Comment

1 Open the Remote connection... dialog box from the Online → Remote 
connection... menu.

–

2

In the Remote IP address text field enter the correct IP address of the 
controller you want to establish a remote connection to.

The default destination port 
number is 1105. To access 
the remote controller on a 
different port, enter the port 
number after the IP number, 
separated by a colon 
according to the following 
syntax:
a.b.c.d:<port number>
for example: 
111.111.111.111:1106
NOTE: It can be useful to 
specify the port number 
when you are trying to 
access different controllers 
located behind a router with 
a NAT (network access 
table).

Wpisz adres IP sterownika w polu Remote IP address.

Port domyślny 1105 
aby połączyć się ze 
sterownikiem przez inny 
port należy podać adres 
IP i numer portu tak jak 
w przykładzie: adres 
IP:numer portu
111.111.111.111:1106
Uwaga: Ta funkcja może 
być użyteczna w przypadku 
dostępu do sterownika 
podłączonego do rutera 
z NAT (networ acces table).
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Krok Akcja Komentarz
3 Wciśnij przycisk Add connection (dodaj połączenie).

Rezultat: Zostanie wyświetlone połączenie z odpowiednim numerem, 
można zdefiniować kilka połączeń zdalnych do tego samego sterownika.

–

Za każdym razem jak zostanie uruchomiona komenda Scan Network SoMachine 
będzie szukał nie tylko sterowników lokalnych ale także te, które są zdefiniowane 
na liście połączeń zdalnych.

Usuwanie połączeń/sterowników z listy połączeń zdalnych

Aby usunąć połączenie z listy należy zaznaczyć odpowiednie połączenie zdalne 
i wcisnąć przycisk Relase Connection.
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Opis komend Imortu/Eksportu projektu Vijeo Designer

Przegląd

Komenda Import Vijeo Designer project pozwala zaimportować istniejący projekt 
Vijeo Designer do SoMachine.
Komenda Export Vijeo Designer project pozwala wyeksportować istniejący 
projekt Vijeo Designer jako odrębną aplikację HMI.
Uwaga: Zaimportowany projekt Vijeo Designer zastąpi projekt istniejący 
w SoMachine.

Importowanie projektu Vijeo Designer do SoMachine

Krok Akcja
1 Należy wejść do zakładki File i kliknąć komendę Import Vijeo Desiger 

project.
Rezultat: Zostanie wyświetlony ekran przeglądarki plików.

2 Wskaż plik z rozszerzeniem VDZ i kliknij Open.
Rezultat: Wybrany projekt Vijeo Designer zostanie zaimportowany do projektu 
SoMachine.

Eksportowanie projektu Vijeo Designer z SoMachine

Krok Akcja
1 Należy wejść do zakładki File i kliknąć komendę Export Vijeo Desiger 

project.
Rezultat: Zostanie wyświetlony ekran przeglądarki plików.

2 Wskaż plik z rozszerzeniem VDZ i kliknij Save.
Rezultat: Wybrany projekt Vijeo Designer zostanie wyeksportowany 
z SoMachine.
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6.8	 Wymiana danych Sterownika z HMI

Co zawiera ta sekcja?

Ta sekcja zawiera następujące tematy:

Temat Strona
Definicja pojedynczej zmiennej w SoMachine 183

Publikacja zmiennych w sterowniku 187

Wybór zmiennych w HMI 188

Publikacja zmiennych w HMI 189

Parametryzacja warstwy fizycznej 191
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Definicja pojedynczej zmiennej w SoMachine

Przegląd

Wymiana zmiennych pomiędzy sterownikiem i HMI jest możliwe za pomocą 
narzędzia, które publikuje zmienne w SoMachine i, są one dostępne w aplikacji 
Vijeo Designer.
Aby wymienić zmienne za pomocą protokołu SoMachine należy:

pp Stworzyć zmienne
pp Publikuj zmienne przez zdefiniowanie ich w Symbols. Będą teraz dostępne 
w HMI jako zmienne SoMachine.

pp Skonfiguruj połączenie fizyczne (robione automatycznie przez SoMachine).
Uwaga: Ostatni krok nie jest wymagany dla XBTGC ponieważ komunikuje się 
on za pomocą zmiennych kontrolnych.

Dezaktywacja automatycznego eksportu symboli do Vijeo Designer

Domyślnie SoMAchine automatycznie eksportuje zmienne zdefiniowane 
w Symbols do Vijeo Designer.
Jak tylko symbole są przetransferowane do Vijeo Designer nie ma potrzeby 
transferować ich przy każdej modyfikacji programu. Aby zaoszczędzić czas można 
dezaktywować automatyczny transfer symboli:

Krok Akcja
1 Wejdź do menu Preferences i kliknij na przycisk Options.

Rezultat: Zostanie otwarte menu Options.

2 Wybierz zakładkę Vijeo Designer po lewej stronie ekranu.
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Krok Akcja
3 Należy dezaktywować funkcję Disable automatic symbol export znajdującej 

się po prawej stronie ekranu.
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NOTE: Activating the Disable automatic symbol export function inhibits the 
automatic export of SoMachine variables defined as Symbols to Vijeo-Designer. In 
order to perform this transfer manually, right-click the Symbol configuration node 
in the Devices window and execute the Export Symbols to Vijeo-Designer 
command. If you do not perform this manual transfer, Vijeo-Designer may not show 
the correct symbols which, in turn, may lead to errors in the project.

3 On the right-hand side, enable the check box Disable automatic symbol 
export.

4 Click OK to close the dialog box.

Step Action

4 Click OK to close the dialog box.

Uwaga: Aktywacja funkcji Disable automatic symbol export uniemożliwia 
automatyczny eksport zmiennych z SoMachine do Vijeo Designer. W celu 
ręcznego eksportu zmiennych należy kliknąć prawym przyciskiem myszy na 
Symbol Configuration i wybrać komendę Export Symbols to Vijeo Designer.
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Typy zmiennych SoMachine - HMI

Typ zmiennych 
w SoMachine

Typ zmiennych  
w Vijeo Designer

Komentarz

BOOL BOOL –

BYTE Integer –

WORD UINT –

DWORD UDINT –

SINT Integer –

INT INT –

DINT DINT –

USINT Integer –

UINT UINT –

UDINT UDINT –

REAL REAL –

STRING STRING –

WSTRING STRING Zmienna WSTRING jest obsługiwana w Vijeo 
Designer jako zmienna String. To oznacza, że 
możliwa jest tylko wymiana zmiennych STRING 
lub tylko WSTRING. Mieszanie tych dwóch 
zmiennych jest niemożliwa. Jeśli są używane  
WSTRING to wszystkie zmienne muszą być typu 
WSTRING.
Należy wskazać w Vijeo Designer, że wszystkie 
zmienne string powinny być traktowane jak 
UNICODE WSTRING:
Należy wybrać urządzenie w SoMachineNetwork 
lub SoMachineCombo i ustawić funkcję String 
Encoding na Unicode.
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Typ zmiennych 
w SoMachine

Typ zmiennych  
w Vijeo Designer

Komentarz

Array – W Vijeo Designer można zainportować tylko 
elementy z macierzy a nie całą macierz.
Przykład: Macierz zawiera SINT nazwane 
myValues. W Vijeo Designer można mieć 
zmienne myValues[0] lub myValues[5].
Macierz nie może być większa niż 2048 elementów 
w przypadku większej ilości nastąpi wyświetlenie 
błędu w Vijeo Designer.

DUT – W Vijeo Designer można używać tylko elementów 
z DUT, a nie całego DUT.

Niewspierane typy zmiennych

Następujące zmienne nie są wspierane przez funkcję wymiany zmiennych 
SoMAchine HMI:

pp wszystkie zmienne integer 64 bitowe 
pp LREAL
pp macierze bez zera. Nie można zaimportować następujących macierzy 
myArray[1..100].

Więcej informacji znajduje się w pomocy online programu SoMachine.

Długość symbolu

Maksymalna długość symbolu w Vijeo Designer to 32 znaki.
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Publikacja zmiennych w sterowniku

Procedura

Publikacja zmiennych w części sterownika SoMachine w edytorze Symbol 
configuration i definiowanie dostępu (zapis/odczyt, odczyt, zapis):

Krok Akcja
1 Stwórz Symbol configuration w zakładce Devices → Application tak jak jest to opisane w rozdziale 

Dodawanie konfiguracji symboli.

2 W Symbol configuration wybierz zmienne które chcesz przesłać do jednego lub wielu HMI.
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Publishing Variables in the Controller Part

Procedure

Publish variables in the controller part of the SoMachine application within the 
Symbol configuration editor and define specific access rights (read/write, read, 
write): 

NOTE: The publishing mechanism consumes an overhead of about 50 kbyte in the 
controller. Each published variable consumes 11 bytes within the controller 
application.

Step Action

1 Create a Symbol Configuration item under the Application node in the Devices window as described 
in the Adding a Symbol Configuration chapter (see page 102).

2 In the Symbol configuration editor select those elementary variables that you wish to publish for 
communication with 1 or several HMI terminal(s):

The left part of the editor window shows the variables that are currently available in the application. To 
see all variables, open the subitems by clicking the plus signs. To provide variables to HMI terminals, 
select individual variables or even complete nodes in the list on the left-hand side and click the arrow 
button in the middle to copy them to the right side, that is to provide them to HMI terminals.
You can also assign read/write access rights to each variable individually in the Access Rights column.
Note: Only variables on elementary data types are available for interchange with HMI terminals.

3 For your settings to become valid click the Download link in the Symbol configuration editor.

Lewa strona edytora pokazuje zmienne aktualnie dostępne w aplikacji aby zobaczyć wszystkie zmienne 
należy kliknąć na symbol + w celu rozwinięcia widoku. Publikacja zmiennych w HMI odbywa się przez 
wybór odpowiedniej zmiennej lub grupy zmiennych i kliknięciu strzałki. Można także przydzielić poziom 
dostępu do każdej zmiennej kolumna Acces Rights.
Uwaga: Tylko zmienne standardowe są dostępne do wymiany z HMI.

3 Aby ustawienia były ważne należy kliknąć przycisk Download w edytorze Symbol configuration.

Uwaga: Mechanizm publikacji konsumuje około 50 kbyte pamięci sterownika. 
Każda zmienna konsumuje 11 bajtów aplikacji sterownika.
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Wybór zmiennych w HMI

Wybór zmiennych

Wszystkie zmienne, które są dostępne w części sterownika są także dostępne 
w części HMI.
W menu Expression Editor Pad w Vijeo Designer należy wybrać zakładkę 
SoMachine.
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Selecting Variables in the HMI Part

Selecting Variables

Those variables that have been published in the controller part are directly available 
in the HMI part.

In the Expression Editor Pad of Vijeo-Designer select the SoMachine tab to have 
direct access to the variables published in SoMachine. 

For further information refer to the Vijeo-Designer online help.Więcej informacji znajduje się w pomocy online Vijeo Designer.
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Publikacja zmiennych w HMI

Wspierane typy zmiennych

pp BOOL
pp DINT
pp INT
pp UINT
pp UDINT
pp Integer
pp REAL
pp STRING

Procedura

Aby udostępnić wymienione wyżej zmienne należy:

Krok Akcja
1 W edytorze Variable Editor wybierz zmienne które chcesz opublikować.

2 Kliknij prawym przyciskiem myszy na zmienną i użyj komendy Move to SoMachine.
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Publishing Variables in the HMI Part

Supported Variable Types

The following variable types can be published in Vijeo-Designer to make them 
available for the entire SoMachine project:

BOOL
DINT
INT
UINT
UDINT
Integer
REAL
STRING

Procedure

To publish the above mentioned variable types proceed as follows:

Step Action

1 In the Vijeo-Designer Variable Editor select those variables you want to publish.

2 Right-click the selected variable(s) and execute the command Move to SoMachine from the context 
menu.

Result: The Move to SoMachine dialog box will be displayed.

3 In the Move to SoMachine dialog box open the subfolders of the devices defined in SoMachine to see 
the levels where variables are defined (POU or GVL).

Rezultat: Nastąpi otwarcie edytora Move to SoMachine.
3 W edytorze Move to SoMachine otwórz poszczególne foldery w celu zdefiniowania gdzie dane zmienne 

się znajdują (POU lub GVL).
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Krok Akcja
4 Wybierz POU lub GVL, do którego chcesz dodać zmienne wybrane w Vijeo Designer i kliknij OK.

Program
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4 Select the POU or GVL to which you want to add the selected Vijeo-Designer variable(s) and click OK.

Result: The selected variable(s) has / have been moved to the selected SoMachine POU or GVL and is 
/ are available throughout the SoMachine project.

Step Action

Rezultat: Wybrane zmienne zostały przesłane do wybranego w SoMachine POU lub GVL.

Program
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4 Select the POU or GVL to which you want to add the selected Vijeo-Designer variable(s) and click OK.

Result: The selected variable(s) has / have been moved to the selected SoMachine POU or GVL and is 
/ are available throughout the SoMachine project.

Step Action
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Parametryzacja warstwy fizyczne

Przegląd

Dane wymieniane pomiędzy sterownikiem  a HMI, są wymieniane w rózny sposób 
w zależności od sprzętu.

Przykład konfiguracji

Ustawienia domyślne widoczne poniżej są ważne dla komunikacji pomiędzy M238 i 
HMI przez połączenie szeregowe RS485 używając przewodu XBTZ9008.
Konfiguracja M238 i HMI:
Konfiguracja sterownika M238.

Parametr Wartość
Warstwa fizyczna RS485

Prędkość transmisji 115200

Parzystość none

Bity Danych 8

Bity Stop 1

Konfiguracja panela HMI IO Manager: SoMachine sieć z przynajmniej jedną grupą 
skanowania.

Parametr Wartość
Warstwa fizyczna RS485

Prędkość transmisji 115200

Parzystość none

Bity Danych 8

Bity Stop 1

Nazwa urządzenia nazwa sterownika (dostępna w ustawieniach komunikacji)

Konfiguracja XBTGC

Urządzenie Konfiguracja
Sterownik XBTGC konfiguracja nie jest potrzebna

Panel HMI IO-Manager

Driver SoMachine - Combo z przynajmniej jedną grupą skanowania.
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6.9	 Wgranie i uruchomienie aplikacji

Co zawiera ta sekcja?

Ta sekcja zawiera następujące tematy:

Temat Strona
Wgranie aplikacji x

Start aplikacji x
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Wgranie aplikacji

Wstęp

Start aplikacji może się odbyć wyłącznie po fizycznym podłączeniu sterownika do 
PC i wgraniu aplikacji.
Wgranie aplikacji umożliwia skopiowanie projektu z SoMachine do pamięci 
sterownika.
Uwaga: Z powodu ograniczeń wynikających z wielkości pamięci w sterowniku 
niektóre sterowniki nie są w stanie zapisać źródłowego projektu, a tylko jego 
skompilowaną wersję. Z tego też powodu nie ma możliwości zgrania programu ze 
sterownika do PC.

Warunki wstępne

Aplikacja musi spełnić następujące warunki przed wgraniem ich do sterownika:
pp musi być ustanowione połączenie ze sterownikiem,
pp aplikacja do wgrania musi być aktywna,
pp aplikacja musi być bez błędów.

Aplikacja rozruchowa

Aplikacja rozruchowa jest uruchamiana za każdym razem jak sterownik zostanie 
zasilony, ta aplikacja znajduje się w pamięci sterownika. Konfiguracja wgrywania 
aplikacji rozruchowej jest dostępna po kliknięciu prawym przyciskiem myszy na 
zakładkę Application w oknie Devices i wybraniu komendy Properties.
Po każdym wgraniu aplikacji wyskakuje wiadomość z pytaniem czy stworzyć 
aplikację rozruchową.
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Można stworzyć aplikację rozruchową ręcznie:
pp W trybie offline: Kliknij Online → Create boot application (zapamietanie 
do pliku)

pp W trybie online jeśli aplikacja jest w STOP: Kliknij Online → Create boot 
application aby wgrać aplikację rozruchową do sterownika. 

Tryby pracy

Metody wgrania aplikacji do sterownika zależą od różnic pomiędzy aplikacją w 
sterowniku i w SoMachine:

pp Przypadek 1: Aplikacja w sterowniku jest taka sama jak w SoMachine. W tym 
przypadku aplikacja nie jest wgrywana i następuje automatyczne połączenie się 
ze sterownikiem.

pp Przypadek 2: Aplikacja będąca w sterowniku została zmieniona. W tym 
przypadku mamy do wyboru czy chcemy wgrać wszystko czy też tylko zmienioną 
część aplikacji.

pp Przypadek 3: Aplikacja w sterowniku jest inna niż ta, którą chcesz wgrać. W tym 
przypadku należy wybrać czy wgrywamy nową aplikację czy łączymy sie do tej 
w sterowniku.

Wgranie aplikacji do sterownika: Przypadek 1

Krok Akcja
1 Aby podłączyć się do sterownika wybierz: Online → Login to ’Application[YourApplicationName; Plc 

Logic]’.
2 Jesteś połączony ze sterownikiem.

Wgranie aplikacji do sterownika: Przypadek 2

Krok Akcja
1 Aby podłączyć się do sterownika wybierz: Online → Login to ’Application[YourApplicationName; Plc 

Logic]’.
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Krok Akcja
2 W przypadku modyfikacji aplikacji i chęci wgrania jej do sterownika pojawi się następująca wiadomość:

Program
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NOTE: See the Programming Guide for your controller for important safety-related 
information concerning the downloading of applications.

Downloading your Application to the Controller: Case 3

NOTE: See the Programming Guide for your controller for important safety-related 
information concerning the downloading of applications.

2 In case you modified your application and you want to reload it into the controller, the following message 
appears:

Login with online change only the modified parts of an already running project will be re-loaded to the 
controller.

Login with download the whole modified application will be re-loaded to the controller.
Login without any change the modifications are not loaded.

Select what you want to do, click OK.

Step Action

Step Action

1 To connect to the controller, select Online → Login to ’Application[YourApplicationName; Plc 
Logic]’.

2 In case you want to load a different application than the one currently in the controller, the following 
message appears:

To download the new application to the controller, click OK otherwise, click Cancel.

Login with online change - tylko zmieniona część aplikacji zostanie wgrana do sterownika.
Login with download - cała zmieniona aplikacja zostanie wgrana do sterownika
Login without any change - zmiany w aplikacji nie zostaną wgrane do sterownika.

Wgranie aplikacji do sterownika: Przypadek 3

Krok Akcja
1 Aby podłączyć się do sterownika wybierz: Online → Login to ’Application[YourApplicationName; Plc 

Logic]’.
2 Jeśli chcesz wgrać aplikację inną niż ta w sterowniku pojawi się informacja:

Program
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NOTE: See the Programming Guide for your controller for important safety-related 
information concerning the downloading of applications.

Downloading your Application to the Controller: Case 3

NOTE: See the Programming Guide for your controller for important safety-related 
information concerning the downloading of applications.

2 In case you modified your application and you want to reload it into the controller, the following message 
appears:

Login with online change only the modified parts of an already running project will be re-loaded to the 
controller.

Login with download the whole modified application will be re-loaded to the controller.
Login without any change the modifications are not loaded.

Select what you want to do, click OK.

Step Action

Step Action

1 To connect to the controller, select Online → Login to ’Application[YourApplicationName; Plc 
Logic]’.

2 In case you want to load a different application than the one currently in the controller, the following 
message appears:

To download the new application to the controller, click OK otherwise, click Cancel.Aby wgrać nową aplikację do sterownika wciśnij OK lub No aby anulować.

NOTE: See the Programming Guide for your controller for important safety-related
information concerning the downloading of applications.
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Start aplikacji

Wstęp

Ta część pokazuje jak uruchomić lub zatrzymać wykonywanie aplikacji.

Start/Stop w SoMachine

Sterownik może być wystartowany za pomocą SoMAchine podłączonego do 
sterownika.
Wciśnij Online → Start ‘Application [ApplicationName: Plc logic]’ lub CTRL+F5 
lub Start ’Application [ApplicationName: Plc logic].
Sterownik może być zatrzymany za pomocą SoMachine podłączonego do 
sterownika.
Wciśnij Online → Stop ‘Application [ApplicationName: Plc logic]’ lub 
CTRL+SHIFT+F5 lub Stop ’Application [ApplicationName: Plc logic].

Wejście Start/Stop w sterowniku

Niektóre sterowniki umożliwiają konfigurację wejścia Start/Stop 
(np. %IX0.0...%IX1.5) do kontroli sterownika.

Status Opis
0 Zatrzymaj wykonywanie aplikacji. Komenda RUN w SoMachine jest 

niemożliwa.

Zbocze 
wzrastające

Uruchom wykonywanie aplikacji.

1 Wykonywanie aplikacji jest uruchomione. Komenda Start/Stop w SoMachine 
jest możliwa.

Należy sprawdzić w instrukcji obsługi danego sterownika czy jest możliwa kontrola 
stanu za pomocą wejścia Start/Stop.
Wejście Start/Stop umożliwia lokalne sterowanie stanem sterownika oraz ułatwia 
obsługę maszyny.
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6.10	 Wyszukanie najnowszego firmware

Wyszukanie najnowszego firmware

Przegląd

SoMachine umożliwia automatyczne sprawdzanie aktualizacji firmware do 
sterownika z którym chcesz się podłączyć. Można aktywować lub dezaktywować tą 
funkcję w menu Project Settings.
Jeśli ta funkcja jest aktywna sprawdzanie dostępności nowego firmware na twoim 
komputerze następuje automatycznie i jest wyświetlana w polu Messages.
Funkcja Firmware Update sprawdza domyślny folder w programie SoMachine jeśli 
nowy firmware nie będzie tam obecny to program nie będzie świadomy o jego 
istnieniu.

Wspierane sterowniki

Automatyczne powiadamianie o nowym firmware jest dostępne w następujących 
sterownikach:

Sterownik M238 M258 / LMC058 ATV IMC Sterowniki XBT
Sprawdzanie 
dostępności nowego 
firmware

tak tak tak nie

Aktywowanie/Dezaktywowanie sprawdzania firmware

To activate / deactivate the automatic check for a more recent firmware of the
supported controllers, proceed as follows:

Krok Akcja
1 Otwórz projekt SoMachine w którym chcesz ustawić tą funkcję.

2 Otwórz zakładkę Program.

3 Wybierz menu Project → Project Settings.
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Krok Akcja
4 W menu Project Settings wybierz opcję Firmware Update.

Rezultat: Nastąpi otwarcie okna konfiguracji.

Program
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4 In the Project Settings dialog box select the option Firmware Update from the list on the left-hand side.
Result: The Firmware Update configuration dialog box is displayed:

5 Configure the firmware update function as follows:
To activate the automatic check for a more recent firmware of the supported controllers in this project, 
select the option Check if new Firmware is available.
To deactivate the automatic check, select the option Do not check if new Firmware is available.
To prevent the software from opening a separate message box indicating that a more recent firmware 
has been found, select the option Do not show any pop-messages. In this case the more recent 
firmware version is only indicated in the Messages pane of the SoMachine window.

Step Action

5 Skonfiguruj funkcję następująco:
pp Aktywacja funkcji sprawdzania firmware odbywa się przez zaznaczenie opcji Check if new Firmware 
is available.

pp Aby dezaktywować tą funkcje zaznacz Do not check if new Firmware is available.
pp Aby zablokować wyskakiwanie oddzielnej informacji o nowym firmware należy wybrać funkcję Do 
not show pop messages. W tym momencie informacja będzie tylko wyświetlana w oknie Messages 
programu SoMachine.
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Wyświetlanie wiadomości o nowym Firmware

Jeśli funkcja jest włączona informacja o nowym firmware jest pokazywana na dwa 
sposoby:

pp W oknie Messages programu SoMachine.
pp W dodatkowym wyskakującym oknie z informacją o nowym firmware i jego 
lokalizacji.

Drugi sposób jest opcjonalny i może być dezaktywowany przez zaznaczenie opcji 
Do not show any pop messages lub Do not show this message again.
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Co zawiera ta część?
Ta część zawiera następujące rozdziały:

Temat Strona
Opis ogólny x

Opis zakładki Login/Logout x

Opis funkcji Multiple Download x

Opis funkcji Source Download x

Opis funkcji Save Data/Restore Data x
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7

SoMachine

Commissioning

EIO0000000067 04/2012

Commissioning

What’s in this Chapter?

This chapter contains the following topics:

Topic Page

General Description of the Commissioning Tab 236

Description of the Login/Logout Task 239

Description of the Multiple Download Task 244

Description of the Source Download Task 246

Description of the Save Data / Restore Data Tasks 247
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Opis ogólny

Przegląd

Menu Commissioning jest wyświetlane wyłącznie w momencie uruchomienia 
SoMachine.
Jest to edytor graficzny zawierający następujące funkcje:

pp podgląd parametrów
pp podgląd statusu
pp logowanie do maszyny
pp zapis danych w pliku CSV
pp odczyt danych z pliku CSV.
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Elementy Edytora

Poniższy obraz pokazuje edytor Commisioning z przykładową konfiguracją.

1.	 Lista dostępnych komend
2.	 Edytor graficzny z dostępnymi funkcjami 
3.	 Ekran informacji

Commissioning

EIO0000000067 04/2012 237

Elements of the Commissioning Tab

The following figure shows the Commissioning tab with a sample configuration:

1 The task selection pane lists the available tasks.
2 The work area includes the graphical configuration editor with functions restricted to 

commissioning tasks.
3 The information pane provides further information on the element selected in the work area 

as well as the online status of this device.
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Status informacji Online

Status Online jest sygnalizowany za pomocą różnych kolorów:

Status Online Kolor
Nie zalogowany żółty

Start zielony

Kontroler Motion Modicon M238 czerwony

Informacja o statusie Online jest wyświetlana dla sterownika wybranego w edytorze 
graficznym.

Edytowanie parametrów urządzenia i komunikacji

Edytowanie parametrów urządzenia:
pp kliknij dwa razy na urządzenie w edytorze graficznym lub
pp kliknij prawym przyciskiem myszy na ikonę urządzenia i wybierz komendę Edit 
parameters.

Rezultat: Nastąpi otwarcie ekranu konfiguracji wybranego urządzenia

Edytowanie parametrów komunikacji:
pp kliknij dwa razy na linię połączenia sieciowego w edytorze graficznym lub
pp kliknij prawym przyciskiem myszy na linie połączenia sieciowego i wybierz 
komendę Edit parameters.

Rezultat: Nastąpi otwarcie ekranu konfiguracji parametrów sieci wybranego 
urządzenia.

Uwaga: Więcej informacji znajduje się w instrukcji użytkowania danego sterownika.
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Opis zakładki Login/Logout

Przegląd

Funkcja Login/Logout umożliwia ustanowienie połączenia pomiędzy sterownikiem 
i PC w celu wgrania lub ściągnięcia programu.

Przed połączeniem się ze sterownikiem należy fizycznie połączyć go 
z komputerem.
Procedura logowanie zależy od ilości aplikacji w programie.
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Procedura logowania do projektu zawierającego 1 sterownik i 1 aplikację

Aby się zalogować należy:

Krok Akcja
1 W oknie Commisioning kliknij przycisk Login/Logout.

Rezultat: Po zalogowaniu do sterownika status połączenia zostanie zasygnalizowany odpowiednim 
kolorem (np. Stop na czerwono)

Jeśli nie została ustanowiona aktywna ścieżka połączenia zostanie uruchomiony 
następujący proces

Faza Jeśli... Wtedy...
1 ścieżka połączenia nie została ustanowiona SoMachine zeskanuje sieć w celu wyszukania 

dostępnych sterowników

2a nie znaleziono pasującego sterownika lub 
znaleziono kilka pasujących sterowników

zostaje wyświetlona informacja i nastąpi 
otwarcie menu Communication Settings w celu 
ustanowienia aktywnej ścieżki połączenia

2b został znaleziony dokładnie 1 pasujący sterownik zostanie wyświetlona informacja o potencjalnych 
zagrożeniach
Naciśnij ALT + F jeśli akceptujesz połączenie.

Aby się wylogować należy wcisnąć przycisk Login/Logout.
Rezultat: Po wylogowaniu zostanie wyświetlona informacja not logged i status 
Online na żółto.
Uwaga:
Procedura Login działa tak samo w przypadku uruchomienia jej z poziomu zakładki 
Program:

pp Ikona Login z paska narzędzi
pp Ikona Login w zakładce Online
pp Komenda Login z menu Devices → Application.
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Procedura Login w projekcie, który zawiera więcej niż 1 sterownik

Aby połączyć się ze sterownikiem należy:

Krok Akcja
1 W zakładce Commisioning kliknij przycisk Login/Logout.

Rezultat: Zostanie otwarte okno Login/Logout Applications.

Commissioning
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Login Procedure with Project Consisting of Several Controllers, Each with 1 Application

For login to a connected device, proceed as follows:

Step Action

1 In the Commissioning tab click the Login/Logout button from the task 
selection pane.
Result: The Login/Logout Applications dialog box will be displayed.

2 In the Login/Logout Applications dialog box select the application you want to 
login and click the OK button.
Result: After successful login, the information line at the bottom of each device 
icon will indicate the status of the device using different colors (for example, 
Stop is indicated in red).

2 Wybierz aplikację do której chcesz się zalogować i wciśnij przycisk OK.
Rezultat: Po zalogowaniu do sterownika status połączenia zostanie zasygnalizowany odpowiednim 
kolorem (np. Stop na czerwono).
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Jeśli nie została ustanowiona aktywna ścieżka połączenia zostanie uruchomiony 
następujący proces

Faza Jeśli... Wtedy...
1 ścieżka połączenia nie 

została ustanowiona
SoMachine zeskanuje sieć w celu wyszukania dostępnych sterowników

2 nie znaleziono 
pasującego sterownika 
lub znaleziono kilka 
pasujących sterowników

nastąpi otwarcie okna widocznego poniżej:

Commissioning
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If the active path was not previously set in the Communication Settings dialog then 
the following process starts after launching the login operation.

Phase If... Then ...

1 the active path was not 
previously set,

SoMachine starts a scan to search for available controllers.

2 at least for 1 device no 
matching controller or 
several matching 
controllers have been 
found,

the following dialog opens:

Press OK to continue the login operation as selected in the Action column. 
Press Cancel to abort the login operation completely.
For more detailed information about the selections in the Action column, see 
the following description:

open communication settings - This is the default action for devices 
that do not have an active path and no matching controller or several 
matching controllers are found. By pressing OK the Communication 
Settings dialog opens to set the active path manually for the device.
login - This is the default action for devices that already have an active 
path. By pressing OK the login is running for the device.
set active path and login - This is the default action for devices that do 
not have an active path and exactly 1 matching controller is found. By 
pressing OK a warning occurs for the device. Press ALT+F to confirm 
setting the active path and login to the matching controller.
none - This is an alternative action which can be choosen for every 
device. This action cancels the login for the device.

Wciśnij OK aby kontynuować logowanie 
Wciśnij Cancel aby anulować logowanie
Więcej informacji na temat kolumny Action patrz poniżej:

pp open communication settings - jest to akcja domyślna dla urządzeń 
w przypadku nie znalezienia pasującego sterownika lub znalezienia 
wielu pasujących sterowników. Naciśnięcie OK powoduje otwarcie menu 
Communication Settings i możliwość ustawienia aktywnej scieżki 
połączenia.

pp login - jest to akcja domyślna dla urządzeń, które mają ustawioną 
domyślną ścieżkę połączenia. Naciśnięcie OK powoduje zalogowanie do 
sterownika.

pp set active path and login - jest to akcja domyślna dla urządzeń, które 
nie mają ustawionej ścieżki połączenia i dokładnie jeden sterownik 
pasuje do aplikacji. Naciśnięcie OK spowoduje wyświetlenie ostrzeżenia, 
naciśnięcie ALT + F powoduje zalogowanie do sterownika.

pp none - jest to alternatywna akcja powodująca anulowanie logowania.



209

Uruchomienie

Aby się wylogować należy wcisnąć przycisk Login/Logout następnie należy 
odznaczyć aplikację i wcisnąć przycisk Close.

Rezultat: Po wylogowaniu zostanie wyświetlona informacja not logged i status 
Online na żółto.

Uwaga:

Procedura Login działa tak samo w przypadku uruchomienia jej z poziomu zakładki 
Program:

pp Komenda Login z menu Devices → Application.
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Opis funkcji Multiple Download

Przegląd

Funkcja Multiple Download umożliwia wgranie całej aplikacji do wszystkich 
urządzeń za pomocą jednej komendy.
Do Multiple Download należy skonfigurować 2 rzeczy:

pp Wybierz aplikację, która ma być wgrana do sterownika
pp Wybierz opcje zmiany online i dodatkowe ustawienia

Uwaga: Wszystkie wybrane urządzenia PLC, HMI muszą być fizycznie podłączone 
do PC.

Procedura

Wykonaj Multiple download następująco:

Krok Akcja
1 Kliknij przycisk Multiple Download w zakładce Commisioning.

Rezultat: Nastąpi otwarcie okna Multiple Download.

Commissioning
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Description of the Multiple Download Task

Overview

For the Multiple Download operation you must specify 2 settings:
Select the applications of the project to be downloaded.
Specify online change options and additional settings.

NOTE: All physical targets (selected applications’ associated controllers and HMIs) 
must be connected to the PC.

Procedure

Execute the Multiple Download task as follows:

Step Action

1 In the Commissioning tab click the Multiple download button from the task selection pane.
Result: The Multiple Download dialog box will be displayed.

2 In the Please select the applications for download section check each application you want to 
download the new source project to.



211

Uruchomienie

Krok Akcja
2 W oknie Please select the application for download zaznacz wszystkie elementy, które chcesz wgrać 

do podłączonych urządzeń.

3 Wybierz odpowiednią opcję w polu Online change options.

4 Wybierz dodatkowe opcje w polu Additional operations.

5 Wciśnij przycisk OK w celu wgrania aplikacji.
Rezultat: Zostanie wyświetlony status wgrywania aplikacji i informacja o powodzeniu operacji.
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Opis funkcji Source Download

Przegląd

Komenda Source Download umożliwia wgranie archiwalnej wersji projektu z PC 
do sterownika.
Uwaga: Aby użyć tej funkcji sterownik musi posiadać rozszerzoną pamięć. Jest 
ona dostępna w sterowniku ATV IMC i M258 oraz dla XBTGC z podłączoną 
pamięcią USB. XBTGT/GK muszą być wyposażone w kartę CF.

Procedura

Aby wgrać projekt do sterownika należy:

Krok Akcja
1 Zaloguj się do sterownika.

2 Będąc zalogowanym wybierz komendę Source Download.
Rezultat: Projekt zostanie wgrany do sterownika i zapisany w pamięci.
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Opis funkcji Save Data/Restore Data

Przegląd

Komenda Save data umożliwia zapisanie danych (wartości zmiennych) ze 
sterownika do PC z SoMachine. Nastepnie funkcja Restore data umożliwia 
przywrócenie danych.
Ta funkcja ma zastosowanie w następujących przypadkach:

pp zmiana firmware
pp wykonanie komendy Reset Origin
pp wgranie nowej aplikacji

Komenda pozwala zapisać wartości zmiennych do jednego pliku CSV:

Obszar Typ Sposób mapowania Przykład deklaracji zmiennych
System Słowa pamięci zmienne są mapowane jako %MW Memory Word 

AT %MW0:WORD

Wejścia zmienne są mapowane jako %IW Output AT %QW0:WORD

Wyjścia zmienne są mapowane jako %QW Input AT %IW0:WORD

Użytkownik Wszystkie typy zmiennych oprócz bloków funkcyjnych i pointerów.

Dostępność funkcji

Funkca Save data i Restore data, są dostępne w następujących przypadkach:
pp Należy być zalogowanym do sterownika
pp Aplikacja w sterowniku jest w trybie STOP.

Zapis danych do pliku

Aby zapisać dane ze sterownika do PC należy:

Krok Akcja Komentarz
1 W zakładce Commisioning należy kliknąć prawym 

przyciskiem myszy na sterownik i wybrać komendę 
Set application active (wybór aplikacji do zapisu 
danych).

Rezultat: Sterownik zostanie oznaczony zielonym 
kółkiem. 

2 Naciśnij przycisk Save data. Rezultat: Nastąpi otwarcie okna Save Variables.
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Krok Akcja Komentarz
3 W oknie Save Variables zaznacz zmienne, które 

mają być zapisane do pliku CSV.
–

4 Wciśnij przycisk > lub >> aby przesunąć zmienne 
na prawą stronę okna.

Zmienne wyświetlane po prawej stronie zostana 
zapisane w pliku CSV.

5 Naciśnij przycisk Save Data. Nastąpi otwarcie okna zapisu pliku systemu 
Windows.

6 Wybierz folder w którym chcesz zapisać plik 
i wciśnij przycisk Save.

Nastąpi zamknięcie okna i zapis zmiennych do 
pliku CSV.
Pojawi się okno z informacją o powodzeniu zapisu, 
wciśnij OK w celu potwierdzenia operacji.

Odzyskiwanie danych 

Funkcja Restore data nadpisuje wartości zmiennych w sterowniku na te, które były 
zapisane w pliku CSV.
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Odzyskanie danych z pliku odbywa się następująco:

Krok Akcja Komentarz
1 W zakładce Commisioning należy kliknąć prawym 

przyciskiem myszy na sterownik i wybrać komendę 
Set application active (wybór aplikacji do 
odzyskania danych).

Rezultat: Sterownik zostanie oznaczony zielonym 
kółkiem. 

2 W zakładce Commisioning wybierz sterownik 
i kliknij przycisk Restore data.

Rezultat: Nastąpi otwarcie standardowego okna 
odczytu Windows.

3 Wybierz folder gdzie zapisany jest plik CSV 
i wciśnij przycisk Open.

Rezultat: Nastąpi wyświetlenie informacji 
o nadpisaniu wartości zmiennych w aplikacji.

4 Wciśnij przycisk OK w celu importu danych z pliku 
CSV.

Rezultat: Zmienne zapamiętane w pliku CSV 
zostaną zaimportowane do sterownika.

5 Sprawdź czy projekt zawiera poprawne zmienne 
i wartości.

–


